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1. Lock Systems Made to Measure

In today's facilities, lock cylinders are expected to be secure while lock systems retain a degree of flexibility. It's 

the same at private companies and public institutions, as well as in universities or hospitals: Whenever you hire 

new staff or move them to different locations, or when you have to change the entrance regulations or access 

authorisations at your facility, you need a flexible door security system. The state-of-the-art lock system from IKON 

has, in collaboration with the ASSA ABLOY Group, been developed for the highest requirements and is currently 

in use around the world. 

This mechatronic solution integrates the advantages of mechanical and electronic systems and guarantees higher 

security and more flexibility than any other lock system. Using the CLIQ™ Manager program and CLIQ™ Manager 

Plus program, you can precisely program each the electromechanical cylinders whenever necessary - without 

having to retrofit or disassemble the mechanical cylinders or purchase new ones.

By utilising powerful microelectronics and modern data encryption methods, the mechatronic lock system from 

IKON will provide your facilities with exceptionally high security standards. You can program the cylinders without 

any need for external cabling or network connections. Instead, you use software-programmed keys - referred to 

as programming keys - to change the locking permissions for the locks in your facility.

Extensive Control of Keys

Using CLIQ™ Manager program or CLIQ™ Manager Plus program, you have complete control over the 

electromechanical and mechanical keys of your lock system. In this lock system, every key is unique and can be 

completely personalised for each key owner. 

This provides you with the required flexibility for assigning electromechanical locking permissions and also 

guarantees security, since you can immediately revoke the locking permissions for the cylinders in 

electromechanical keys that have been lost. The mechanical keys can only open the mechanical cylinders of their 

own lock line and are thus barred from accessing restricted areas of your facilities.

Fig. 1.1/1: Electromechanical and mechanical keys

Using the system programming keys, authorised employees can program the electromechanical cylinders 

according to the locking permissions of the electromechanical keys. 
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The electromechanical programming keys and electromechanical user keys in the electromechanical lock 

system from IKON have the following performance features:

The mechatronic lock system that you manage using CLIQ™ Manager program or CLIQ™ Manager Plus program 

can be equipped with different cylinder types with a wide range of lengths for various door leaf thicknesses. This 

allows you to use an electromechanical lock on one side of the cylinder and a mechanical lock on the other. You 

can choose whether to use an electromechanical or mechanical locking mechanism on either side of the door and 

you can also assign separate locking permissions for each side. You simply combine electromechanical and 

mechanical locking mechanisms for the two sides of a cylinder as you require them for your locking system. 

The electromechanical cylinders in the electromechanical lock system from IKON have the following 

performance features:

User keys

With unique encoding

Lithium battery in key head

Battery life of 30,000 lockings

Key and battery are splash-proof

Available in three types:

E1, with memory for up to 50 events and without 

quartz for time settings

E2, with extended memory for up to 100 events and 

with quartz for time settings

E3, Additionally with time function and event 
memory for the last 1,000 closings, possibility to 
directly program authorizations without starting the 
cylinders

Secure cylinder system

Programming keys

Transmission of up to 3,000 programming steps 

(jobs) to electromechanical cylinder

Transfers program to key E3

Lithium battery in key head allows up to 6,000 events 

to be read from electromechanical cylinders

Does not have a closing function

Detailed information on the individual product areas 
can be found in the product area under:
http://secure.assaabloy.com

Basic

Electromechanical locking with five 

mechanical and one 

electromechanical tumbler as well 

as a stop bar

With unique encoding

Optional: Anti-drill protection AB=2

Integrated memory chip

Standard memory E1

Authorisation for up to 100 

electronic groups possible (more 

than 65,000 individual keys 

possible per group)

Up to 100 individual keys can be 

blocked

Closing processes and attempts 

can be logged (up to 50 events)

Extended memory E2 

Authorisation for up to 1500 

electronic groups possible (more 

than 65,000 individual keys 

possible per group)

Up to 1500 individual keys can be 

blocked

Closing processes and attempts 

can be logged (up to 750 events)
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The mechanical cylinders in the electromechanical lock system from IKON have the following performance 

features:

The modular IKON cylinders (electromechanical or mechanical) can be retrofitted to different door leaf widths. The 

expansive range of IKON products provides you with much freedom and flexibility in planning your facility's lock 

system.

Fig. 1.1/2: Examples from type catalog

Transfer function of programming device

Using the Programming device, you can transfer encypted data between the CLIQ™ Manager program or CLIQ™ 

Manager Plus program and the programming key. After changing the locking permissions in the program, you use 

the programming device to send these to the programming key. In turn, you can use this key to program the 

electromechanical cylinders of your facility's locks.

Fig. 1.1/3: Programming device

Mechanical lock utilises 12 mechanical tumblers and 

two stop bars

Optional: Anti-drill protection AB=2

Knob cylinder Double cylinder Single cylinder

Padlock Furniture inset lock Camlock
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Similarly, the programming device also transfers the defined access times into keys of type E2 or E3. All events 

from the electromechanical keys and cylinders are read out by the programming device and stored in event lists 

that can be viewed using CLIQ™ Manager program or CLIQ™ Manager Plus program. These lists provide you with 

an overview all of lock events recorded by the electromechanical keys within your facility.
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2. Installation and Update

2.1 Installing the Program

You can install CLIQ™ Manager or CLIQ™ Manager Plus in any of the following operating systems:

- Windows 7 (32/64 Bit)

- Windows 8 (32/64 Bit)

- Windows 8.1 (32/64 Bit)

- Windows 10 (32/64 Bit)

Minimum hardware requirements:

- The prerequisite is always that of the respective operating system

- Memory 1 GB

- Hard disk capacity 1 GB

- 1 Gigahertz (GHz) or faster processor

Insert the installation CD for CLIQ™ Manager or CLIQ™ Manager Plus in the CD drive of your Windows computer. 

A start window appears where you can choose the installation language by clicking the corresponding button.

Note:  If you want to install CLIQ™ Manager or CLIQ™ Manager Plus in a network, the administrator has 

to carry out the installation.

Fig. 2.1/1: Start window

Click the [Install / Update] button to start the installation (see section 2.1.1). Click the other buttons in the start 

window to view information about this program.
Version:  P84 5 133 0106_ENP845133 00017 0EN 0A    04/18



2.1-2 Installing the Program Manager
2.1.1 Starting the InstallShield Wizard

In the Start window (see fig. 2.1/1), click the [Install /Update] button to start the InstallShield Wizard. This wizard 

guides you throughout the installation of the CLIQ™ Manager or CLIQ™ Manager Plus. Click the [Next] button to 

start the program installation.

Fig. 2.1/2: InstallShield Wizard

Click the [Cancel] button to close this and the following window without installing the program. In the message 

window that appears, click the [Yes] button to cancel the installation.

Fig. 2.1/3: Message window

Click the [No] button to display the InstallShield Wizard again.
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2.1.2 Accepting the Software License Conditions

This window displays the software license conditions for the CLIQ™ Manager or CLIQ™ Manager Plus program. 

Click the [Yes] button to agree to the software license conditions and continue with the program installation.

Click the [Back] button to return to the previously displayed window. Click the [No] button to close this window 

without installing the program.

2.1.3 Choosing the Target Path

To install the CLIQ™ Manager or CLIQ™ Manager Plus in the given “Destination Folder”, click the [Next] button.

Note:  Only experienced Windows users should change the target path.
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Click the [Browse...] button to choose a different target folder for the program installation. In the window that 

opens, double-click the new target folder in the “Directories” box. This is where the CLIQ™ Manager or CLIQ™ 

Manager Plus will be installed.

In the “Path” box, you can see the currently selected installation path. Alternatively, you can directly enter the 

target path in this box. Click the [Cancel] button to close this window without changing the target folder for the 

installation.

Click the [OK] button to confirm your selection and install the program in the selected target folder and click [Next] 

button in the InstallShield Wizard. Click the [Back] button to return to the previously displayed window.

Note:  You can also install to a network drive given that the server is not used as a file server. This 

allows multiple users to access the database of CLIQ™ Manager or CLIQ™ Manager Plus. If your 

server is used as a file server, the CLIQ™ Manager or CLIQ™ Manager Plus has to be installed on 

a local hard drive and the database has to be selected in the “Config. Options” window (see 

section 7.5.1). 

The program is installed into the specified target folder and the setup window displays the installation progress.
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The bar and percent value indicate the installation progress.

2.1.4 Completing the Installation

Click the [Finish] button to complete the installation of CLIQ™ Manager or CLIQ™ Manager Plus.

After the installation is complete, the  icon is added to your Windows desktop that you can click to directly start 

the program.

Note:  Before you start the program, first connect the programming device as described in section 2.2. 
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2.2 Connecting the Programming Device

To transfer the electromechanical data between the CLIQ™ Manager or CLIQ™ Manager Plus and the 

programming key, you have to connect the programming device to your Windows computer. The programming 

device is available with USB and COM interfaces. If the programming device is connected to your computer’s USB 

interface, it is referred to as a “ USB programming device” in this user guide. A programming device connected 

to your computer's COM port is referred to as a “ COM programming device” in this user guide.

Before you connect the programming device to your Windows computer, insert your programming key into the 

keyhole marked by a coloured semi-circle and insert an electromechanical key into the other keyhole on your 

programming device.

2.2.1 COM Programming Device

Shut down your Windows computer and turn it off before connecting your COM programming device to an 

available serial COM port (COM 1 or COM 2). Connect the serial ports of your programming device (see fig. 2.2/

1) and computer using a serial cable. Restart your Windows computer.

“

Fig. 2.2/1: Programming device connectors

Double-click the  icon on your Windows desktop to start the program as described in section 3.1.

2.2.2 USB Programming Device

You can connect the USB programming device to a free USB interface on your Windows computer without having 

to shut down your Windows computer. Connect the USB ports of your programming device (see fig. 2.2/1) and 

computer using the USB cable.

If your Windows computer does not find an appropriate USB driver for your USB programming device, the “Found 

New Hardware” window opens. 

COM port USB port
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“

Fig. 2.2/2: “Found New Hardware” window

In this window you can see that the USB driver for the USB programming device has not yet been installed on your 

Windows computer.

Note: The USB driver is located on your installation CD for the CLIQ™ Manager or CLIQ™ Manager Plus.

2.2.3 Installing USB Drivers

Note: You install a USB driver in two parts. You begin by installing the “USB converter” followed by 

the software for the “USB port” on your Windows computer.

Part 1: Search for and install the software for the “USB converter”

Windows 98, Windows 2000 and Windows ME

Under Windows 98, Windows 2000 and Windows ME, the “Found New Hardware” window opens to help you find 

and install the “USB Converter” software.

Fig. 2.2/3: “Add New Hardware Wizard” window
Version:  P84 5 133 0106_ENP845133 00017 0EN 0A    04/18



Connecting the Programming Device 2.2-3Manager
Click the [Cancel] button to close this window again without searching for and installing the “USB Converter” 

software. Click the [Next] button to start the search. Another window opens where the option “Search for a 

suitable driver for my device (recommended)” is selected. Click the [Cancel] button to close this window and 

cancel the search. Click the [Back] button to return to the previously displayed window.

Do not make any changes to the settings and click the [Continue] button to continue with the search. In the 

window that opens, check that the two options “Floppy disk drives” and “CD-ROM drives” are selected. Click 

the [Cancel] button to close this window and cancel the search. Click the [Back] button to return to the previously 

displayed window.

Click the “Floppy disk drives” option to clear it and click the [Continue] button to continue with the search. 
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The next window indicates that the search is complete and that the “USB converter” has been found. Click the 

[Cancel] button to close this window again without searching for and installing the “USB Converter” software. Click 

the [Back] button to return to the previously displayed window.

Click the [Continue] button to install the “USB Converter” software. In the following window, click the [Finish] 

button to complete the installation of the “USB Converter” software.
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Windows XP

Using Windows XP, a message appears above the status bar and the hardware wizard will guide you through the 

installation process for the “USB converter” software. Select “No, not this time” and click the [Continue] button.

Fig. 2.2/4: “Add New Hardware Wizard” window

Click the [Cancel] button to close this window again without searching for and installing the “USB Converter” 

software. Click the [Next] button to start the search. In the following window, you have to click the “Select 

software from list or specified source (for advanced users)” option. Click the [Cancel] button to close this 

window and cancel the search. Click the [Back] button to return to the previously displayed window.
Version:  P84 5 133 0106_ENP845133 00017 0EN 0A    04/18



2.2-6 Connecting the Programming Device Manager
Click the [Next] button to continue the search. In the window that opens, you have to select the “Search 

Removable Storage (Floppy, CD, ...)” option. Click the [Cancel] button to close this window and cancel the 

search. Click the [Back] button to return to the previously displayed window.

Click the [Cancel] button to install the “USB Converter” software. You can monitor the installation process in the 

window that appears. The bar and percent value indicate the installation progress.

Click the [Cancel] button to install the “USB Converter” software. In the following window, click the [Finish] button 

to complete the installation of the “USB Converter” software.
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Once you have installed the “USB Converter” software on your Windows computer, this completes the first part of 

the USB driver installation.

Part 2: Search for and install the software for the “USB port”

Under Windows 98, Windows 2000 and Windows ME, the “Found New Hardware” windows opens where you can 

search for and install the “USB Port” software. In this window, a message appears indicating that the “USB Port” 

software was not found on your Windows computer. 

Fig. 2.2/5: “Found New Hardware” window

In Windows XP, the “Found New Hardware” window appears above the status bar to indicate that the “USB Port” 

software was not found on the Windows computer. 

At the same time, a wizard starts to help you search for and install the “USB Port” software. Repeat the same steps 

as described in the first part for the second part.

After installing the “USB Port” software, the following window opens in Windows 98, Windows 2000 and Windows 

ME.
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In Windows XP, the following window appears.

Click the [Finish] button in the window to complete the installation for the second part. 

The USB driver is now completely installed. To start the program, double-click the  icon on your desktop of your 

Windows computer (see section 3.1).
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2.3 Installing the Update

You can install an update for your program from a CD or after downloading it from the Internet. Double-click the 

installer file (format:  “.exe”), to start the file for the update. In the start window that opens (see fig. 2.1/1), click 

the [Install / Update] button to start the InstallShield Wizard. Choose the “Update” option box  and click the 

[Next] button.

Fig. 2.3/1: InstallShield Wizard

The bar and percent value in the InstallShield Wizard indicate the installation progress. Click the [Finish] button 

to complete the installation of CLIQ™ Manager or CLIQ™ Manager Plus.

Double-click the  icon on your Windows desktop to start the CLIQ™ Manager or CLIQ™ Manager Plus program

(see section 3.2). 
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In the “Update CLIQ Manager” window that opens, click the [OK] button to update the program. Click the [Cancel] 

button to close this window without updating the program.

Fig. 2.3/2: “Update CLIQ Manager” window

The following message window indicates that the program can only be updated when no other users are accessing 

the database (see section 7.5.1). Make sure that no other users are accessing the database before you click the 

[Yes] button in this message window. Click the [No] button if there are still other users accessing the database.

Fig. 2.3/3: Message window

In the message window that appears after you successfully update the program, click the [OK] button.

Fig. 2.3/4: Message window
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2.4 Uninstalling the Program

Insert the installation CD for the CLIQ™ Manager or CLIQ™ Manager Plus into the CD drive of your Windows 

computer and click the [Install / Update] button in the start window (see fig. 2.1/1) to start the InstallShield Wizard. 

Choose the “Uninstall” option and click the [Next] button.

Fig. 2.4/1: InstallShield Wizard

In the message window that appears, click the [Yes] button to delete the files you no longer require. If you click 

the [No] button, these files are kept.

After you uninstall the program from your Windows computer, the InstallShield Wizard opens. Click the [Finish] 

button to continue uninstalling the program.
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To delete all of the files from the CLIQ™ Manager or CLIQ™ Manager Plus from your Windows computer, right-

click [Start] in the taskbar of your computer and open the Explorer from the shortcut menu.

In the Explorer, select the “A2Software” folder that was created when you specified the target installation path 

(see section 2.1.3). Delete this folder by choosing “Delete” from the “File” menu and clear the contents of the 

Recycle Bin on your Windows computer.
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3. Starting the Program

3.1 Starting the Program for the First Time

Double-click the  icon to start CLIQ™ Manager or CLIQ™ Manager Plus program proceed as described below 

to register and configure the program.

3.1.1 Entering the License Number

In the “Registration Key” window that opens, enter the license number to register your program. You can register 

the software by Internet or by fax.

Fig. 3.1/1: “Registration Key” window

Online registration

Click the [www.registerserver.com] button to register the program over the Internet. As soon as your computer 

is connected to the Internet, a browser opens to the registration page of IKON. The key for your program is 

displayed in the “Registration key” box of this web page.

Fig. 3.1/2: Registration page
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Click the [SEND KEY] button to display the corresponding license number. The following Web site appears with 

your license number. Write down this license number and close the Web site by clicking the  symbol.

Fig. 3.1/3: Registration page with display of license number

Registering by fax

In the “Registration Key” window, click the [Fax Form] button to register your program by fax. Enter your company 

data into the fax form. Click the  symbol to print out the form and then click the  symbol to send the fax to 

IKON.

Fig. 3.1/4: Fax form for company data
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In the “License number” input box of the “Registration Key” window, enter the license number that was sent to 

you by Internet or fax for your program (see fig. 3.1/1). Click the [Cancel] button to close this window without 

entering the license number. Confirm your license number by clicking the [OK] button. 

If you enter an incorrect license number, the following message window appears. Click the [OK] button to confirm 

and enter the correct license number for your program.

Fig. 3.1/5: Message window

3.1.2 Entering company data

Once the license number is accepted, the “Company Data” window opens. In this window, you can enter your 

company's data so that it appears in the header of your printouts (see section 6.10). Click the arrows next to the 

“Open From” and “Closed From” input boxes to set the opening times for your company. You can also enter, 

modify or add to the company data at a later point in time (see section 7.4).

Fig. 3.1/6: “Company Data” window

Click the  symbol to insert your company's logo. In the “Open” window that appears, choose the folder from 

the “Look in” selection box and select the image file in the display box below.
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Fig. 3.1/7: “Open” window

The selected image file appears in the “File name” input box. To apply this image as your company's logo, click 

the [Open] button or double-click image file in the “Company Data” window. Click the [Cancel] button to close this 

window without using the logo.

Note: You can use image files of “.jpg”, “.bmp”, “.wmf” and “.ico” format as a logo in the “Company 

Data” window.

To delete your company's logo from the “Company Data” window, simply click the  symbol. Click the [Cancel] 

button in the “Company Data” window to close this window and exit the program without applying the company 

data. Click the [OK] button to apply any changes to the company data and open the “Login” window.

3.1.3 Logging in

After you enter your license number and any of your company data, the “Login” window opens. In this window, you 

have to log in as a supervisor to operate the program.

Fig. 3.1/8: “Login” window

Note: The first time you start the program, you can only log in as a supervisor without a password.
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Click the [Cancel] button to close this window without starting the program. Click the [OK] button to start the 

program. The loading progress is briefly shown in a window.

3.1.4 Configuring the Programming Device

After starting the program, the “Programming device options” window opens to the “Communications” tab. This 

tab displays the data communication settings for the programming device. 

Fig. 3.1/9: “Programming device options” window with “Communications” tab

Check whether the settings displayed in the “Comm. Port” field correspond to the computer port that your COM 

or USB programming device is connected to.
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Displaying the port of your Windows computer

To display the available ports ( COM and LPT) on your Windows computer, proceed as follows:

- Right-click the My Computer icon and choose the “Properties” function from the shortcut menu.

Fig. 3.1/10: Shortcut menu

- The “System Properties” window opens to the “General” tab. Open the “Hardware” tab by clicking the

corresponding tab.

Fig. 3.1/11: “System Properties” window with “Hardware” tab

- In this tab, click the [Device Manager] button to open the “Device Manager” window. Click the  symbol

to the left of “Ports (COM and LPT)” to expand the list. This list contains all of the available ports on

your Windows computer.
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Fig. 3.1/12: “Device Manager” window

Checking the port and transfer rate settings in “Programming device options” window

If necessary, change the port shown in the “Comm. Port” selection box of the “Programming device options” 

window so that it corresponds to the COM or USB port listed for the programming device in the “Device Manager”.

As shown in the “Device Manager” for the USB port or the programming device, change the settings in “Comm. 

Port” to “COM 3” for your USB programming device.

Fig. 3.1/13: “Programming device options” window with “Communications” tab

Check the data transfer rate given in the “Comm. Speed” selection box. This value must be set to 115200 so 

that your Windows computer can communicate with your programming device. 
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Once you have checked these settings, click the  symbol to apply the settings to the programming device. In 

the message window that appears, confirm by clicking the [OK] button.

Fig. 3.1/14: Message window

Once the data transfer is complete, click the [Exit] button in the “Programming device options” window to close 

the window again and display the main operating window (see fig. 3.2/12) of the program.

In this window, you can import data for your lock system, enter personnel data and administer the system keys. 

Before you can run any of the functions in the program, you first have to import your lock system data into CLIQ™ 

Manager (as described in 6.2.1) or into CLIQ™ Manager Plus program (as described in 9.2.2).
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3.2 Starting the Program

The supervisor can configure other users for CLIQ™ Manager or CLIQ™ Manager Plus program with user 

names and passwords (see section 7.2). These users can receive various access permissions for the program 

functions.

The “Login” window appears each time you start the program. In this window, you have to log in as a user to 

operate the program. 

Fig. 3.2/1: “Login” window

3.2.1 Choosing and Releasing Users

Choosing users

Click the  symbol to open the “Select User” window. This window lists the users that have been configured by 

the supervisor. If no user is selected as the progam operator here, the supervisor is activated automatically in the 

“Login” window. 

Fig. 3.2/2: “Select User” window
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Click your user name to select it and confirm by clicking the [OK] button or double-click the line. Click the [Cancel] 

button to close the “Select User” window without applying your user name in the “Login” window. 

In the “Login” window, your user name is displayed in the “Name” input box and you have to enter your password 

into the “Password” input box. 

Fig. 3.2/3: “Login” window

If you enter an incorrect password, a message window appears. Click the [OK] button to confirm the message 

window and enter the correct password.

Fig. 3.2/4: Message window

If you enter the password incorrectly three times consecutively, the following message window opens. Confirm this 

message by clicking the [OK] button. The “Login” window closes and the CLIQ™ Manager program or CLIQ™ 

Manager Plus program do not start.

Fig. 3.2/5: Message window
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Click the [Cancel] button in the “Login” window to close this window without starting the CLIQ™ Manager or CLIQ™

Manager Plus program. Click the [OK] button to start the program. The loading progress is briefly shown in a 

window.

Releasing a user

If you log on but the program crashes, a message window will appear the next time you click the [OK] button in 

the “Login” window (see fig. 3.2/3).

Fig. 3.2/6: Message window

Click the [OK] button to confirm the message window and click the activated  symbol in the “Login” window 

(see fig. 3.2/3).

In the “Release user” window that appears, enter your password in the “Password” input box.

Fig. 3.2/7: “Release user” window

Click the [Cancel] button to close this window without releasing your user name for operating the program. Click 

the [OK] button to release your user name for the program again. 

Note: If the program crashes for a supervisor, supervisors can only be released by themselves.

CLIQ™ Manager program or CLIQ™ Manager Plus program starts and the loading progress is briefly displayed in 

a window.
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3.2.2 Releasing the Lock System

Note: In CLIQ™ Manager Plus program, you have to select the lock system first before it can be released 

(see section 9.2.7).

After a program crash in CLIQ™ Manager program, you first have to release the imported lock system before you 

can continue to operate it.

After a program crash, a message window opens when you click the [OK] button in the “Login” window (see fig. 

3.2/3) or “Release users” window (see fig. 3.2/7).

Fig. 3.2/8: Message window

Click the [Yes] button in the message window to open the “Release” window. Enter the word “release” into the 

input box using lower case letters.

Fig. 3.2/9: “Release” window

Click the [OK] button to continue releasing the lock system. The “Type in the PIN” window opens.  In the input box 

provided, enter the PIN code of your programming key for this lock system and confirm your entry by clicking the 

[OK] button (see section 5.4). The CLIQ™ Manager program opens with the imported lock system and you can 

operate the program with this system.

If you click the [No] button in the message window (see fig. 3.2/8) or the [Cancel] button in the “Release” window, 

the “Type in the PIN” window opens. After confirming with the [OK] button, you can no longer run any operations 

in the CLIQ™ Manager program.
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3.2.3 Displaying Overdue Keys

Note: In CLIQ™ Manager Plus program, you have to select the lock system first before you can display 

overdue keys (see section 9.2.5.2).

You can assign a return date to all keys that are given out to personnel (see section 6.3.2.2). In other words, the 

key has to be given back by the return date. If the return date expires before the key is returned, a message 

window appears when you open CLIQ™ Manager program.

Fig. 3.2/10: Message window

Click the [Cancel] button to close this without displaying the overdue keys. Click the [Yes] button in the message 

window to open the “Reminder list” window.

Fig. 3.2/11: “Reminder list” window

Under “Keyholder” in the reminder list, you can see the personnel that is to be reminded of their overdue keys 

(as described in 6.3.3). As soon as you receive an overdue key, insert this into the programming device and click 

the  symbol. The line with the overdue key is marked in the list so that you can immediately see the information 

pertaining to this key.

Click the [OK] button to close this window without printing out the list of overdue keys. Click the  symbol to 

open the “Report Actions” window (see fig. 5.6/2) where you can change the printer settings (as described in 

section 5.6) or print out this list. You can also create a printout with a list of overdue keys at a later point in time 

(see section 6.10.6).
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3.2.4 Program Window

After CLIQ™ Manager or CLIQ™ Manager Plus program starts and the loading process is complete, the 

corresponding program window appears.

Fig. 3.2/12: Program window for CLIQ™ Manager Plus or CLIQ™ Manager

In these program windows, you can only run those program functions for which you have permission. Certain 

program functions, such as displaying programming keys for the lock system, are restricted to the supervisor. If 

you try to run a function for which you do not have permission or for which only the supervisor has permission, the 

following message window will appear. Confirm this message by clicking the [OK] button.

Fig. 3.2/13: Message window

The CLIQ™ Manager program opens to the imported electromagnetic lock system automatically. Since  CLIQ™ 

Manager Plus program does not (as described in 9.2.5.1), you first have to select a lock system before you can 

use any of the functions.
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3.2.5 Notes on this User Guide

For the most part, the CLIQ™ Manager and CLIQ™ Manager Plus programs contain the same functions. Only a 

few functions are different in the two programs and these are explained in this guide.

In following, we describe the functions of the CLIQ™ Manager program. All additional functions or functions that 

differ in the CLIQ™ Manager Plus program are described separately in section 9. 

The following functions are different in the CLIQ™ Manager and CLIQ™ Manager Plus programs:

- Importing lock systems (see section 6.2.1 for CLIQ™ Manager or section 9.2.2 for CLIQ™ Manager Plus)

- Importing facility data for lock systems (see section 6.2.3 for CLIQ™ Manager or section 9.2.6 for CLIQ™

Manager Plus)

- Releasing lock systems (see section 3.2.2 for CLIQ™ Manager or section 9.2.7 for CLIQ™ Manager Plus)

- Displaying overdue keys (see section 3.2.3 for CLIQ™ Manager or section 9.2.5.2 for CLIQ™ Manager

Plus)

The CLIQ™ Manager Plus program also allows you perform the following additional functions:

- Open a lock system (see section 9.2.5)

- Create a mechanical lock system (see section 9.2.4)

- Delete a lock system (see section 9.2.8)

- Assign personnel to lock systems (see section 9.3.1)

- Display a person's keys for other locking systems (see section 9.3.2)
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4. Brief Description

In following, we briefly describe the main features of CLIQ™ Manager or CLIQ™ Manager Plus program so that you

have a broad overview of the available functionality. For a more detailed description of the available functions, 

refer to the later chapters in this user guide.

4.1 Configuring the Program

Before you begin to use these functions, be sure to configure the program according to your requirements.

Changing the operating settings

There are a range of symbols available in the “Setup” program area for configuring the operating parameters:

- If you are a supervisor, click the  symbol to configure additional users for operating the program in 

the “Users” window. For each user, you can assign access permissions for the various program functions 

as well as a password that the user has to enter each time they start the program.

- You can switch the user that is logged in to the progam at any time without having to restart the program.

Click the  symbol and enter your user name and, if required, your password in the “Change user”

window.

- You can also change the company data that was entered when the program was installed. This data is

displayed in the headers of the reports that you print out. Click the  symbol and enter the changes in

the “Company Data” window.

- In the “Config. Options” window that you open by clicking the  symbol, you can make additional

program settings. You can also change the location where the database is stored so that other users

also have access. Change the settings for displaying symbols and icons, such as the the symbol that

appears while transferring locking permissions to keys of type E3. You can enter the time and date

formats for the program. To use existing lock system data in a new version of the program, you can

import the files from the previous program versions. The symbols used to represent the door plan of your

facility are freely configurable. You can also enter standard text messages for issued and returned keys,

for reminders to users with overdue keys as well as for notifications of changes.

- To change the language that the program is displayed in, click the  symbol. The “Select Keybank 

language” opens where you can choose the language.
Version:  P84 5 133 0106_ENP845133 00017 0EN 0A    04/18



4.1-2 Configuring the Program Manager
Changing the electronic settings

The symbols in the “Elec. Setup” program area allow you to change the following electronic settings for the 

program:

- If you are a supervisor, click the  symbol in the “C-Key list” to assign different programming

permissions to the subordinate programming keys (C-Key) for the given user in the lock system. The

main programming key (C-Key) always has to be in the possession of the supervisor.

- If required, you can change the PIN code for your programming key after inserting it into the correct

keyhole on the programming device. Click the  symbol and enter the new code in the “Change PIN 

code” window.

- If the quartz-controlled time in a programming key or key of type E2 or E3 does not match the time in

your Windows computer, you can synchonize the time setting in the key. Click the  symbol and

choose the correct port on your programming device. In the “Diagnostics” tab of the “Electronic

Information” window, synchronize the time setting by clicking the  symbol.

- To change the settings in the connected programming device, click the  symbol in the “Programming 

device options” window.
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4.2 Executing Important Functions

After importing the facility data for your electromechanical lock systems and creating users, you can use the 

symbols in the “System” program area to execute the following functions.

Managing the keys

In the “Daily Work” window, click the  symbol to manage the keys of the imported or selected lock system. In 

this window, you can select persons and issue them with keys or register keys that they have returned. You can 

issue keys of the following types:

- Key of type E1 (without quartz), locking permission can be activated or deactivated

- Key of type E2 (with quartz), locking permissions can be restricted to certain times

- Key of type E3 (with quartz), locking permissions can be directly progammed and restricted to certain

times

You issue a specific key type to personnel groups to restrict their locking permissions or limit them to certain times. 

For example, you would assign a key of type E3 to a construction worker who regularly changes rooms and 

requires door access permissions. You can quickly and easily change the locking permissions for keys of type E3 

without having to reprogram the electromechanical cylinders. Similarly, you can enter a key that someone has lost 

as missing in the “Daily Work” window. When the return date for a key expires, the overdue key is added to a 

reminders list. You can print out each reminder from a reminders list separately and give these to the 

corresponding persons.

Applying time settings for keys of type E2 or E3

To restrict the locking permissions for key of type E2 or E3 to certain times, open the “Key List” window by clicking 

the  symbol and select the key by clicking it. Click the  symbol to open the “Electronic. Key Card” window. 

In this window, open the “Electronic. information” tab. Open the “Key time options” window by clicking the 

symbol and enter the access timetable for keys of type E2 or E3. You can save these settings as a timetable 

template for future use.

Changing locking permissions for an electromechanical key

Click the  or   symbol to open the “Door Plan” or “Lock Chart” window and change the locking permissions 

of an electromechanical key for an electromechanical cylinder. In the “Door Plan” window, you can tell whether a 

key is permitted to access a given cylinder by the colour of the door symbol. By switching to access mode, you 

can grant or revoke locking permission for a cylinder to a key of type E1 or E2. In the “Lock Chart” window, the 

locking permission assignments between the keys and cylinders are displayed using special symbols in a function 

matrix. You can quickly and easily change the assigned permissions by clicking the corresponding icon for the key 

of type E1, E2 or E3.
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Transferring modified locking permissions to the electromechanical cylinders

After changing a key’s locking permission for a given cylinder, you have to transfer the changes to the locking 

permissions to the cylinders. Click the  symbol in the “Door Plan” or “Lock Chart” window to transfer lock 

permission changes to the programming key using the programming device. You can also print out a “To Do” list 

with a list of the cylinders to be programmed by the programming key with the new locking permissions. Insert 

the programming key into each cylinder for which the locking permissions are to be changed. Hold the 

programming key in the cylinder until the  symbol appears on the display. After programming the cylinders 

using the programming key, click the  symbol to confirm within the program that the locking permissions have 

been changed.

Authorizing cylinders for keys of type E3

In order for a key of type E3 to be able to access a given electromechanical cylinder, you first have to authorise 

the cylinder for keys of this type. By assigning the authorisation, these cylinders become authorised cylinders that 

keys of type E3 can only access after you have assign them with locking permission for these cylinders. Click the 

 or   symbol to open the “Door Plan” or “Lock Chart” window and grant or revoke authorisation to 

electromechanical cylinders for keys of type E3. In the “Door Plan” window, you can tell whether a key of type E3 

is permitted to access a given cylinder by the colour of the door symbol. By switching to access mode, you can 

grant or revoke a cylinder authorisation for a key of type E3. In the “Lock Chart” window, the cylinder authorisations 

for keys of type E3 are displayed using special symbols in a function matrix. You can quickly and easily change 

the assigned authorisation by clicking the corresponding symbol for the key of type E3. After changing the cylinder 

authorisation for a key of type E3 in the software, you have to transfer this information to the cylinders. Click the 

 symbol in the “Door Plan” or “Lock Chart” window to transfer the authorisation changes as described above.

Changing the locking permission for a key of type E3

Using the programming device and programming key, you can directly change the locking permissions for a key 

of type E3 without having to transfer the new permissions to each electromechanical cylinder. As a prerequisite, 

the corresponding electromechanical cylinders must be authorised for keys of type E3. Click the  symbol to 

open the “Lock Chart” window. Click the  symbol to highlight the inserted key of type E3 in the function matrix. 

In the function matrix, you can change the locking permission for the key of type E3 by clicking the special symbol. 

Afterwards, click the  symbol to transfer the modified locking permission to the key of type E3 using the 

programming key.
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Reading event lists from electromechanical keys and cylinders

All authorised or non-authorized lock actions in keys and cylinders are recorded in event lists. To view the event 

lists, you can read out the data from a key using the programming key. Click the  symbol to open the “Select 

PD port” window and select the correct port on the programming device to display the event lists for the key. To 

read out the event lists from a cylinder, click the  symbol to open the “Door/Cyl. List” window and then select 

the corresponding cylinder.

Printing out lists

Click the  symbol to open the “Reports” window where you can choose from various types of lists to be printed. 

The following types of lists are available as previews or final printouts:

- Personnel list

- Visitor list

- Key list

- List of missing keys

- Key status list

- List of overdue keys

- Access permissions list

- Locking permissions list
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4.3 Electromechanical Keys

An electromechanical lock system comprises of both electromechanical programming keys (C-Key) and 

electromechanical user keys. You use the programming keys to program the locking permissions for the user 

keys into the electromechanical cylinders of your lock system. Every user key is unique and can be completely 

personalised for its owner. The user keys can be of type E1, E2 or E3. You can define time settings for the lock 

permissions into keys of type E2 and E3.

Fig. 4.3/1: Electromechanical key

The programming and user keys are high-quality electromechanical products that have to be kept dry and clean. 

If a user key becomes wet or dirty and fails to function properly during opening and closing, ensure that the key 

is cleaned using a dry cloth or similar. When closing, the key release is delayed by approx. 0.3 s to allow for 

energy and data transfer.

The programming keys are completely red to differentiate them from the electromechanical user keys. Both keys 

have an LCD that displays the following information using appropriate symbols:

Symbol Inserted User key Programming key (C-Key)

No Normal status

No Battery almost empty, please replace (grey: symbol flashes)

No Battery empty, no function

Yes
Locking permission OK (display remains visible 
up to 5 s after removing key)

Yes
No locking permission (display remains visible 
up to 5 s after removing key)

No No permission currently or time is invalid

Yes Programming activated (grey: symbol flashes)

No
Programming of all cylinders not yet complete 
(grey: symbol flashes)

Yes
Cylinder was successfully programmed (display 
remains visible up to 5 s after removing key)

Yes
No programming required for this cylinder 
(grey: symbol flashes)

No Key contacts have short-circuited
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4.3.1 Replacing the Battery

If the  symbol or the  symbol appears in the LCD of a key, this indicates that the battery has to be 

replaced. The battery in electromechanical and programming keys is integrated in the key head and can be 

replaced quickly and easily. Use commercially available CR-2025 lithium button cells for the keys. 

After replacing the battery in a programming key or key of type E2 or E3, you have to synchronise the time.

Fig. 4.3/2: Replacing the battery

Note: The time settings are initially deactivated in keys of type E2 and E3 for safety reasons. You can 

only transfer the time settings to these keys after first synchronising their internal times (see 

section 6.5.7) 

4.3.2 Synchronising the Time

Note: Make sure to insert the programming key and key of type E2 or E3 into the correct ports on your 

programming device for the lock system that you have imported into CLIQ™ Manager or selected 

in CLIQ™ Manager Plus (see section 5.3).

Click the [Elec. Setup] button in the taskbar to open the “Elec. Setup“ program area. Next, open the “Select PD 

Port“ window by clicking the  symbol.

Fig. 4.3/3: “Select PD port“ window
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In this window, select the correct port for the key in which the battery has been replaced. The “Electronic 

Information“ window opens to the “Lists” tab. Click the “Diagnostics” tab to open it.

Fig. 4.3/4: “Electronic Information” window with “Diagnostics” tab

Click the  symbol to open the “Checking key quartz” window and click the [Start] button in this window to 

transfer the time synchronisation settings to the corresponding key. Click the [Cancel] button to close the window 

again.

Fig. 4.3/5: “Checking key quartz” window

After you transfer the time data by clicking [Start] button, a message window appears. Confirm this message 

window by clicking the [OK] button.

Fig. 4.3/6: Message window
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5. General Functions

In the following, we describe the main operating elements for running the functions in the program. We also 

describe functions that are used in the same way in multiple windows.

5.1 Operating Instructions

There is no need to remember any complicated keyboard shortcuts for operating CLIQ™ Manager or

CLIQ™ Manager Plus program. All functions are available using just a few key presses and mouse clicks. The 

graphic user interface utilizes a Window-based structure and is intuitive to operate. This means that the same 

operating elements (functions, menus, buttons and symbols) are always located at the same positions in the 

various windows and dialogs.

5.1.1 User Interface Structure

The user interface generally consists of a header, menu, symbol and taskbar as well as a window display area. In 

some windows, such as the “Key List”, the imported and created data is listed in clearly arranged rows and 

columns.

Fig. 5.1/1: User interface, such as in “Key List” window

Header

Column

Title bar of 
window

     Row

Display area of 
window

Menu bar

Toolbar

System

Taskbar

Setup

Elec.Setup
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Header

The header contains the names for each program as well as the following symbols:

Menu bar

In general, the menu bar contains the menu “System”, “List”, “Edit” and “Help” with window-specific functions.

Toolbar

The toolbar contains window-specific symbols that can be used to run specific commands.

Taskbar

The taskbar contains the symbols for each area of the program. Click one of these symbols to open the 

corresponding program area and display it on screen. Click the [Setup] button or the [Elec. Setup] button to 

display the taskbar for these areas. Click the [System] button to display the taskbar for your “System” again. 

Click the  symbol above the [System] button to minimize the taskbar display. Click the  symbol to return the 

taskbar display to its original size.

Display area

When you click a symbol in the taskbar, the corresponding window opens and appears in the display section of 

the program window. In windows that contain data lists, you can click  in the toolbar or choose the 

“Information Card” fuction in the “List” menu to display the data from a single row in an additional window. 

Alternatively, you can double or triple-click the row to open it.

The window that appears contains the “Card”, “View” and “Help” menus. After making any changes in the 

windows, click “OK” or “Cancel” in the “Card” menu to apply the changes in the window or exit the window 

without making any changes. The “View” menu contains the names of the window tabs that you can display by 

clicking the name. Click “Additional help” or “Help screen” in the “Help” menu to open the online Help or the 

simple Help for the program (see section 5.2.1).

Minimizes program to taskbar of your Windows computer

Not active

Closes the program

Click a menu item to drop down the menu and select a function by clicking 

iti.

Click a symbol to run the corresponding function. Click this symbol at the right of the toolbar to 

quit the program area or exit the program.
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5.1.2 Operating Elements

Buttons

Click a button to run the corresponding function. Below is a list of the most important buttons:

Tabs

Selection, option, input and display boxes

Scroll bars

Stores any changes you have made in a window

Applies any changes you have made to the lock system

Closes a window without applying the changes

Closes a window where no changes are possible

Click a tab to display the corresponding tabbed dialog. The tab 

of the currently active dialog is shown in front of the other tabs.

When you click an arrow next to a box, a list drops down containing functions that 

you can select. The selected function has a blue background and is displayed in the 

selection box. In some boxes, you can change the displayed value by clicking the 

arrows.

To select an option associated with a round or square option box, you simply click 

the box. A selected option is indicated by a dot in a round option box and by a check 

mark in a square option box.

To change a value in the input boxes, enter the changes using the keyboard. First 

click in the input box and then enter the new value (a flashing cursor appears in the 

box). 

The display boxes contain information and data from the lock system. You can 

change some of these settings.

If the contents of a window extend beyond the displayed area, horizontal and/or 

vertical scroll bars appear so that you can navigate to the section of the window you 

require.
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5.2 Using Help Functions

5.2.1 Displaying Online Help

Click the “Additional help” function in the “Help” menu on the menu bar to open the online Help.

Fig. 5.2/1: “Online Help” window

Open the online Help in the preferred language by clicking the corresponding key. The online Help contains 

information on a variety of topics. In the online Help, click one of buttons at the bottom of the window to display 

the table of contents for the selected topic.

Note: Clicking  the “Help screen” function in the “Help” menu on the menu bar or pressing the F1 key 

will only open a simple Help and not the detailed one describe above.
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5.2.2 Display information on the program

Click the “About ...” function in the "Help" menu on the menu bar to open a Web site containing information on 

the program. In the “CLIQ Customer” window that opens, click the “http://www.a2software.net” link.

Fig. 5.2/2: “CLIQ Customer” window

If your Windows computer is connected to the Internet, the following Web site opens.

Fig. 5.2/3: Web site with information on the program

Click the [OK] button to close the ”CLIQ Customer” window again.
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5.3 Transfer Function of Programming Device

The programming device connected to your Windows computer transfers data between the program and the 

programming key and the various electromechanical keys.

Press the [OK] button to turn on the COM programming device. Press down the [OK] button until the display of 

the COM programming device turns on. In contrast to the COM programming device, the USB programming 

device is always on and does not have to be turned on by pressing the [OK] button.

Fig. 5.3/1: Programming device 

You can change or display the settings for the connected COM programming device in the “Programming device 

options” window (see section 8.5). According to your settings, the COM programming device turns off 

automatically after the prescribed time. 

If the COM programming device is turned off when you open a security-relevant area of your program such as the 

“Lock Chart” window, a warning message appears.

Fig. 5.3/2: Security query

First press the [OK] button on the programming device and then click the [Retry] button to reconnect to the COM 

programming device. The “Type in the PIN” window appears. In this window, enter the PIN of your programming 

key for the lock system imported into CLIQ™ Manager program or selected in CLIQ™ Manager Plus program (see 

section 5.4).

Port for programming 
key

[OK] button

Port for electromechanical 
key
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Using the programming device, you can send any changes you have made to the programming key. In turn, you 

can use this key to program the electromechanical cylinders of your lock system. After you program an 

electromechanical cylinder using the programming key, you have to insert the programming key into the port of 

the programming device again and confirm the change in the program.

Similarly, the programming device also transfers the new access times into keys of type E2 or E3. In addition to 

the programming key, you also have to insert the corresponding key of type E2 or E3 into the other port on the 

programming device.

To transfer the event lists from an electromagnetic key, insert both the programming key and the 

electromechanical key into the correct port on the programming device. Event lists from an electromechanical 

cylinder are loaded into the program via the programming key that is inserted into the programming device.
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5.4 Entering the PIN Code

To run security-relevant functions for your facility's lock system in CLIQ™ Manager or CLIQ™ Manager Plus, you 

have to enter the PIN code of your programming key. This prevents unauthorized users from having access to 

security-relevant functions in the program. The security-relevant functions include changing the locking 

permissions for electromechanical cylinders and keys of type E3 as well as reading out event lists from 

electromechanical keys and cylinders.

Every electromechanical lock system has a main programming key and may have several subordinate 

programming keys. It is important that only the supervisor possesses the main programming key, since it 

provides access to all of the security-relevant functions in your facility's lock system. The supervisor can assign 

certain programming permissions to the subordinate programming keys and give these out to other users. With 

the restricted programming permissions of the subordinate programming keys, the other users can only change 

the locking permissions for certain electromechanical cylinders.

Note: Make sure to insert the programming key into the correct port on your programming device for 

the lock system that you have imported into CLIQ™ Manager or selected in CLIQ™ Manager Plus 

(see section 5.3).

When you select an electromechanical lock system or security-relevant function, the “Type in the PIN” window 

opens. In the input box of this window, enter the PIN code for the programming key of this lock system.

Fig. 5.4/1: “Type in the PIN” window

Click the [OK] button to enter the PIN code. If you click the [Cancel] button, a message window appears to warn 

that you will not be able to access security-relevant functions in the program without entering the PIN code. Click 

[OK] to close the message window.

Fig. 5.4/2: Message window
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If the corresponding programming key for the lock system that you import into the CLIQ™ Manager program or 

select in the CLIQ™ Manager Plus program is not inserted into the correct port on the programming device, a 

security query appears. This security query informs you that the inserted programming key does not belong to this 

lock system. If you click [Cancel] to close this security query, the message shown in fig. 5.4/2 appears again.

Fig. 5.4/3: Security query

If the programming key from a different user is inserted into the programming device of the lock system that you 

import into CLIQ™ Manager program or select in CLIQ™ Manager Plus program, a message window appears. 

This message informs you that the inserted programming key does not belong to you.

Fig. 5.4/4: Message window

Insert the correct programming key into the correct port on the programming device (see section 5.3) and click the 

[Retry] button in the security query or click the [OK] button in the message window.
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5.5 Viewing and Editing Entries

5.5.1 Changing the Displayed Columns

To change the way that columns are displayed in windows containing lists, click the  symbol in the toolbar or 

choose the “Select columns to show” function in the “List” menu on the menu bar.

The “Column List” window opens and lists the columns that can be displayed in the current window. Select the 

columns you require by clicking them so that they will be visible in the window. The selected columns are displayed 

using the  symbol and are arranged above the columns that are not selected. Click a previously selected 

column again to clear it so that it will not be displayed in the window.

Note: At least one column must be selected so that the entries can be listed in the current window.

Fig. 5.5/1: “Column List” window, such as for personnel data

Click the [Cancel] button to close this window without changing the way the columns are displayed in the current 

window. Click the [OK] button to display the selected columns in the current window.

The entries for each of the columns are listed in the window below the labelled column headers. You can change 

the column order by clicking a column header and, while pressing down the mouse button, dragging the column 

to a new position. Release the mouse button. The selected column is inserted at this position and the following 

columns move over by one position.

To change the column width, point the mouse cursor at the column border along the column header. The mouse 

cursor changes appearance to the  symbol. Press down the mouse button and drag the column border to 

the desired width. Release the mouse button. The selected column is now displayed using the new width.
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5.5.2 Searching for Entries in the Columns

To search for a certain entry in the list of the current window, click an entry to select the column for the search. 

The selected entry has a yellow background and black border. 

Click the  symbol in the toolbar or choose the “Find” function in the “List” menu on the menu bar. The search 

mask opens. The name of the column header that you have selected for the search is displayed below the 

selection box for the search term. Click the [Advanced] button to make additional settings for the search. The 

“Forward” and “Backward” options allow you to choose the search direction relative to the selected entry. Click 

the [Basic] button to hide the lower section of the search mask. 

Fig. 5.5/2: Search mask

Type the term into the input box that you wish to search for in the selected column. You can choose a new column 

at any time by clicking a different column in the current window.

Note: When typing search criteria, it is often sufficient to enter just the initial letters or number of the 

item you are searching for. It is important that the column is not selected, that is, the background 

colour should not be yellow and marked with a black border.

After you type in the search criterion, the  symbol (for “Found”) and the  symbol (for “Not found”) indicate 

whether or not an entry was found in the selected column that matches the search criterion.

If you select the “Whole words only” option box, the [OK] button appears. Click the [OK] button to start the 

search.

If an entry is found, the row containing the entry is highlighted in the list. The found entry has a yellow background 

and black border. Using the [Previous] and [Next] buttons in the search window, you can skip to the previous or 

next entry in the list that matches the search criterion you have entered. Click the [Cancel] button to close the 

search mask again.
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5.5.3 Adding Images

To insert an image in the current window, click the  symbol. In the “Open” window that appears, choose the 

folder from the “Look in” input box and select the image file in the display box below. The selected image file 

appears in the “File name” input box. To use this image in the current window, click the [Open] button or double-

click image file. Click the [Cancel] button to close this window without using the image.

Fig. 5.5/3:“Open” window

After inserting the image into the window, you can delete it again by clicking the  symbol.
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5.5.4 Using Autofill

When you have to change the column entries in newly created rows of a window, you can fill these entries 

automatically. 

Click a column field to select the column where you wish to autofill the entries. When you click an editable column 

field, the background colour changes to yellow and is marked with a black border. Click the  symbol in the 

toolbar or choose the “Autofill” function in the “Edit” menu on the menu bar. For instance, if you are in the “Key 

List” window, the “Keys” window opens where you can change the settings for the entries.

Fig. 5.5/4: “Keys” window

In the “Fill with” box, enter the text to be entered in the selected columns. Click the  symbol and select a 

previously defined text from the drop-down list. Select the “Overwrite Previous Text” option box to overwrite any 

existing entries in the list.

Under “Select lines to autofill”, specify the row(s) in the list, for which the optoin boxes of the selected column 

are to be filled or overwritten using Autofill. 

The option boxes below “Advanced Options” allow you to specify how to number the entries. If the “Only  

numbers” option box is selected, you have to enter the initial number and incrementation for the numbering in the 

“Start with” and “Increment” selection boxes respectively. If the “Allow numbers” option box is selected, you 

can enter the initial number or letter for the numbering as well as the number or letters for the incrementation in 

the “Start with” and “Increment” selection boxes. 

If none of the option boxes below “Advanced Options” are selected, letters are used for the ‘numbering’. You 

can define how to apply the numbering with your entries in the “Start with” and “Increment” selection boxes. 

The “Use uppercase only”, “Use uppercase and lowercase” and “Use lowercase only” option boxes are only
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activated when you select the “Allow numbers” options box or when you do not select any of the option boxes 

under “Advanced Options”. Using these option boxes, you can choose whether to use upper-case or lower-case 

letters for the ‘numbering’.

The option boxes under “Insert increment...” allow you to define the positions where the numbering appears 

amongst the entries. If you choose the “Customizable” option box, you have to enter the “#” character in the 

“Fill with” input box at the position in the text where the numbering is to appear amongst the entries. If the 

“Without increment” option box is selected, the entries will not be numbered.
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5.6 Printing Out Lists

Click the  symbol in the toolbar or choose the “Print” function in the “List” menu on the menu bar to print out 

the list from the current window. 

When you print out personnel data, the “Range of persons” window opens where you can select the first and last 

rows in the list to include in the printout by clicking the arrows in the “From” and “To” selection boxes.

Fig. 5.6/1: “Range of persons” window

Click the [Cancel] button to close this window without using the selection. Click the [OK] button to open the 

“Reports Actions” window. 

Before you print the personnel list by clicking the  symbol in the “Reports Actions” window, enter the printout 

settings in the same way as with other lists. Click the [Cancel] button to close the “Reports Actions” window and 

return to the previous window without printing the report.

Fig. 5.6/2: “Report Actions” window
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5.6.1 Choosing a Printer

Click the  symbol to select a printer. In the “Print” window that opens, you can choose a printer in the “Name” 

input box and make additional settings. Click the [Cancel] button to close this window without applying the 

settings. Click the [OK] button to return to the “Print Settings” window and click the  symbol to print the list on 

the selected printer.

Fig. 5.6/3: “Print” window

Click the [Properties...] button to make additional print settings in the tabs. 
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5.6.2 Print Preview

Click the  symbol to display a preview of the printout on screen. The header displays the name of the current 

list together with your company and system data and the current date. The selected rows are displayed in a well-

structured list below the header.

Fig. 5.6/4: Preview function, here for a list containing personnel data

Click the  button to display a full-screen preview of the printout. Click the  button to display the preview at 

100% and click the  button to display the preview at the full width of the display screen. Click the , , 

or  button to switch to the first, previous, next or last preview page respectively.

Click the [Cancel] button or choose the “Cancel” function in the “Card” menu on the menu bar to close this 

window again.
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5.6.3 Changing Company Data for Printout

Click the  symbol to open the “Company Data” window where the company data is displayed that was entered 

when you installed the program (see section 3.1.2). The company data that has been entered is added to the 

printout header and will be displayed accordingly.

After logging on as a supervisor in the “Login” window (see section 3.1.3) when starting the program, you can 

enter, edit or add to this data at a later point in time. Highlight the entry to be changed and overwrite it or enter a 

new data in the input box provided. Click the arrows next to the “Opening time” and “Closing time” input boxes 

to set the opening times for your company.

Fig. 5.6/5: “Company Data” window

Click the  symbol to insert you company's logo as described in section 5.5.3.

Note: You can use files of “.jpg”, “.bmp”, “.wmf” and “.ico” format as a logo in the “Company Data” 

window.

To delete your company's logo from the “Company Data” window, simply click the  symbol. This symbol is only 

active after you have inserted a logo.

Click the [Cancel] button to close the “Company Data” window without applying any changes. Click the [OK] 

button to confirm the changes and apply them.
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6. System

Click the [System] button in the taskbar of the program to display the symbols for this program area in the taskbar.

6.1 Taskbar

The “System” (lock system) area contains the following symbols. When you click one of these symbols, the 

corresponding window opens or is displayed so that you can access the program functions.

Note:  The CLIQ™ Manager Plus taskbar also contains the  symbol (see section 9.2).

Opens the “Daily Work” window (see section 6.3).

Displays the “Personnel” window (see section 6.4). 

Displays “Key List” window (see section 6.5). 

Displays the “Door/Cyl. List” window (see section 6.6). ).

Displays the “Door Plan” window (see section 6.7). 

Displays the “Lock Chart” window (see section 6.8). 

Displays the “System Information” window (see section 6.9). 

Opens the “Reports” window (see section 6.10).
Version:  P84 5 133 0106_ENP845133 00017 0EN 0A    04/18



6.1-2 System Manager
Version:  P84 5 133 0106_ENP845133 00017 0EN 0A    04/18



Lock System 6.2-1Manager
6.2 Lock System

Note: The following functions differ for CLIQ™ Manager Plus program and are described in section 9.2.

6.2.1 Importing System Data

Note: Make sure to insert your programming key for the lock system to be imported into the correct 

port on your programming device (see section 5.3).

Insert the medium with the data from your electromechanical lock system into the appropriate drive on your 

Windows computer. In the “Setup” taskbar, click the  symbol for “System Import” (see section 7.1) to import 

the system data. 

In the “System Import” window that opens, choose the system data format that corresponds to your lock system. 

Select the “Superlock 16 bit file” option to import data from an older lock system. The “Electronic lock system 

(*.ELS)” option is for importing newer lock systems that use keys of type E3.

Click the [Cancel] button to close this window without importing the electromechanical lock system. Click the [OK] 

button to confirm your selection and import that system data.

Fig. 6.2/1: “System Import” window

In the “Connecting DB...” window that appears, choose the folder from the “Look in” input box and select the 

system database file (format: “.WIN”) from the available files.

Click the [Cancel] button to close this window without opening the selected file. The selected file appears in the 

“File name” input box and you can open it by clicking the [Open] button or simply double-clicking the file.
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Fig. 6.2/2: “Connecting DB...” window

The loading progress for the lock system is displayed in a window. After importing the database for the 

electromechanical lock system, the “Type in the PIN” window opens where you can enter the PIN code of your 

programming key for the imported lock system. Confirm your entry with the [OK] button (see section 5.4). The next 

time you start the program, it will automatically open with the imported database for your electromechanical lock 

system.

6.2.2 Updating System Data

Note: Make sure to insert your programming key for the lock system to be updated into the correct port 

on your programming device (see section 5.3).

To update the data in your electromechanical lock system, insert the medium with your new system data into the 

appropriate drive on your Windows computer. In the “Setup” taskbar, click the   symbol for “System Import” 

(see section 7.1). In the “System Import” window that opens as described in section 6.2.1, select the format of the 

system database to be imported that corresponds to your lock system.

Fig. 6.2/3: “System Import” window

Click the [Cancel] button to close this window without updating the electromechanical lock system. Click the [OK] 

button to confirm your selection and update the system data.
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In the “Connecting DB...” window that appears (as described in section 6.2.1), choose the new system database 

file and click the [Open] button.

Fig. 6.2/4: “Connecting DB...” window

You are prompted to confirm the action. Click the [No] button to close the security query without updating the 

electromechanical lock system. Click the [Yes] button in the security query to update your lock sytem data.

Fig. 6.2/5: Security query

The loading progress of the system data update is displayed in a window. While updating the data, the “Type in 

the PIN” window appears. In the input box provided, enter the PIN code of your programming key for this lock 

system and confirm your entry by clicking the [OK] button (see section 5.4). 

Once your system data has been updated, a message window appears. Confirm this message window by clicking 

the [OK] button.

Fig. 6.2/6: Message window

Note: After updating your lock system database, you have to refresh the data (see section 7.5.7).
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In the taskbar, click the  symbol for “Config. Options” to open the “Config. Options” window. Click the 

“Reindexing” tab and refresh the system data as described in section 7.5.7.

6.2.3 Backing up System Data

In the menu bar, choose the “Backup” function under “System”  menu to open the “Select operation to perform” 

window. Click the [Backup] button to display the “Create backup” window where you can change the backup 

settings (see section 6.2.3.1). Click the [Restore] button to restore the former system database (see section 

6.2.3.2). Click the [Cancel] button to close the “Select operation to perform” window.

Fig. 6.2/7: “Select operation to perform” window

6.2.3.1 Changing the Backup Settings

To change backup settings for the lock system, click the [Backup] button in the “Select operation to perform” 

window. The “Create backup” window appears where you can adjust the security level using the “Security level” 

slider and the compression level using the “Compression” slider for the data backup. The “Level description” 

display box displays your security level settings. The remaining options allow you to make additional settings. Note 

that you can select several options at once.
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Fig. 6.2/8: “Create backup” window

Click the [Cancel] button to close this window without applying the data backup settings. Click the [OK] button to 

apply the settings. 

In the “Save File As” window that appears, choose the folder where you want to store the backup file in the “Save” 

selection box. If required, you can also change the file name in the “File name” input box. Click the [Save] button 

to create a backup file for the lock system.

Fig. 6.2/9: “Save File As ...” window
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If you selected the “Use password protection system” option box, the “Write password or phrase” window will 

open. In this window, enter a password for the system backup file and click the [OK] button to apply the password.

Fig. 6.2/10: “Write passwort or phrase” window

If you click the [Cancel] button to close this window, you are prompted to confirm this action. Click the [OK] button 

in the security query to confirm that you do not want to use a password for the backup file. Click the [Cancel] button 

to return to the “Write passwort or phrase” window.

Fig. 6.2/11: Security query

If you selected the “Specify system comments” option box, the “Comment editor” window appears. In the input 

box, you can enter a comment that will appear when the system backup file is opened.
Version:  P84 5 133 0106_ENP845133 00017 0EN 0A    04/18



Lock System 6.2-7Manager
Fig. 6.2/12: “Comment editor” window

Click the [Cancel] button to close this window without using the comment. Click the [OK] button to apply the 

comment. 

A window appears while the backup file is being created for the lock system. Once the backup file has been 

created, a message window appears where you have to click the [OK] button to confirm.

Fig. 6.2/13: Message window
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6.2.3.2 Restoring System Data

Note: If you have already updated your lock system database as described in section 6.2.2, it is not 

possible to use a backup file that was created before the update.

The backup data for the lock system is stored in a backup file according to the settings made during the backup 

(see section 6.2.3.1). Therefore, if your computer crashes or some other problem occurs, you can also restore 

your system data from this backup file. In the “Select operation to perform” window (see fig. 6.2/7), click the 

[Restore] button so that you can access this backup file again. 

In the “Connecting DB...” window that appears, choose the folder from the “Look in” input box and select the 

required system backup file (format: “.A2B”) from the available files. The selected backup file appears in the “File 

name” input box and you can open it by clicking the [Open] button or simply double-clicking the file. Click the 

[Cancel] button to close this window without using the backup file.

Fig. 6.2/14: “Connecting DB...” window

Note: If you have assigned a password to the backup file, the “Write password or phrase” window 

opens (see fig. 6.2/10). Enter the new password in this input box.

After you choose the backup file, the “List of backed up systems” window appears and contains the name of the 

lock system that has been backed up. 
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Fig. 6.2/15: “List of backed up systems” window

Click the [Cancel] button to close the window again. Click the [OK] button to restore the lock system database.

In the security query that appears, click the [Yes] button to restore the lock system database. Click the [No] button 

to close the security query without restoring the lock system database.

Fig. 6.2/16: Security query

The lock system data is overwritten with the version of the data in the backup file. In the message window that 

appears, click the [OK] button to overwrite the data.

Fig. 6.2/17: Message window
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6.3 Daily Work

In this window, you can manage the issued and returned keys for the electromechanical lock system that you have 

imported or selected. You can also quickly enter keys that are missing or lost and generate a reminder for overdue 

keys.

When you select a person, you can view a list of all electromechanical and mechanical keys that this person 

currently possesses. You can also display the cylinders for which these keys have locking permission.

Fig. 6.3/1: “Daily Work” window

You can perform the following tasks in the “Daily Work” window:

- Issue and return keys

- Specify issuing and return dates for keys

- Print out the issue and return receipts

- Enter a key as missing

- Generate reminders for overdue keys

- Configure the visitor status for personnel

In the taskbar, click the “Daily Work” symbol to open the “Daily Work” window.
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6.3.1 Choosing a Person

If you want to issue keys to a person or when a person wishes to return a key, click the  symbol. The 

“Personnel” window opens and lists all persons by “Pos”, “Name”, “Surnames”, “Employee Number” and 

“Active” for the lock system that you have imported or selected. Click the row with the person to select them for 

a key to be issued or returned. Click the  symbol to display the data of the selected person in the “Person 

Card” window (see section 6.4.4).

Fig. 6.3/2: “Personnel” window

To search for a person, select the column in which the search is to be performed. Next, click the  symbol to 

perform a search as described in section 5.5.2.

If the person to whom you wish to issue a key is not listed in the “Personnel” window, you can create a new data 

record for this person. To create the person's data, click the  symbol or choose the “Create” function from the 

“Edit” menu as described in section 6.4.3. 

Click the [Cancel] button to close the “Personnel” window without using the selected person. Click the [OK] button 

to use the selected person in the “Daily Work” window. 

The person's data is displayed in the top section of this window. If you select the corresponding option in the “View 

Options” tab of the “Config. Options” window (see section 7.5.2), the person's signature and photo will also be 

displayed. 

The keys that the selected person possesses are shown in the “Hand in/out list” tab (see fig. 6.3/1). The  or 

 symbol indicates the key type (electromechanical or mechanical). To display the cylinders for which the key has 

locking permission, click the “Doors/Cylinders” tab (see section 6.3.2.4).
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6.3.2 Managing the Keys

After selecting a person, you can issue them with keys, register returned keys or missing keys, or generate a 

reminder for overdue keys.

6.3.2.1 Issuing Keys

The “Hand Out” tab contains many options for issuing keys to the selected person:

Select the key(s) to be handed out in the “Key List” window (see fig. 6.5/1)

Click the  symbol at the top to select a key in this window. In this window, you can easily view all of the various 

lock lines according group and key. To display just the keys , click the .symbol.

Select the key(s) to be handed out in the “Door Plan” window (see fig. 6.7/1)

Click the  symbol in the middle to create a door plan for the imported or selected lock system. Click the 

symbol to open the “Keys” pop-up window and select the required key. In this pop-up window, you can view the 

various lock lines according to group and key in clearly arranged lists. When you select a key, the door symbols 

in the door plan change to graphically illustrate the cylinders for which the selected key locking permission.

Select the key(s) to be handed out in the “Lock Chart” window (see fig. 6.8/1)

Click the  symbol at the bottom to select a key in this window. The keys are clearly arranged in a function 

matrix using access permission icons. These access permission icons allow you to see which door cylinders the 

key can access.

The “In Stock” entry in the “Keyholder” column of the “Key List” window or “Keys” pop-up window indicates 

which keys cannot yet be handed out. All missing keys are marked in red in the “Key List” and “Lock Chart” or  

“Keys” pop-up window. You cannot hand out these keys.

Select the key from the list in the “Key List”, “Door Plan” or “Lock Chart” window by clicking the row. Click the [OK] 

button or double-click a row to apply the currently defined locking permission to the selected key in the “Daily 

Work” window. Click the [Cancel] button to close the “Key List”, “Door Plan” or “Lock Chart” window without 

applying the selected key.

After applying the key, the “Hand out dates” window opens where you can define the ‘hand out‘ and ‘hand in‘ times 

for the key as described in 6.3.2.2.
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6.3.2.2 Defining the ‘Hand Out‘ and ‘Hand In‘ Dates

In the “Hand out dates” window, the issue date of a key is displayed with the date and time that the keys were 

handed out in the “Out Date” display box and “Out Time” selection box. You can define a different time and date 

on which the key is to be handed back in.

Fig. 6.3/3: “Hand out dates” window

Out Date

Click the  symbol next to the “Out Date” display box to change the date on which the key was handed out. 

The “Date” window opens where the current calender date is marked in blue. 

Fig. 6.3/4: “Date” window

Click a date to select it as the date on which the key was handed out . Click the  or  and  or  symbols 

to switch to the calendar view of the previous month or year or the following month or year. The selected day is 

marked in blue and the current day is marked in red. Click the [Cancel] button to close this window without using 

the selection. Click the [OK] button to apply the selection to the “Hand out dates” window. 
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The “Out Date” display box displays the day that was selected for handing out the key. Using the “Out Time” 

display box, you can specify the exact issue time for the key on the given day.

In Date

Click the  symbol next to “In Date” display box and, as described above, select the return date for the key in 

the “Date” window. The “In Date” display box displays the selected day for returning the key. Using the “In Time” 

selection boxes, you can specify the exact return time for the key on the given day.

Note: Keys without a hand in date are assigned to the selected person without any time restrictions.

Click the [Cancel] button to close the “Hand out dates” window without assigning the ‘hand out‘ and ‘hand in‘ dates 

to the selected key. Click the [OK] button to apply the ‘hand out‘ and ‘hand in‘ dates to the selected key in the 

“Daily Work” window.

Applying the hand out/in dates

After applying the dates to the “Daily Work” window, the key is displayed in the “Hand in/out list” tab using the 

symbol and the issue and return dates are displayed in the “Out Date” and “In Date” display boxes. In the 

“Notes” input box, you can enter additonal comments concerning the key that was handed out so that this 

information can viewed when the person is selected.

Fig. 6.3/5: “Daily Work” window with “Hand in/out list” tab
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You can change a key's ‘hand out‘ and ‘hand in‘ dates at a later point in time. To do this, click the  symbol 

below the “Out Date” or “In Date” display boxes. The “Daily Work” window opens where you can change the 

‘hand out‘ and ‘hand in‘ dates as described above.

Fig. 6.3/6: “Daily Work” window for entering the ‘hand out‘ dates

Note: You can only change the ‘hand in’ date of a key before the key is registered in the program (see 

section 6.3.2.5).

Click the [Cancel] button to close this window without applying the change to the “Daily Work” window. Click the 

[OK] button to apply the settings. Click the [Register] button in the “Daily Work” window to register the issued key 

in the program (see section 6.3.2.5).

6.3.2.3 Configuring the Visitor Status for Personnel

In the “Daily Work” window, select a person and click the  symbol to assign the visitor status to this person. 

The “Visitor Dates” window opens where you have to enter the visiting period for the visitor in the “Date Arriving” 

and “Date Leaving” display boxes (as described in section 6.3.2.2).

Fig. 6.3/7: “Visitor Dates” window

You can enter remarks concerning this person in the “Notes” input box. Click the  symbol to print out a visitor 

pass for this person. In the “Report Actions” window (see fig. 5.6/2) that opens, you can change the printer settings 

(as described in section 5.6) and print out the visitor pass. Click the [Cancel] button to close this window without 

applying the time period and visitor status. 
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Click the [OK]  button to apply the visiting period and visitor status to this person ion the “Daily Work” window. The 

visiting period of the visitor is displayed in the “Date Arriving” and “Date Leaving” display boxes of the “Daily 

Work” window. As described in 6.3.2.1, you can issue a key to the person for the period that they have visitor 

status.

Fig. 6.3/8: “Daily Work” window with “Hand in/out list” tab

Note: The issue and return date of the selected key must be identical to the arrival and departure dates 

defined for the visitor status.

If the key's ‘hand in‘ date is later than the departure date, the following message window appears. Confirm this 

message window by clicking the [OK] button.

Fig. 6.3/9: Message window
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Click the [Register] button in the “Daily Work” window to register the visitor status for this person and, if applicable, 

the key that you have given them (see section 6.3.2.5). You can cancel a person's visitor status as described in 

section 6.4.4.

6.3.2.4 Returning Keys

When a person wishes to return a key, start by selecting this person as described previously. In the “Hand in/out 

list” tab, click the row containing the key that this person wishes to return. Under “Hand In”, click the  symbol 

to enter that the key has been returned. The returned key is indicated by the  symbol in the window.

Fig. 6.3/10“Daily Work” window with “Hand in/out list” tab

To display the cylinders that the key is authorized to open, click the “Doors/Cyl. List” tab. Select the 

“Electronical accesses” option in the “View Options” tab of the “Conf. Options” window (see section 7.5.2) to 

list the electromechanical cylinders that the selected electromechanical key is authorised to access. If doors have 

been assigned to the cylinders (see section 6.6.2), the doors are displayed together with the cylinders. Click the 

 symbol to expand the list and display all of the cylinders for this door. Click the  symbol to collapse the list 

again.

To the left of the cylinder names, special symbols indicate the cylinder type:  for electromechanical cylinder, 

for mechanical cylinder,  for a double cylinder with an electronic and mechanical side and  for an 

electromechanical double cylinder.
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Fig. 6.3/11: “Daily Work” window with “Door/Cly. List” tab

Click the [Register] button to register in the program that the key has been returned.

6.3.2.5 Registering Issued and Returned Keys

Click the [Register] button to register in the program that the key has been issued or returned. You are prompted 

whether to print a receipt for an issued or returned key (see section 6.3.2.6). Click the [Close] button to close the 

“Daily Work” window.

If you click the [Close] button in the “Daily Work” window without registering that the key has been handed out or 

handed in, a security query appears. Click the [No] button to return to the “Daily Work” window and register the 

date on which the key was handed out or handed in. Click the [Yes] button to close the security query and the 

“Daily Work” window without registering the issued or returned key.

Fig. 6.3/12: Security query
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6.3.2.6 Printing Receipts for Issued and Returned Keys

After registering an issued or returned key by clicking the [Register] button, a message window appears. In this 

window, you can choose whether or not to print out a receipt.

Fig. 6.3/13: Message window

Click the [No] button to close the message window without printing out a receipt for the issued or returned key. 

Click the [OK] button to print out the receipt. In the “Report Actions” window (see fig. 5.6/2) that opens, you can 

change the printer settings (as described in section 5.6) and print out the receipt.

Note: In contrast to a issued key receipt, you can only print out a returned key receipt immediately after 

receiving the key and not afterwards.

The confirmation printouts for issued and returned keys display company and system data in the header together 

with the current date and user data. The name and home address of the person are displayed below the header. 

The issued and returned keys are displayed in a clearly arranged list.

Fig. 6.3/14: Hand in receipt
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After registering a key that has been issued to a person (see section 6.3.2.5), you can generate an isued key 

receipt afterwards by selecting the person in the “Daily Work” window as described in section 6.3.1.

The keys that have been issued to the selected person are shown in the “Hand in/out list” tab. Right-click the 

row containing with the issued key for which the receipt is to be printed. Choose the “Print a hand out note for 

the selected key” function from the shortcut menu.

Fig. 6.3/15: “Daily Work” window for printing issued key receipt at later point in time

In the message window that appears, you can choose whether or not to print out a receipt. Click the [No] button 

to close the message window without printing out a receipt for the issued key. Click the [OK] button to print out 

the receipt. 

Fig. 6.3/16: Message window

In the “Report Actions” window that opens, you can change the printer settings (as described in section 5.6) and 

print out the receipt.
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6.3.3 Generating Reminders for Overdue Keys

Note: In the CLIQ™ Manager Plus program, you have to select the lock system first before you can 

display overdue keys (see section 9.2.5.1).

When you start the program, you can print out a list of overdue keys (see section 3.2.3). In the “Keyholders” 

column, you can see the names of the personnel who are to receive reminders.

Select the person as described. The overdue keys from this person are displayed using the  symbol in the 

“Hand in/out list” tab. Click the row where the key is listed to view the return date for the key in the “In Date” 

display box.

Fig. 6.3/17:  “Daily Work” window with “Hand in/out list” tab

You can change the return the date for overdue key by clicking the  symbol below the “In date” display box. 

The “Daily Work” window opens where you can enter a different return date (see fig. 6.3/6).

To send a reminder to this person, click the activated  symbol below the “Hand In” section. The “Key 

Reminder” window opens where the overdue key is listed together with “Pos”, “Name”, “Mark”, “Keyholder”, 

“Out Date”, “Out Time”, “In Date” and “In Time”. 
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The times in the “Out Date”, “Out Time”, “In Date” and “In Time” columns indicate the exact date and time 

when the key was issued and when it is to be returned. The  or  symbol indicates the key type 

(electromechanical or mechanical).

Fig. 6.3/18: “Key Reminder” window

In this window, click the row containing the overdue key so that you can generate a reminder for this person.

Click the [Cancel] button to close this window without generating a reminder for this person. Click the [OK] button 

to open the “Printer Settings” window (see fig. 5.6/2). As described in section 5.6, enter the printer settings for the 

reminder.

Click the [Close] button to close the “Daily Work” window.
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6.3.4 Entering a Key as Missing

As described above, start by selecting the person who has lost the key. In the “Hand in/out list” tab, click the row 

containing the key that this person has lost. Under “Hand In”, click the   symbol to enter that the key is 

missing. In the security query that opens, click the [No] button to close the security query without entering the key 

as missing.

Fig. 6.3/19: Security query

Click the [Yes] button in the security query to enter the key as missing. The missing key is displayed using the 

symbol in the “Hand in/out list” tab.

Fig. 6.3/20:  “Daily Work” window with “Hand in/out list” tab

Note: Make sure to insert the programming key into the correct port on your programming device for 

the lock system that you have imported into CLIQ™ Manager or selected in CLIQ™ Manager Plus 

(see section 5.3).
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Click the [Register] button to register in the program that the key is missing. In the message window that appears, 

clicking the [OK] button to confirm.

Fig. 6.3/21: Message window

Once the key has been registered as missing, it losses all locking permissions throughout your lock system. As 

described in section 6.8.4.3, you can transfer any changes to the key’s status to the programming key so that you 

can reprogram the corresponding electromechanical cylinders.

Note: If the missing key is found again, you can reset the “missing” status for this key (see section 

6.5.10).
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6.4 Personnel

This window clearly lists all of the personnel data that has been created or imported for the lock system. You can 

only issue keys for the lock system to personnel who are listed in this window.

The program can manage up to 500,000 people for one lock system. The tabs of the “Personnel” window provides 

you with an overview of the personnel data for each person. Despite the potentially large number of personnel, 

you can still view all of the data that has been entered for them.

Fig. 6.4/1: “Personnel” window

You can perform the following tasks in the “Personnel” window:

- Import or create personnel data

- View personnel data

- Delete personnel data

In the taskbar, click the “Personnel” symbol to display the “Personnel” window.
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6.4.1 Menu bar

The menu bar in this window contains the following menus. When you click a menu name, the menu drops down 

to display its contents. Some of these functions are also available as symbols in the toolbar.

When you select a row by clicking it, right-clicking it opens a shortcut menu with various functions that you can 

select.

6.4.2 Importing personnel data

To import personnel data, insert the medium with the data into the appropriate drive on your Windows computer. 

Click the  symbol in the toolbar or choose the “Import Personnel Data” function in the “Edit” menu on the 

menu bar. The “Import Personnel Data” window appears. 

To import data from your Outlook address book, select the “Import Outlook contact info” option box  (see 

section 6.4.2.1). Likewise, select the “Import Personnel data from ASCII file” option box  to import data from a 

text file (see section 6.4.2.2).

“System” menu

Backup (see section 6.2.3)

“System” menu

Find (see section 5.5.2)

Select column to show (see section 5.5.1)

Information Card (see section 6.4.4)

Print (see section 5.6)

Exit, closes the “Personnel” window

“Edit” menu

Copy, copies an entry from an input box

Paste, pastes an entry into an input box

Create (see section 6.4.3)

Import Personnel Data (see section 6.4.2)

Delete (see section 6.4.5)

“Help” menu

Help screen (see section 5.2.1)

Additional help (see section 5.2.1)

About … (see section 5.2.2)
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Fig. 6.4/2: “Import Personnel Data” window

Note: You can import files with the “.txt” format in the “Import Personnel Data” window.

Click the [Cancel] button to close this window without importing the personnel data. Click the [OK] button and 

import the personnel data according to your selection.

6.4.2.1 Importing Personnel Data from Outlook

To import the personnel data from the address book, first open Outlook. In Outlook, open the “File” menu and 

choose the “Other Address Books” function under the “Export” function to export the address book.

Fig. 6.4/3: “Address Book” window

The “Address Book Export Tool” window opens. In this window, choose the “Text File (Comma delimited)” 

function and click the [Export] button if you want to export the address book.
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Fig. 6.4/4: “Address Book Export Tool” window

The “CSV Export” window appears. Click the [Browse...] button to export the address book as a text file and select 

the storage location.

Fig. 6.4/5: “CSV Export” window

The “Save File As” window appears. In this window, specify where to save the file using the “Save” selection box 

and enter the file name into the “File name” input box. 

Fig. 6.4/6: “Save File As ...” window
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In the “Save File As” window, click the [Save] button to apply the file name to the “CSV Export” window. The “CSV 

Export” window opens containing the copied file names. Click the [Next] button to continue with settings.

Fig. 6.4/7: “CSV Export” window

The “CSV Export” window changes appearance and you can choose which entries (such as First name, Surname 

and so on) to import by selecting the option boxes. Click the [Back] button to return to the previously displayed 

window. Click the [Finish] button to save the address book as a text file under the specified name.

Fig. 6.4/8: “CSV Export” window

In the “Import Personnel Data” window, choose the “Import Outlook contact info” option box to import the 

personnel data. 

In the “Connecting DB...” window that appears, choose the folder from the “Look in” selection box and select the 

stored text file. The selected text file appears in the “File name” input box. To import this file, click the [Open] 

button or double-click the text file in the “Import Personnel Data” window. Click the [Cancel] button to close this 

window without importing the text file.
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Fig. 6.4/9: “Connecting DB...” window

After importing the text file in the “Import Personnel List” window, you can select the person to be imported into 

“Personnel” window by clicking the option box.

Fig. 6.4/10“Import Personnel List” window

Note: When you clear an option box, the deactivated entry is moved to the bottom of the list.

Click the [Cancel] button to close this window without applying the data from the selected personnel. Click the 

[OK] button to add the selected person(s) as new row(s) in the “Personnel” window.
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6.4.2.2 Importing Personnel Data as ASCII Files

To import your personnel data from another program, save it first as a  text file in “.txt” or “.prn” format. To import 

your personnel data from an Excel file, choose the “Save As“ function with “Formatted Text (Space delimited)” 

to save this Excel file as a text file with the “.prn” format. Open this text file (“.txt” or “.prn” format) using Notepad 

and save the text file using the “.txt” format. In the “Import Personnel Data” window, choose the “Import 

personnel data from ASCII file” option box  to import the personnel data. The “Import Personnel Data” window 

opens to the “Personnel Data” tab.

Fig. 6.4/11: “Import Personnel Data“ window with “Personnel Data” tab

Click the  symbol to import the personnel data. In the “Connecting DB...” window that appears, choose the 

folder from the “Look in” selection box and select the stored text file. The selected text file appears in the “File 

name” input box. To import this file, click the [Open] button or double-click the text file in the “Import Personnel 

Data” window.

Fig. 6.4/12: “Connecting DB...” window
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After importing the text file into the “Import Personnel Data” window, the number of personnel data records is 

displayed next to the  symbol (see fig. 6.4/13). 

Entering the position number and character string length

In the “Pos” and “Long” input boxes, enter the position numbers and character lengths respectively for the 

entries, so that they can be applied into the corresponding display boxes. Click the “Other Info” tab and enter the 

position numbers and character string lengths into the “Pos” and “Long” input boxes to import additional entries 

from the text file.

Note: Confirm each entry in the “Pos” and “Long” boxes by pressing the ENTER key.

Displaying imported entries for personnel

After entering the correct position numbers and character string lengths, data such as title, first name, last name, 

and so on are displayed in fields for the first person in the text file. 

Fig. 6.4/13: “Import Personnel Data” window with “Personnel Data” tab

Click the , ,  or  buttons to switch to the next, last, previous or first person respectively, and display 

their data in the fields.

Click the “Other Info” tab to display additional data in the fields for the first person in the text file, such as the 

organisation, workplace, division and so on.
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Fig. 6.4/14: “Import Personnel Data” window with “Other info” tab

Incorrect entry of position numbers and character lengths

For example, if the person's first name is displayed in the “Surnames” display box because the entered position 

number does not correspond to the position of the entry in the text file, simply overwrite all “Pos” input boxes with 

“0”. Open the text file using Notepad and count the entries. Afterwards, enter the correct position numbers into 

the “Pos” input boxes. If you enter incorrect string lengths into the “Long” input boxes, the displayed entries will 

not be complete or a few characters from the next entry will be included. Change the values in the “Long” input 

box until the entries are displayed correctly with no characters from the following entry.

Entering an already existing position number

If you enter the same position number into a second “Pos” input box, a message window appears after you press 

the ENTER key. Click the [OK] button to confirm the message window and change the position number that you 

have entered twice.

Fig. 6.4/15: Message window

Click the [Cancel] button to close the “Import Personnel Data” window without importing the personnel data. Click 

the [OK] button to add the imported personnel as new row(s) in the “Personnel” window.
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Importing personnel data for existing employee numbers

If personnel data already exists for the employee numbers being imported, the “Duplicate employee number” 

window opens.

Note: This window only appears when the “Load and confirm duplicates” option is selected (see 

section 7.5.2).

Fig. 6.4/16: “Duplicate employee number” window

This window contains a clearly arranged list with the stored and imported personnel data for the duplicate 

employee numbers. Click the [Update] button and import the personnel data and overwrite the existing personnel 

data. Click the [Skip] button to neither overwrite the existing personnel data nor import the new data. To import 

the personnel data using new employee numbers, click the [Change] button. The “Change employee number” 

window opens where you have to overwrite the displayed employee number with a new employee number.

Fig. 6.4/17: “Change employee number” window
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Click the [Cancel] button to close this window without importing the personnel data using the new employee 

numbers. Click the [OK] button to add the personnel data with new employee numbers as new rows in the 

“Personnel” window. The “Duplicate employee number” window closes automatically when you skip duplicate 

personnel data records, update them or import them using a new employee number.

6.4.3 Creating personnel data

Click the  symbol in the toolbar or choose the “Create” function in the “Edit” menu on the menu bar. The 

“Person Card” window opens to the “General” tab where the current date is displayed in the “Creation Date” 

display box.

Fig. 6.4/18: “Person Card” window with “General” tab

Click the [Complete Name...] button to change the entries in the “Complete Name...” window. Using the selection 

boxes, you can choose a title and name affix, if required.

Fig. 6.4/19: “Complete Name...” window
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Click the [Cancel] button to close this window without applying the entries. Click the [OK] button to apply the 

entries in the “Person Card” window. You can enter an additional employee number for this person in the 

“Employee Number” input box.

Click the  symbol to insert a photo and/or signature image for this person. In the “Open” window, you can select 

the photo and/or signature image as described in section 5.5.3. 

Note: You can import image files of “.jpg”, “.bmp”, “.wmf” and “.ico” format as a photo or signature 

image in the “Person Card” window.

After you add a photo or signature image to the “Person Card” window, you can delete it by simply clicking the now 

active  symbol.

To change the creation date from the current date or to create an exit date, click the  button next to “Creation 

Date” or “Valid Date” display boxes. The “Date” window opens where the current calender view is displayed. The 

current date is marked in blue. 

Click a date to select it as the creation or exit date. The selected day is marked in blue and the current day is 

marked in red. Click the  or  and  or  button to switch to the calendar view of the previous month or 

year or following month or year. Click the [Cancel] button to close this window without using the selection. Click 

the [OK]  button to apply the selection in the “Person Card” window.

Fig. 6.4/20: “Date” window
Version:  P84 5 133 0106_ENP845133 00017 0EN 0A    04/18



Personnel 6.4-13Manager
If required, you can enter remarks concerning this person in the “Person Type” box of the “Person Card”. Click 

the  or  symbol next to the “Person Status” display box to enter the person's status. Click these symbols 

to switch the status between “Active” and “Inactive”. 

Note: It is not possible to issue keys to personnel with the “Deactivated” status.

Click the [Work Address...] button in the open the “Work Address...” window to make the required changes to this 

person's address data. Click the  symbol below this button to switch between “Work Address...” and “Private 

Addresse...” in the drop-down menu. 

Depending on your selection, the button is displayed as [Work Address..] or [Private Address...]. Click the [Cancel] 

button to close this window without applying the data in the “Person Card” window. Click the [OK] button to apply 

the entries.

Fig. 6.4/21: “Work Address ...” window

Enter the telephone number for this person into the “Organization Phone” input box. Click the  symbol to 

choose “Work Phone 1”, “Work Phone 2”, “Mobile”, “Extension” or “Pager” in the drop-down menu. The 

names of this input box changes according to your selection. 

You can enter the person's fax number in the “Work Fax” input box and the e-mail addresses in the “Electronic 

Address 1” input box. Click the  symbol to choose “Electronic Address 1”, “Electronic Address 2”, or 

“Electronic Address 3” in the drop-down menu. The name of this input box changes according to your selection.
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Fig. 6.4/22: “Person Card” window

Click the “Details” tab to enter additional information about this person. Enter the required data into the input 

boxes.

Fig. 6.4/23: “Person Card” window with “Details” tab

Click the [Cancel] button to close this window without apply the entries. Click the [OK] button to apply your entries 

in the program. A new row with data for this person is added to the end of the “Personnel” list.
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Instead of editing the data in the “Person Card” window, you can also enter the information directly in the 

“Personnel” window by clicking the field in a column and entering the information directly into the field. When you 

click an editable column field, the background colour changes to yellow and is marked with a black border. 

Click the  symbol in the toolbar or choose the “Copy” function in the “Edit” menu on the menu bar to copy 

a selected entry. Click the  symbol in the toolbar or choose the “Paste” function in the “Edit” menu on the 

menu bar to paste a previously copied entry into the currently selected field.

6.4.4 Viewing information

To view information for a specific person, select the row containing the person and click the  symbol in the 

toolbar or choose the “Information Card” function in the “List” menu on the menu bar. Alternatively, you can 

also double or triple-click the row containing the person. The “Person Card” window opens and contains 

information on the selected person in the various tabs.

The “General” and “Details” tabs (see fig. 6.4/23) displays the entries for the selected person in the input and 

display boxes. You can change the entries or add to them as described in section 6.4.3.

Fig. 6.4/24: “Person Card” window with “General” tab

Note: CLIQ™ Manager Plus program also contains the “Key in the other systems” tab (see section 9.3.2).
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Click the , ,  or  symbols to switch to the next, last, previous or first person respectively and view 

their data. If you make changes in a tab, a security query appears when you switch to a new person's data record. 

Click the [Yes] button to save the changes to the person's data. Click the [No] button to display the data from the 

next, last, previous or first person in the database without saving the changes.

Fig. 6.4/25: Security query

The “General” tab also displays the status of the selected person. After setting up visitor status for this person in 

the “Daily Work” window (see section 6.3.2.3), this status is indicated by the  symbol situated next to the 

“Visitor” and the  and  symbols are active.  

Click the   button next to the “Visitor” to view the time period for which this user has visitor status. The “Visitor 

Dates” window opens and shows the visiting period in the four display boxes. Click the [Cancel] button to close 

the window again.

Fig. 6.4/26: “Visitor Dates” window

Click the  symbol next to “Visitor” to cancel the person's visitor status. 
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6.4.4.1 Displaying a Person's Keys

In the “Key in possession” tab of the “Person Card” window, you can view the keys this person currently 

possesses and the cylinders for which these keys have locking permission.

Fig. 6.4/27: “Person Card” window with “Key in possession” tab

Displaying keys

In the “Key Copy List” display area at the top, the keys that this “Keyholder” possesses are listed with “Pos.”, 

“Name”, “Mark” and “Alt. Mark”. The  or  symbol indicates the key type (electromechanical or mechanical). 

The “Missing” status indicates whether the given key has been registered as missing. 

Displaying locking permissions

In the “Key Copy List” display area at the top, click a key to list the corresponding cylinders in the “Door 

Accesses” display area at the bottom. By default, the first key is automatically selected. In the “Door Accesses” 

display area at the bottom, the cylinders for which the selected key has locking permission are listed with their 

“ID”, “Name”, “Door No.”, “Mark.”, “Alt. Mark”, “Type”, “Lock Type” and “Status”. 

To the left of the cylinder names, special symbols indicate the cylinder type:  for electromechanical cylinder, 

for mechanical cylinder,  for a double cylinder with an electronic and mechanical side and  for an 

electromechanical double cylinder.

The permission symbols to the left of each cylinder indicate the locking permission of the selected key: The  

permission symbols , , , ,  or  indicate whether the key has locking permission for a single 
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cylinder or double cylinder (see section 6.8.3). If you choose a key of type E3, the permission symbols indicate 

whether this key has locking permission for the given cylinder or not (see section 6.8.5). If you select a missing 

key, the locking permission is indicated by the  symbol.

if you have selected the “Electronical accesses” option in the “View Options” tab of the “Config. Options” 

window (see section 7.5.2), only those those electromechanical cylinders for which the selected electromechanical 

key has locking permission. When electromechanical locking permission has been assigned, this is indicated by 

the  or  symbol.

Fig. 6.4/28: “Key in possession” tab with electromechanical lock permissions

If doors have been assigned to the cylinders (see section 6.6.2), the doors are displayed together with the 

cylinders. Click the  symbol to expand the list and display all of the cylinders for these doors. Click the  symbol 

to collapse the list again. The symbol displayed to the left of the door name indicates the locking permissions that 

this person has for these doors. The meanings of these door symbols are explained on the inside of the back cover 

of this user guide. 

Changing the column display

Click the  symbol and choose “Select columns to show in keys” or “Select columns to show in doors/

cylinders” function in the drop-down menu to change the display in the “Key Copy List” or “Door Accesses” 

display area . In the “Column List” window that opens, you can choose which columns to display (as described in 

section 5.5.1).
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Fig. 6.4/29: Drop-down menu for selecting columns

Click the button [Cancel] or the [OK] button to close the “Person Card” window and return to the “Personnel” 

window.

6.4.4.2 Viewing History

In the “Person Card” window, click the “Historic hand out” tab for an overview of the keys that his person has 

had in their possession and the cylinders for which these keys have had lock permissions.

Fig. 6.4/30: “Person Card” window with “Historic hand out” tab

Displaying keys

In the “Historic Hand Out” display area at the top, the keys that this person (“Person Name” and “Surnames”) 

has possessed are listed with “Pos”, “Key Name” and “Mark”. The “Out Date” and “Out Time” indicate the 

exact date and time that this person was issued with this key. The exact date and time that the key was returned 

is displayed in the “In Date” and “In Time”. The  or  symbol indicates the key type (electromechanical or 

mechanical).

Displaying lock permissions

In the “Historic Hand Out” display area at the top, click a key to list the corresponding cylinders in the “Door 

accesses” display area at the bottom. By default, the first key is automatically selected. In the “Door accesses” 
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display aera at the bottom, the cylinders for which the selected key has had locking permission are listed with their 

“ID”, “Name”, “Door No.”, “Mark”, “Alt. Mark” and “Type”. 

Select the “Electronical accesses” option box in the “View Options” tab of the “Config. Options” window (see 

section 7.5.2) to list only those electromechanical cylinders for which the selected electromechanical key has had 

locking permission.

Fig. 6.4/31: “Historic hand out” tab with electromechanical lock permissions

To the left of the cylinder names, special symbols indicate the cylinder type:  for electromechanical cylinder, 

for mechanical cylinder,  for a double cylinder with an electronic and mechanical side and  for an 

electromechanical double cylinder.

If doors have been assigned to the cylinders (see section 6.6.2), the doors are displayed together with the 

cylinders. Click the  symbol to expand the list and display all of the cylinders for these doors. Click the  symbol 

to collapse the list again. 

Click the [Cancel] button or the [OK] button to close the “Person Card” window and return to the “Personnel” 

window.
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6.4.5 Deleting Personnel Data

Click a row to select the person in the list whose data you wish to delete. Click the  symbol in the toolbar or 

choose the “Delete” function in the “Edit” menu on the menu bar. In the security query that appears, click the 

[Yes] button to continue. Click the [No] button to close the security query without deleting the selected personnel 

data.

Fig. 6.4/32: Security query

Note: You can only delete personnel data from persons who do not possess any keys in the lock 

system.

6.4.6 Additional Functions

Changing the column display

Click the  symbol in the toolbar or choose the “Select columns to show” function in the “List” menu on the 

menu bar to change the way the columns are displayed in the “Personnel” window. In the “Column List” window 

that opens, you can choose which columns to display (as described in section 5.5.1).

Searching for entries

To search for a certain person in the list, click an entry to select the column for the search. The selected entry has 

a yellow background and black border. Click the  symbol in the toolbar or choose the “Find” function in the 

“List” menu on the menu bar. The search window opens where you can perform the search as described in 

section 5.5.2.

Printing the personnel data list

Click the  symbol in the toolbar or choose the “Print” function in the “List” menu on the menu bar. In the 

“Range of persons” window that appears (as described in section 5.6), choose the range (first row to last row) to 

be printed. After clicking [OK], the “Report Actions” window (see fig. 5.6/2) opens where you can change the 

printer settings and print out the list of personnel data.
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6.5 Keys

This window clearly lists all of the electromechanical and/or mechanical keys that have been created or imported 

for the imported or selected lock system. 

The key data is displayed in corresponding tabs to provide you with an overview to all of the information. Despite 

the potentially large number of keys, it is easy to manage all of the data pertaining to your keys. You can create 

mechanical keys for an additional lock line (referred to as ‘key line’ in the program) so that you can manage these 

as well.

Fig. 6.5/1: “Key List” window

You can perform the following tasks in the “Key List” window:

- View data from a lock line, group or key

- Create an access schedule for keys of type E2 or E3

- Deactivate or activate keys of type E1

- Register a key as missing or found

- View and delete the history of a key

- Create and delete mechanical key lines and mechanical keys

In the taskbar, click the “Key list” symbol to display the “Key List” window.
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6.5.1 Menu bar

The menu bar in this window contains the following menus. When you click a menu name, the menu drops down 

to display its contents. Some of these functions are also available as symbols in the toolbar.

When you select a row by clicking it, right-clicking it opens a shortcut menu with various functions that you can 

select.

“System” menu

Backup (see section 6.2.3)

“List” menu

Find (see section 5.5.2)

Select columns to show (see section 5.5.1)

Information Card (see section 6.5.3, 6.5.4 or 6.5.5)

Print (see section 5.6)

Show existing keys or Show all keys (see section 

6.5.2)

Search for key inserted in PD (see section 6.5.12)

Delete historic (‘Delete History’, see section 6.5.5.4)

Exit, closes the “Key List” window

“Edit” menu

Copy, copies an entry from an input box

Paste, pastes a previously copied entry into an input box

Autofill (see section 5.5.4)

Create (see section 6.5.9)

Create a new key line

Create a new key copy

Expand (see section 6.5.9.1 or 6.5.9.2)

Delete (see section 6.5.11)

“Help” menu

Help screen (see section 5.2.1)

Additional help (see section 5.2.1)

About ... (see section 5.2.2)
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6.5.2 Viewing Information

Key types

In the “Key List”, a lock line is indicated by the  symbol and the keys therein are indicated by the  or  symbol, 

depending on the type of key (electromechanical or mechanical). All of the electromechanical keys within a lock 

line are combined into a group that is indicated by the  symbol. For keys of type E1, the  symbol appears in 

the “Status” columns while the  symbol appears there for keys of type E2 or E3. For keys of type E3, the 

symbol is also displayed in the “Pos” column. For a key of type E2 and E3, you can create specific access 

schedules (see section 6.5.7) in order to define the times during which the key has locking permission. A row that 

contains a missing key is marked in red.

Click the  symbol to expand the list and display all of the keys for that belong to the lock line or group. Click the 

 symbol to collapse the list again. 

Display options

Click the  symbol in the toolbar to display or hide a specific keys. In the “View Options” window that opens, you 

can choose whether to display missing and/or planned keys by selecting or clearing the corresponding options. 

Planned keys have not yet been provided by IKON and may not yet be available.

Fig. 6.5/2: “View Options” window

Click the [Cancel] button to close this window without applying the display settings for these keys. Click the [OK] 

button to list the keys according to the settings you have made.

Displaying lock lines with keys or just the keys

Click the  symbol in the toolbar or choose the “Show existing keys” function in the “List” menu on the menu 

bar to display the keys together with the lock line(s) and groups that they belong to. Click the  symbol in the 

toolbar or choose the “Show all keys” function in the “List” menu on the menu bar to only display the keys that 

belong to the imported or selected lock system.
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Displaying information

To view the data for a certain lock line, group or for a specific key, click the row containing the item that you wish 

to display. Click the  symbol in the toolbar or choose the “Information Card” function in the “List” menu on 

the menu bar. Alternatively, you can double or triple-click the row to open it.

The next window that opens depends on your selection: “Key Line Card” opens for lock lines, “Group Card” opens 

for a group, “Electronic Key Card” opens for an electromechanical key and “Key Copy Card” opens for a 

mechanical key. In following, we describe the various tabs using just one window. The information described there 

also applies to the corresponding tabs in the other windows. 

Click the , ,  or  symbols to switch directly to the next, last, previous or first lock line, group or key 

in the list and display the data in the window. 

If, for instance, you make changes in the “Electronic Key Card” window, a security query appears when you switch 

to the next key. Click the [Yes] button in this security query to confirm the changes. Click the [No] button to close 

the security query without storing the changes.

Fig. 6.5/3: Safety query for a key
Version:  P84 5 133 0106_ENP845133 00017 0EN 0A    04/18



Keys 6.5-5Manager
6.5.3 Displaying Data for a Lock Line

When you select a lock line, the “Key Line Card” window opens to the “General Information” tab. 

Fig. 6.5/4: “Key Line Card” window with “General Information” tab

This tab displays the data that has been registered for the lock line in the lock system. In the “Quantity” display 

box, the  symbol indicates the number of mechanical keys that belong to the lock line. Using the “Locked” 

option box, you can lock or unlock the lock line. 

You can change or edit the entries in the input boxes by simply selecting the contents and overwriting them or 

making an entry. Click the [Cancel] button to close the window without storing the changes. Click the [OK] button 

to apply the settings.
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6.5.3.1 Displaying Corresponding Groups or Keys

When you select a lock line or group in the “Key Line Card” or “Group Card” window, click the “Physical Keys” 

tab view all of the corresponding groups or keys. When you select a lock line, the corresponding groups are 

displayed together with the electromechanical keys and mechanical keys contained therein. When you select a 

group, only the corresponding electromechanical keys are displayed.

Fig. 6.5/5: “Key Line Card” with “Physical Keys” tab

In this list, the corresponding groups and keys are displayed with “Pos”, “Name”, “Mark”, “Alt. Mark”, “Qty”, 

“Keyholder” and “Missing”. In the “Group card” there is no “Qty” column. A row that contains a missing key is 

marked in red. 

The selected lock line is displayed using the  symbol and the mechanical keys and groups of the lock line are 

displayed using the  and  symbols respectively. Electromechanical keys are marked using the  symbol. For 

keys of type E3, the  symbol is also displayed in the “Pos” column. 

Click the [Cancel] button or the [OK] button to close the window again.
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6.5.4 Displaying Data for a Group

When you select a group, the “Group Card” window opens to the “Info Group” tab.

Fig. 6.5/6: “Group Card” window with “General Information” tab

This tab displays the data that has been registered for the group in the lock system. In the “Electronics” display 

box, the  symbol indicates the number of electromechanical keys that belong to this group. Using the “Locked” 

option box, you can lock or unlock this group.

You can change or edit the entries in the boxes by simply selecting the contents and overwriting them or making 

an entry. Click the [Cancel] button to close the window without storing the changes. Click the [OK] button to apply 

the settings.
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6.5.5 Displaying the Data for a Key

When you select an electromechanical key, the “Electronic Key Card” window opens to the “Electronic Key” tab. 

When you select a mechanical key, the “Key Copy Card” window opens to the “General Information” tab.

Fig. 6.5/7: “Electronic Key Card” window with “Electronic Key” tab

This tab displays the data that has been registered for the key in the lock system. Additionally, you also receive 

information on the person to whom you have issued this key. The “Out Date” and “Out Time” display boxes 

indicate the exact time at which the key was issued. When it applies, the planned return time of the key is displayed 

in the “In Date” and “In Time” display boxes. The “Quartz” display box indicates whether the selected key 

contains a quartz (keys E2 and E3 contain quartz, key E1 is without a quartz). Using the “Locked” option box, 

you can lock or unlock the key line.

You can change the name of the key in the “Name” input box by highlighting it and overwriting it. In the 

“Additional Information” input box, you can enter additional data for the key or edit the previous entry.

To display personnel data for the person to whom this key has been issued, click the  symbol. The “Person 

Card” opens (see section 6.4.4) where the corresponding personnel data is displayed in the various tabs. Click the 

[Cancel] button to close the window without storing the changes. Click the [OK] button to apply the settings.
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6.5.5.1 Displaying and Printing Locking Permissions

Click the “Door Access List” tab for an overview of the cylinders for which the key has locking permission.

Fig. 6.5/8: “Electronic Key Card” window with “Door Access List” tab

In this list, the corresponding cylinders are displayed with “ID”, “Name”, “Door No.”, “Mark”, “Alt. Mark, 

“Type”, “Lock Type” and “Status”. To the left of the cylinder names, special symbols indicate the cylinder type: 

 for electromechanical cylinder,  for mechanical cylinder,  for a double cylinder with an electronic and 

mechanical side and  for an electromechanical double cylinder.

If doors have been assigned to the cylinders (see section 6.6.2), the doors are displayed together with the 

cylinders. Click the  symbol to expand the list and display all of the cylinders for these doors. Click the  symbol 

to collapse the list again. The door symbols indicate the type of cylinder they contain as well as the locking 

permission of the selected key. The meanings of these door symbols are explained on the inside of the rear cover 

of this manual. 
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Displaying locking permissions

The permission symbols to the left of each cylinder indicate the locking permission of the selected key: The 

permission symbols , , , ,  or  indicate whether the key has locking permission for a single 

cylinder or double cylinder (see section 6.8.3). If you choose a key of type E3, the permission symbols indicate 

whether this key has locking permission for the given cylinder or not (see section 6.8.5). If you select a missing 

key, the previous locking permissions are shown using the  symbol. 

Select the “Electronical accesses” option in the “View Options” tab of the “Config. Options” window (see 

section 7.5.2) to list only those electromechanical cylinders for which the selected electromechanical key has 

electromechanical  locking permission. The assigned electromechanical locking permission is displayed using the 

 or  symbol.

Fig. 6.5/9: “Door Access List” tab with electromechanical lock permissions
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Printing lock permissions

Click the  symbol to print out the list of lock permissions. Select the “Electronical accesses” option in the 

“View Options” tab of the “Conf. Options” window (see section 7.5.2) to print out the cylinders for which the 

selected key has electromechanical locking permission. 

Note: If doors have been assigned to the cylinders (see section 6.6.2), click the  symbol in the 

“Electronic Key Card” window to expand the list and display the cylinders for these doors.

In the “Report Actions” window (see fig. 5.6/2) that opens, you can change the printer settings (as described in 

section 5.6). Click the  symbol in the “Report Actions” window to preview the document on the screen (see 

section 5.6.2).

Fig. 6.5/10: Printout of the electromechanical lock permissions

Click the [Cancel] button or the [OK] button to close the window again.
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6.5.5.2 Displaying Electromechanical Information

After selecting a key, click the “Electronic Information” tab in the “Electronic Key Card” window to read out the 

event lists or create access schedules.

Fig. 6.5/11: “Electronic Key Card” window with “Electronic Information” tab

Note: Make sure to insert the programming key into the correct port on your programming device for 

the lock system that you have imported into CLIQ™ Manager or selected in CLIQ™ Manager Plus 

(see section 5.3).

Click the  symbol to read out the event lists for the selected key as described in section 6.5.6.

Click the  symbol to create an access schedule for a key of type E2 or E3 as described in section 6.5.7. When 

you select a key of type E1, click this symbol to deactivate or deactivate the key as described in section 6.5.8.

Click the [Cancel] button or the [OK] button to close the window again.
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6.5.5.3 Displaying Manufacturer's Information

After selecting an electromechanical key, click the “Advanced Elec. info” tab in the “Electronic Key Card” window 

to view the manufacturer's information for this key.

Fig. 6.5/12: “Electronic Key Card” window with “Advanced Elec. info” tab

Note: Make sure to insert the programming key into the correct port on your programming device for 

the lock system that you have imported into CLIQ™ Manager or selected in CLIQ™ Manager Plus 

(see section 5.3).

Click the  symbol to display the manufacturer's electromechanical information for the selected key. 

Click the  symbol to display the manufacturer's article information for the selected key.

Click the [Cancel] button or the [OK] button to close the window again.
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Displaying manufacturer's electromechanical information

To display the manufacturer's electromechanical information for the selected key, click the  symbol in the 

“Advanced Elec. info” tab. A message window appears and prompts you to insert the selected key into the 

correct port on your programming device. Click the [OK] button to confirm the message window and insert the key 

into the correct port (see section 5.3).

Fig. 6.5/13: Message window

The “Elektromech. Informationen” window opens to the “Lists” tab. In the upper section of this window, you can 

view the data that has been registered for the electromechanical key in the lock system. The name of the selected 

or imported lock system is displayed in the “System” display box. 

In the lower section of this window, you can view the general manufacturer's data for this key. Click the [Close] 

button to close the window again.

Fig. 6.5/14: “Electronic Information” window 
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Displaying manufacturer's article information

To display the manufacturer's article information for the selected key, click the  symbol in the “Advanced 

Elec. info” tab. The “Product information” window opens where you can view article data for the selected key. 

Click the [Cancel] button to close the window again.

Fig. 6.5/15: “Product information” window

Note: We do not advise changing any of this information.
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6.5.5.4 Viewing and Deleting the History

In the “Electronic Key Card”, “Key Copy Card” or “Key Line Card”, click the “Historic hand out” (‘History’) tab to 

receive an overview of the personnel to whom you have issued the selected key or keys from a lock line.

Fig. 6.5/16: “Electronic Key Card” window with “Historic hand out” (‘History’) tab

In this list, the keys are displayed together with the “Pos”, “Key Name”, “Mark”, “Person Name”, “Surnames” 

as well as “Out Date”, “Out Time”, “In Date” and “In Time”. The “Out Date” and “Out Time” indicate the exact 

times that this person was issued with this key. The exact time that the key was returned is displayed in the “In 

Date” and “In Time”.

The  or  symbol indicates the type of the selected key (electromechanical or mechanical) that was issued to 

the persons.

To delete the key's history, click the [Cancel] button to close the window. In the “Key List” window, click the 

“Delete Historic” function in the “List” menu on the menu bar.

In the message window that appears, click the [Yes] button to confirm that you want to delete the files. Click the 

[No] button to close this box without deleting the history for this key.
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Fig. 6.5/17: Message window

Before the history is deleted, the “Date” window opens where the current date is marked in blue in the calendar.

Fig. 6.5/18: “Date” window

Click a date to select it as the date up to which the key's history is to be deleted. Click the  or  and  or 

symbols to switch to the calendar view of the previous month or year or following month or year. The selected day 

is marked in blue and the current day is marked in red.

Click the [Cancel] button to close this window without using the selection. Click the [OK] button and then click the 

[Yes] in the security qiuery to confirm that you want to delete the history. Click the [No] button to close the security 

query without deleting the history.

Fig. 6.5/19: Security query
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6.5.6 Reading out the Event Lists

To read out the event lists from the selected electromechanical key, click the  symbol on the “Electronic 

information” in the “Electronic Key Card” window. A message window appears and prompts you to insert the 

selected key into the correct port on your programming device.

Click the [OK] button to confirm and insert the key into the correct port (see section 5.3).

Fig. 6.5/20: Message window

The “Electronic Information” window opens to the “Normal audit trail” tab. In the top section of the window, you 

can view general information on the electromechanical keys as well as the name of the imported or  selected lock 

system. Click the [Close] button to close the window again. 

Note: With keys of type E3, the “Auth. Cyls in TK list” tab is also visible.

Internal event lists and external event lists

The “Normal audit trail” tab provides you with an overview of the authorised and/or unauthorised locking 

processes for cylinders and the locking permissions for the keys within your imported or selected lock system. 

Click the “Foreign audit trail” tab to display all of the locking events in cylinders of separate lock systems as well 

as its lock permissions there.
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Fig. 6.5/21: “Foreign audit trail” and “Normal audit trail” tabs

Click the  symbol to open the “Column List” window where you can choose which columns to display for the 

events (as described in section 5.5.1).

To search for a certain entry in these lists, click an entry to select the column for the search. Next, click the 

symbol to perform a search as described in section 5.5.2. Next, click the  symbol to perform a search as 

described in section 5.6.

Click the  symbol to save the event list on your hard drive or another data medium. The “Save File As” window 

appears. In this window, specify where to save the file using the “Save” selection box and enter the file name into 

the “File name” input box. Click the [Save] button to save the event list as a text file (format: “.txt”). Click the 

[Cancel] button to close this window without saving the event list.

Fig. 6.5/22: “Save File As ...” window
Version:  P84 5 133 0106_ENP845133 00017 0EN 0A    04/18



6.5-20 Keys Manager
Displaying authorised cylinders for keys of type E3

Click the “Auth. Cyls in TK list” tab for an overview of the authorised cylinders for which the key of type E3 has 

locking permission.

Fig. 6.5/23: “Electronic Information” window with “Auth. Cyls in TK list” tab
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6.5.7 Creating an Access Schedule for Keys of Type E2 or E3

To create an access schedule for a key of type E2 or E3 and define the times during which the key has locking 

permission, first click the corresponding key in the list as described in section 6.5.2. Assuming that you have 

selected the appropriate columns as described in section 5.5.1, all keys of type E2 and E3 are indicated by the 

 symbol. For keys of type E3, the  symbol is also displayed in the “Pos” column. In the “Electronic 

Information” tab of the “Electronic Key Card”, click the  symbol (see section 6.5.5.2), to create an access 

schedule for the selected key.

The “Key Time Option” window opens where you can create a new access schedule or display an existing one for 

the key.

Fig. 6.5/24: “Key time options” window

In the top section of this window, you can view general information on the selected key of type E2 or E3 and the 

“Status” section displays information on the access schedule using symbols and warning messages. The date 

and time are entered into your Window computer and displayed accordingly. 

Note: When defining the access schedule for a key of type E2 or E3, make sure that the time in your 

Windows computer is correct.

If the time in a key of type E2 or E3 does not correspond to the time in your Windows computer, click the 

symbol to synchronise the time of the given key (see section 8.4.2).
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6.5.7.1 Selecting the Time Zone

In the “Key time options” window, choose “Use Daylight saving time” in the “Use Daylight saving time” section 

when you define the summer and winter time and select the time zone. Depending on your selections here, certain 

buttons, selection boxes and symbols will become active. 

In the “Key time options” window, click the [Select Time Zone] button to open the “Select Time Zone” window. 

This window lists the time zones alphabetically and you can select a time zone by clicking it.

Fig. 6.5/25: “Select Time Zone” window

Click the [Cancel] button to close this window without applying the time zone in the “Key time options” window. 

Click the [OK] button to apply the selected time zone.

In the “Key time options” window, click the  symbol in the “Summer” or “Winter” sections to open the “Date” 

window, where the current data is highlighted in the calendar. Click a date to select it as a changeover date for 

daylight savings (summer or winter time). The selected day is marked in blue and the current day is marked in red.

Note: The selected changeover data for daylight savings must not lie in the past and is only valid for 

one year.

Click the  or  and  or  symbols to switch to the calendar view of the previous month or year or following 

month or year. 
Version:  P84 5 133 0106_ENP845133 00017 0EN 0A    04/18



Keys 6.5-23Manager
Fig. 6.5/26: Date” window

Click the [Cancel] button to close this window without applying the selected date. Click the [OK] button to apply 

the selection in the “Key time options” window. 

In the “Summer” and “Winter” sections, you also have to enter changeover dates for daylight savings time in the 

“Key time options” window. In the “Summer” section, enter the time with the hour in the first selection box and the 

minutes in the second selection box. Adjust the time in the “Winter” section as well.

Click the [Select from Window] button in the “Key time options” window to apply the settings from your Windows 

computer as the time zone and daylight savings changeover dates in the “Summer” and “Winter” sections. Click 

the [Reset to default values] button in the “Key time options” window to return to the default settings.
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6.5.7.2 Changing the Settings

In the “Key time options” window, select the key validity option under “Key is valid” for the selected key of type 

E2 or E3. Depending on your selections here, certain options, selection boxes and symbols will become active. 

Fig. 6.5/27: “Key time options” window

Unrestricted access

Select the “Always” option box to provide the key of type E2 or E3 with locking permission without any time 

restrictions.

Access schedule

If you select the “Start / end date” option box, click the  symbol below the “Start” and “Stop” sections to 

open the “Date” window (see fig. 6.5/26) where the current date is displayed in the calendar. Click a day to select 

it as last day that the key of type E2 or E3 has locking permission. Click the  or  and  or  buttons to 

switch to the calendar view of the previous month or year or following month or year. Click the [Cancel] button to 

close the “Date” window without applying the selected date. Click the [OK] button in the “Date” window to apply 

the selected date in the “Key time options” window.
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Schedule with definite access times

If you select the “Start / end schedule” option box, click the  symbol in the “Start” and “Stop” sections to 

open the “Date“ window (see fig. 6.5/26) and, as described above, choose the date on which the locking 

permission is to begin or end. Additionally you have to define the weekly access times in the “Start time” and 

“Stop time” sections, during which keys of type E2 or E3 will have locking permission. Select the required 

weekday options and enter the starting hour and minute into the two boxes of the “Start time” section. Similarly, 

enter the required “Stop time” for the end of the period.

Definite access times

If you select the “Schedule only” option box, you can change the settings in the “Start time” and “Stop time” 

boxes and define the daily access times for keys of type E2 or E3, during which they are to receive locking 

permission. Choose the weekday and select the starting hour and minute in the two boxes of the “Start time” 

section. Similarly, enter the required “Stop time” for the end of the access period. When you make this selection, 

the locking permission of the key is not limited to a period with start and end dates.

Deactivating lock permissions

Select the “Never” option box to deactivate the key of type E2 or E3 and revoke locking permission.

Click the [Reset schedule] button, to reset the access schedule to its previous settings.

Click the [Cancel] button in the “Key time options” window to close this window without transferring the access 

schedule to the selected key of type E2 or E3. Click the [Change] button to transfer the access schedule to the 

key of type E2 or E3, as described in section 6.5.7.4. 
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6.5.7.3 Creating and Using Schedule Templates

Creating schedule templates

You can define the schedule template so that you can reuse these settings later on. To create a schedule template, 

click the [Custom schedules] button in the “Key time options” window (see fig. 6.5/27). The “Schedule list” 

window opens containing any previously defined templates.

Fig. 6.5/28: “Schedule list“ window

Click the  symbol to create a schedule template. The “Schedule card” window opens where you can enter the 

schedule name in the “Schedule name” input box and change the access schedule as described in 6.5.7.2.

Fig. 6.5/29: “Schedule card” window
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Click the [Cancel] button to close this window without saving the template in the “Schedule list” window. Click the 

[OK] button to save the template settings.

Using a schedule template

To use an access schedule for a key of type E2 or E3 that has been saved as a template, click the arrow below 

the [Custom schedules] button. Select the access schedule from the drop-down list and click the  symbol to 

apply the template settings in the “Key time options” window.

Fig. 6.5/30: “Key time options” window

To change the settings that have been applied from the template, click the  symbol. The “Schedule card” 

window opens where you can change the schedule as described in section 6.5.7.2 and confirm the changes by 

clicking the [OK] button.

Click the [Cancel] button in the “Key time options” window to close this window without transferring the access 

schedule to the selected key of type E2 or E3. In the “Key time options” window, click the [Change] button to 

transfer the access schedule to the key of type E2 or E3, as described in section 6.5.7.4.

Deleting templates

Select the template in the “Schedule list” window and click the  symbol or choose the “Delete” function in the 

“Edit” menu on the menu bar. In the security query that appears, click the [Yes] button to delete the template. 

Click the [No] button to close the security query without deleting the template.
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Fig. 6.5/31: Security query

6.5.7.4 Transferring Access Schedules

After changing the settings for the schedule in the “Key time options” window or selecting an access schedule 

template, click the [Change] button. In the message window that appears, you are requested to insert the selected 

key of type E2 or E3 into the correct port on your programming device (see section 5.3).

Fig. 6.5/32: Message window 

Click the [OK] button to confirm that you want to transfer the access schedule to the key of type E2 or E3. A 

message window appears and indicates that the settings have been transferred to the key of type E2 or E3. 

Fig. 6.5/33: Message window

Click the [OK] button to confirm this action and return to the “Electronic Information” tab in the “Electronic Key 

Card” window.
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6.5.8 Deactivating or Activating Keys of Type E1

To deactivate a key of type E1, first select it in the “Key List” window. Assuming that you have selected the 

appropriate columns as described in section 5.5.1, keys of type E1 are indicated by the  symbol. Click the 

symbol in the toolbar or choose the “Information Card” function in the “List” menu on the menu bar. 

Alternatively, you can also double or triple-click the row containing the person. In the “Electronic Key Card” window 

that appears, click the “Electronic Information” tab (see fig. 6.5/11).

Click the  symbol to deactivate a key in this window. The “Electronic key time options (No timer)” window opens 

where you can deactivate the key or reactivate it again.

Fig. 6.5/34: “Electronic key time options (No timer)” window

Click the [Cancel] button to close this window without deactivating or reactivating the key of type E1. Click the 

[OK] button to deactivate or reactivate this key.
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6.5.9 Adding Lock Line and Mechanical Keys

You can create a new lock line for mechanical keys or add mechanical keys to an existing lock line (key line).

6.5.9.1 Creating Lock Line

Click the  symbol in the toolbar or choose the “Create” function in the “Edit” menu on the menu bar and click 

the “Create a new key line” function to create a new lock line (key line) for a mechanical key. Empty rows are 

added to the end of the list for the lock line and the mechanical keys contained therein. 

Select the new lock line in the list and click the  symbol in the toolbar or choose the “Information Card” 

function in the “List” menu on the menu bar. Alternatively, you can also double or triple-click the row containing 

the lock line. The “Key Line Card” window opens to the “General Information” tab where you can change the 

settings as described in section 6.5.3.

Fig. 6.5/35: “Key Line Card” window with “General Information” tab

Instead of editing the data in the “Key Line Card” window, you can also enter the information directly in the list by 

clicking the field in a column and directly entering the information. When you click an editable column field, the 

background colour changes to yellow and is marked with a black border. 
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Click the  symbol in the toolbar or choose the “Copy” function in the “Edit” menu on the menu bar to copy a 

selected entry. Click an input field and click the  symbol in the toolbar or choose the “Paste” function in the 

“Edit” menu on the menu bar to paste a previously copied entry into the currently selected field. 

To create several mechanical lock lines, select a lock line and choose the “Expand” function in the “Edit” menu 

on the menu bar. The “Key Line” window opens where you can change the settings.

Fig. 6.5/36: “Key List” window 

Choose the number of rows in the “Quantity to expand” selection box. The current number of lock lines are 

displayed above this selection box. These lock lines were either created or imported with the selected or imported 

lock system. The “Max. num. of Key lines” field displays the number of lock lines that can still be created.

Note: You can create a maximum of 999,999 lock lines per lock system. If you click the first row (lock 

line) in the list, the “Insert in the current position” option is deactivated.

The “Append at the end” option adds the rows to the bottom of the list. Select “Insert in the current position” 

option to insert the rows above the currently selected row in the “Key List” window. Select the “Key Copy“ option 

to add rows for additional keys to the lock line. The window title changes to “Key Copy” and you can add empty 

rows to your lock line as described in section 6.5.9.2. 

Click the [Cancel] button to close this window without creating the empty rows for the lock line. Create the new 

rows by clicking the [OK] button.
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6.5.9.2 Creating Mechanical Keys

To add a mechanical key to an existing lock line, first click the row containing the lock line. Click the  symbol 

in the toolbar or choose the “Create” function in the “Edit” menu on the menu bar and then click the “Create a 

new key copy” function. The new mechanical key is added to either the top or bottom of the list below the selected 

lock line.

Note: Groups contain electromechanical keys but you cannot add mechanical keys. 

Select the new mechanical key in the list and click the  symbol in the toolbar or choose the “Information Card” 

function in the “List” menu on the menu bar. Alternatively, you can also double or triple-click the row containing 

the lock line. The “Key Copy Card” window opens to the “General Information” tab where you can change the 

settings.

Fig. 6.5/37: “Key Copy Card” window with “General Information” tab

With new mechanical keys, the “In Stock” status is displayed in the “Keyholder” display box. Using the 

“Locked” option, you can lock or unlock the key line.

Instead of editing the data in the “Key Copy Card” window, you can also enter the information directly in the list by 

clicking the field in a column and directly entering the information. When you click an editable column field, the 

background colour changes to yellow and is marked with a black border. 
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Click the  symbol in the toolbar or choose the “Copy” function in the “Edit” menu on the menu bar to copy a 

selected entry. Click an input field and click the  symbol in the toolbar or choose the “Paste” function in the 

“Edit” menu on the menu bar to paste a previously copied entry into the currently selected field.

To create several mechanical lock lines, select a lock line and choose the “Expand“ function in the “Edit“ menu 

on the menu bar. The “Key Copy“ window opens where you can change the settings.

Fig. 6.5/38: “Key Copy“ window 

Choose the number of rows in the “Quantity to expand“ option. The number of existing keys are displayed above 

this option box. These keys were either created or imported with the selected or imported lock system. The “Max. 

num. of Key Copy“ field displays the number of keys that can still be created.

Note: You can create a maximum of 1,000,000 keys per lock system. If you select a group or an 

electromechanical key in the list, the “Key Line“ window opens and the “Insert in the current 

position“ option is not selected.

The “Append at the end“ option adds the rows to the bottom of the list. Select “Insert in the current position“ 

option to insert the rows above the currently selected row in the “Key List“ window. 

Click the [Cancel] button to close this window without creating a empty rows for the mechanical key. Create the 

new rows by clicking the [OK] button.
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6.5.10 Register a Key as Missing or Found

In the “Key“ window, select the key to be registered as ‘missing’ or ‘found’. Click the  symbol in the toolbar or 

choose “Information Card“ function in the “List“ menu on the menu bar. Alternatively, you can also double or 

triple-click the row containing the key. With electromechanical keys, the “Electronic Key Card“ window opens to 

the “General Information“ tab (see fig. 6.5/7). With mechanical keys, the “Key Copy Card“ window opens to the 

“General Information“ tab (see fig. 6.5/37).

Note: Make sure to insert the programming key into the correct port on your programming device for 

the lock system that you have imported into CLIQ™ Manager or selected in CLIQ™ Manager Plus 

(see section 5.3).

Registering a missing key

In these tabs, click the  symbol to register a missing key in the program. In the message window that appears, 

click the [Yes] button to confirm that you want to register the key as ‘missing’. Click the [No] button to close this 

window without registering the key as ‘missing’.

Fig. 6.5/39: Message window

Confirm the status change for the key by clicking the [OK] button in the “Electronic Key Card“ or “Key Copy Card“ 

window.

In the message window that appears, confirm by clicking the [OK] button. As described in section 6.8.4.3, you can 

transfer any changes in this key to the programming key so that you can reprogram the affected electromechanical 

cylinders. Once the key has been registered as missing, it losses all locking permissions throughout your system.

Fig. 6.5/40: Message window
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Entering a key as found

You can register a key as ‘found’ in these tabs by clicking the  symbol. In the message window that appears, 

click the [Yes] button to confirm that you want to register the key as ‘found’. Click the [No] button to close this 

window without entering the key as ‘found’. 

Fig. 6.5/41: Message window

After you register a formerly missing key as ‘found’ by clicking the [OK] button in the “Electronic Key Card“ or “Key 

Copy Card“ window, you can issue it to a person again.

Note: You have to reassign the locking permissions for this key in the “Door Plan“ or “Lock Chart“ 

window as described in section 6.7.4.1 or 6.8.4.1. You also have to transfer the permissions to 

the corresponding electromechanical cylinders (see section 6.8.4.3).

6.5.11 Deleting a Key or Lock Line

Note: You cannot delete electromechanical keys or the groups and lock lines that they belong to.

Select the added lock line or mechanical key in the list whose data you wish to delete. Click the  symbol in the 

toolbar or choose the “Delete“ function in the “Edit“ menu on the menu bar. A security query appears and you 

have to click the [Yes] button to continue. Click the [No] button to close the security query without deleting the 

selected lock line or key.

Fig. 6.5/42: Security query

Note: You can only delete data for mechanical keys that have not been issued to persons.
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6.5.12 Additional Functions

Changing the column display

To change the way the columns are displayed, click the  symbol in the toolbar or choose the “Select columns 

to show“ function in the “List“ menu on the menu bar. In the “Column List“ window that opens, you can choose 

which columns to display (as described in section 5.5.1). 

Searching for entries

To search for a certain key in the list, click an entry to select the column for the search. The selected entry has a 

yellow background and black border. Click the  symbol in the toolbar or choose the “Find“ function in the 

“List“ menu on the menu bar. The search window opens where you can enter the search parameters and perform 

the search as described in section 5.5.2.

Using “Autofill“

When changing the settings for new rows, you can also automate this procedure. In the entry you are editing, 

select the column that you wish to autofill. When you click an editable column field, the background colour changes 

to yellow and is marked with a black border. Click the  symbol in the toolbar or choose the “Autofill“ function 

in the “Edit“ menu on the menu bar. In the “Keys“ window (see fig. 5.5/4) that opens, you can change the settings 

for the entry as described in section 5.5.4.

Printing out the list

Click the  symbol in the toolbar or choose the “Print“ function in the “List“ menu on the menu bar. In the 

“Printer Settings“ window (see fig. 5.6/2) that opens, you can change the printer settings (as described in section 

5.6).

Displaying hidden keys

Note: Make sure to insert the programming key into the correct port on your programming device for 

the lock system that you have imported into CLIQ™ Manager or selected in CLIQ™ Manager Plus 

(see section 5.3).

Click the  symbol in the toolbar or choose the “Search for key inserted in PD” function in the “List” menu 

on the menu bar to highlight the electromechanical key that is currently inserted in the programming device.
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6.6 Doors/Cylinders

This window provides you with an overview of all of the doors and electromechanical and/or mechanical cylinders 

that have been created or imported for the imported or selected lock system.

The door and cylinder data is stored in corresponding tabs so that you have access to all of the information at a 

glance. Despite the potentially large number of doors and cylinders, it is easy to manage all of the data pertaining 

to them. You can also create new doors and mechanical cylinders.

Fig. 6.6/1: “Door/Cyl. list” window

You can perform the following tasks in the “Door/Cyl. List” window:

- View data for a cylinder or door

- Create mechanical cylinders and doors

- Change the cylinder status

- Reprogram cylinders

- Delete mechanical cylinders and doors

In the taskbar, click the “Door/Cyl. List” icon to display the “Door/Cyl. List” 

window.
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6.6.1 Menu bar

The menu bar in this window contains the following menus. When you click a menu name, the menu drops down 

to display its contents. Some of these functions are also available as symbols in the toolbar.

When you select a row by clicking it, right-clicking it opens a shortcut menu with various functions that you can 

select.

“System” menu

Backup (see section 6.2.3)

“List” menu

Find (see section 5.5.2)

Select columns to show (see section 5.5.1)

Information Card (see section 6.6.2)

Print (see section 5.6)

Search for cylinder connected to PD, function currently not 

available

Exit, closes the “Door/Cyl. List” window

“Edit” menu

Copy, copies an entry from an input box

Paste, pastes a previously copied entry into an input box

Autofill (see section 5.5.4)

Create (see section 6.6.8)

New door for this cylinder

Create a new door

Create new cylinder

Install all cylinders in stock

Expand (see section 6.6.8.1 or 6.6.8.2)

Expand doors

Expand cylinders

Delete (see section 6.6.10)

Move up or Move down, changes position in list

“Help” menu

Help screen (see section 5.2.1)

Additional help (see section 5.2.1)

About ... (see section 5.2.2)
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6.6.2 Viewing Information

Cylinder types

The “Door/Cyl. List” window lists the cylinders from the imported or selected lock system using various symbols to 

indicate the type of cylinder. The  or  symbols represent electromechanical or mechanical single cylinders and 

the  or  symbols represent double cylinders with electromechanical and mechanical sides or 

electromechanical double cylinders. A row that contains a destroyed key is marked in red.

Display options

Click the  symbol in the toolbar to display or hide specific cylinders. In the “View Options” window that opens, 

you can choose whether to display inactive and/or planned cylinders by selecting or clearing the corresponding 

options. Planned cylinders have not yet been provided by IKON and are not currently available.

Fig. 6.6/2: “View Options” window

Click the [Cancel] button to close this window without applying the display settings for these cylinders. Click the 

[OK] button to list the cylinders according to the settings you have made.

Creating doors for cylinders

Choose the “Create” function in the “Edit” menu on the menu bar and then click the “Install all cylinders in 

stock” function to create doors for the cylinders. A message window opens where you can choose whether to list 

the doors using the names from the cylinders.

Fig. 6.6/3: Message window

Click the [No] button to display the doors without labels in the list. Click the [Yes]  button to apply the cylinder 

names to the doors. The doors are displayed in the list. 
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Click the  symbol to expand the list and display all of the cylinders that belong to the door. Click the  symbol 

to collapse the list again.

Showing and hiding the doors

Click the  symbol in the toolbar to hide the doors in the list. The window changes appearance and only the 

cylinders are listed. At the same time, the  symbol appears in the toolbar that you can click to display the doors 

again.

Fig. 6.6/4: “Cyl. List” window

Displaying information

To view the data for a certain door or cylinder, click the row containing the item that you wish to display. Click the 

 symbol in the toolbar or choose the “Information Card” function in the “List” menu on the menu bar. 

Alternatively, you can double or triple-click the row to open it.

Depending on your selection, the “Door Card” window opens for doors and the “Cylinder Card” window opens for 

cylinders. In following, we describe these tab windows using just one window. The information described there 

also applies to the corresponding tabs in the other window.
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Click the , ,  or  symbols to switch to the first, previous, next or last cylinder or door in the list of the 

given window. 

If you make changes in a window, a security query appears as soon as you switch to a new data record. Click the 

[Yes] button to save the changes in the window. Click the [No] button to close the security query without storing 

the changes.

Fig. 6.6/5: Security query
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6.6.3 Displaying Data for a Door

When you select a door, the “Door Card” window opens to the “General Information” tab.

Fig. 6.6/6: “Door Card” window with “General Information” tab

This tab displays the data that has been registered for the door in the lock system. The “No. of cylinders” display 

box displays the number of cylinders that belong to the door.

You can change or edit the entries in the boxes by simply selecting the contents and overwriting them or entering 

new information.

Click the [Cancel] button to close the window without storing the changes. Click the [OK] button to apply the 

settings.
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6.6.3.1 Displaying Associated Cylinders

Click the “Cylinder in door” tab in the “Door Card” window to have an overview of the associated cylinders.

Fig. 6.6/7: “Door Card” window with “Cylinder in door” tab

In this list, the corresponding groups and keys are displayed with “ID”, “Name”, “Mark”, “Alt. Mark”, “Color” 

and “Clock Type”. 

The various symbols indicate the type of cylinder. The  or  symbols represent electromechanical or 

mechanical single cylinders and the  or  symbol represent double cylinders with electromechanical and 

mechanical sides or electromechanical double cylinders. Double-click a cylinder to open the “Cylinder Card” 

window where you can view data on this cylinder (see section 6.6.4).

Click the [Cancel] button or the [OK] button to close the window again.
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6.6.3.2 Displaying Associated Articles

Click the “Additional products” tab in the “Door Card” window to have an overview of the associated articles.

Fig. 6.6/8: “Door Card” window with “Additional products” tab

This list displays the articles together with “Pos”, “Catalog ID”, “Reference” and “Product Name”. Click the 

 symbol to add an article for the selected door. An empty row is added to the bottom of the list where you can 

enter the required data. When you click an editable column field, the background colour changes to yellow and is 

marked with a black border. Enter a reference and article name in these input flied. 

To delete an article again, select the row and click the  symbol. A security query appears and you have to click 

the [Yes] button to delete the selected article. Click the [No] button to close the security query without deleting the 

article.

Fig. 6.6/9: Security query

Click the [Cancel] button in the “Door Card” window to close the window without storing the changes. Click the 

[OK] button to apply the settings.
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6.6.4 Displaying the Data for a Cylinder

When you select a cylinder, the “Cylinder Card” window opens to the “General Information” tab.

Fig. 6.6/10: “Cylinder Card” window with “General Information” tab

This tab displays the data that has been registered for the cylinder in the lock system. The symbol next to the 

“Electronic type” indicates the type of the selected cylinder. The  or  symbol represent electromechanical 

or mechanical single cylinders and the  or  symbol represent double cylinders with electromechanical 

and mechanical sides or electromechanical double cylinders. 

You can change or edit the entries in the boxes by simply selecting the contents and overwriting them or entering 

new information. 

As described in section 6.6.9, you can change the status of this cylinder by clicking the  symbol next to the 

“Status” option box. When you select a cylinder that has not yet been assigned to a door, you can assign it to a 

door here. Using the “Locked” option box, you can lock or unlock the cylinder.

Click the [Cancel] button to close the window without storing the changes. Click the [OK] button to apply the 

settings.
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6.6.4.1 Displaying and Printing Keys with Locking Permission

In the “Cylinder Card” or “Door Card” window, click the “Key access” tab for an overview of which keys have 

locking permission for the selected cylinder or door.

Fig. 6.6/11: “Cylinder Card” window with “Key access” tab

Displaying locking permissions

In this list, the keys are displayed with “Pos”, “Name”, “Mark”, “Alt. Mark” “Qty”, “Keyholder” and “Missing”. 

The selected lock line is displayed using the  symbol and the groups contained therein are displayed using the 

 symbol. The  or  symbol indicates the key type (electromechanical or mechanical). For keys of type E3, 

the  symbol is also displayed in the “Pos” column. A row that contains a missing key is marked in red.

The door symbol indicates the locking permission of the key for the selected cylinder. If you choose a key of type 

E3, the door symbols indicate whether the key is authorized to access the given cylinder or not (see section 6.8.5). 

The meaning of the door symbols are explained on the last page of this manual.

Select the “Electronical accesses” option in the “View Options” tab of the “Config. Options” window (see 

section 7.5.2) to list only those electromechanical keys that have locking permission for the selected 

electromechanical cylinder.
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Fig. 6.6/12: “Key access” tab with electromechanical locking permission

Printing locking permissions

Click the  symbol to print out the list of lock permissions. The printout contains a list of the keys that have 

locking permission for the selected electromechanical cylinder. In the “Report Actions” window (see fig. 5.6/2) that 

opens, you can change the printer settings (as described in section 5.6). Click the  button in the “Report 

Actions” window to preview the document on the screen (see section 5.6.2).

Fig. 6.6/13: Printout of the electromechanical keys

Click the [Cancel] button or the [OK] button to close the window again.
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6.6.4.2 Displaying Persons with Access Permission

In the “Cylinder Card” or “Door Card” window, click the “Person access” tab for an overview of their access 

permission for the selected cylinder or door.

Fig. 6.6/14: “Cylinder Card” window with “Person access” tab

This list displays the persons together with “Pos”, “Name”, “Surnames”, “Employee Number” and “Active”.

Double-click a person to open the “Person Card” window where you can view data on this person (see section 

6.4.4).

Click the [Cancel] button or the [OK] button to close the window again.
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6.6.4.3 Viewing the History

In the “Cylinder Card” or “Door Card” window, click the “Historic person accesses” or “Persons accesses” tab 

for an overview of which persons have been able to open the selected cylinder or door and the key that they used 

to do this.

Fig. 6.6/15: “Cylinder Card” window with “Historic person access” tab

In this list, persons are displayed with their “Person Name” and “Surnames” as well as their keys and “Pos”, 

“Key Name”, “Mark” and with “Out Date”, “Out Time”, “In Date” and “In Time”. 

The  or  symbol indicates the key type (electromechanical or mechanical). The “Out Date” and “Out Time”  

indicate the exact time that this person was issued with this key. The exact time that the key was returned is 

displayed in the “In Date” and “In Time”.

Select the “Electronical accesses” option in the “View Options” tab of the “Config. Options” window (see 

section 7.5.2) to list only those electromechanical keys that have electromechanical locking permission for the 

selected electromechanical cylinder.

Click the [Cancel] button or the [OK] button to close the window again.
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6.6.4.4 Displaying Electromechanical Information

After selecting an electromechanical cylinder in the “Cylinder Card” window, click the “Elec. info.” tab to read out 

the event lists from this cylinder.

Fig. 6.6/16: “Cylinder Card” window with “Elec. info.” tab

Note: Make sure to insert the programming key into the correct port on your programming device for 

the lock system that you have imported into CLIQ™ Manager or selected in CLIQ™ Manager Plus 

(see section 5.3). 

Click the  symbol to read out the event lists from the programming key for the selected cylinder as described 

in section 6.6.5.

Note: Click the  symbol to read out the event lists directly from the connected cylinder. This 

function is currently not available in the English version.

Click the [Cancel] button or the [OK] button to close the window again.
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6.6.4.5 Displaying Manufacturer's Information

After selecting an electromechanical cylinder, click the “Advanced Elec. info” tab in the “Cylinder Card” window 

to view the manufacturer's information for this cylinder.

Fig. 6.6/17: “Cylinder Card” window with “Advanced Elec. info.” tab

Note: Make sure to insert the programming key into the correct port on your programming device for 

the lock system that you have imported into CLIQ™ Manager or selected in CLIQ™ Manager Plus 

(see section 5.3). 

Click the  symbol to display the manufacturer's article information for the selected cylinder (see section 6.6.6). 

Click the  symbol to reprogram the electromechanical A side of a single cylinder or electromechanical A and 

B sides of a double cylinder as described in section 6.6.7.

Note: Click the  symbol to read out the electromechanical information directly from the connected 

cylinder. This function is currently not available in the English version.

Click the [Cancel] button or the [OK] button to close the window again.
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6.6.5 Reading Out the Event Lists

Note: To view the event lists of a cylinder, it is best to open the “Cylinder Card” window from the “Lock 

Chart” window (see section 6.8.2). From this window, you can directly transfer the task to the 

programming key to read out the event lists (see section 6.8.4.3).

Requesting event lists

To read out the event lists from the selected electromechanical cylinder, click the  symbol on the “Elec. info.” 

tab in the “Cylinder Card” window. With double cylinders ( ), the “Select cylinder side” window opens first 

where you have to choose the cylinder side from which to read the event lists. Click the corresponding button to 

open the “View audit trails list” window.

Fig. 6.6/18: “Select cylinder side” window

After selecting a single cylinder ( ) or double cylinder with a mechanical side ( ), the “View audit trails list”, 

window opens where you have to select the “Get from cylinder” option.

Fig. 6.6/19: “View audit trails list” window

Click the [Cancel] button to close this window without requesting the event lists from the selected cylinder. Click 

the [OK] button in this window to request the event lists and click the [OK] button when prompted by the next 

message window.
Version:  P84 5 133 0106_ENP845133 00017 0EN 0A    04/18



Doors/Cylinders 6.6-17Manager
Fig. 6.6/20: Message window

Before you send the cylinder event list request to the programming key, you can request event lists from additional 

electromechanical cylinders. Click the [OK] button or the [Cancel] button to close the “Cylinder Card” window. In 

the “Door/Cyl. List” window, select another cylinder whose event lists are to be read.

Transferring request to programming key

Click the  symbol in the taskbar to open the “Lock Chart” window. In this window, the cylinders whose event 

lists are to be read are indicated by the green traffic light  (see fig. 6.8/1). 

To transfer the request to the programming key, click the  symbol in the toolbar. The cylinders are indicated by 

the yellow traffic light  and you cannot make any changes during this time. The red traffic light  indicates that 

a request was sent to another programming key for this cylinder but has not yet been confirmed (see section 

8.4.1.1). 

When one or more requests are being sent to the programming key, the “Sending task list” window appears. This 

window closes automatically as soon as the transfer is complete.

After this, a message window appears. Click the [Yes] button to open the “Report Actions” window (see fig. 5.6/

2) where you can configure the printout of a “To Do” list as described in section 5.6. This “To Do” list contains the

names of the cylinders whose event lists are to be read using the programming key. Click the [No] button to close

this window without printing the “To Do” list.

Fig. 6.6/21: Message window
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Insert the programming key into the cylinder whose event lists are to be read. Insert the programming key into the 

cylinder and hold it there until the  symbol appears on the display. Insert the programming key into the correct 

port on your programming device and click the  symbol in the “Lock Chart” window to transfer the cylinder's 

event lists. 

The “Type in the PIN” window opens where you can enter the PIN code of your programming key for the imported 

or selected lock system. Click the [OK] button to confirm your entry (see section 5.4). The “Receiving task list” 

window appears while the data is being transferred to the programming key. This window closes automatically as 

soon as the transfer is complete.

If the programming key is not able to receive the event lists or problems occur, the “Results receiving task list” 

window opens with an error log. This window provides you with an overview of the request that have not been sent 

or received. Click the [Cancel] button to close this window again.

Fig. 6.6/22: “Results receiving task list” window

Transfer the request(s) to the programming key again. If no errors occur while transferring the event lists, this 

window will not appear.

Opening event lists

In the “Lock Chart” window, double-click the row containing the cylinder. Click the  symbol in the toolbar to open 

the “Cylinder Card” window for the cylinder from the “Door/Cyl. List” window as described above. Click the “Elec. 

info.” tab and click the  symbol to open the “View audit trails list” window.
Version:  P84 5 133 0106_ENP845133 00017 0EN 0A    04/18



Doors/Cylinders 6.6-19Manager
Fig. 6.6/23: “View audit trails list” (event list) window

The  symbols for “NAT list” (internal event list) or “FAT list” (external event list) are now active. Click these 

to open the “NAT list” or “FAT list” window respectively.

Displaying the internal and external event lists

The “NAT list” window (internal event list) contains the events for the selected cylinder that were initiated by keys 

of the imported or selected lock system. The “FAT list” window (external event list) contains the events for the 

selected cylinder that were initiated by keys from an external lock system.

Fig. 6.6/24: “FAT list” and “NAT list” windows
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Click the  symbol to open the “Column List” window where you can choose which columns to display for the 

events (as described in section 5.5.1).

To search for a certain event in the list, click an entry to select the column for the search. Next, click the  symbol 

to perform a search as described in section 5.5.2. 

Click the  symbol to print out the event list for a cylinder. In the “Report Actions” window (see fig. 5.6/2) that 

opens, you can change the printer settings (as described in section 5.6). 

Click the  symbol to save the event list for this cylinder on the hard drive of your Window computer or to another 

data medium. In the “Save File As ...” window that appears, choose the folder where you want to store the backup 

file in the “Save” selection box. The information will be stored as a text file in the “.txt” format. Enter or overwrite 

the name in the “File name” input box and click the [Save] button. Click the [Cancel] button to close the window 

without storing the events.

Fig. 6.6/25: “Save File As ...” window
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6.6.6 Displaying Manufacturer's Article Information

To display the manufacturer's article information for the selected key, click the  symbol in the “Advanced Elec. 

info” tab of the “Cylinder Card” window. With double cylinders ( ), the “Select cylinder side” window opens first 

where you have to choose the cylinder side from which to display the article information. Click the corresponding 

button to open the “Product information” window.

Fig. 6.6/26: “Select Cylinder side” window

After selecting a single cylinder ( ) or double cylinder with a mechanical side ( ), the “Product information” 

window opens where you can view the article information for the selected cylinder.

Fig. 6.6/27: “Product information” window

Note: We do not advise changing any of this information.

Click the [Cancel] button to close the window again.
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6.6.7 Reprogramming Cylinders

Due to a host of reasons, the program version on an electromechanical cylinder may deviate from the current 

program version. In these cases, the cylinder may have to be reprogrammed. To reprogram an electromechanical 

cylinder, first select the cylinder in the list. Click the  symbol in the toolbar or choose the “Information Card” 

in the “List” menu on the menu bar. Alternatively, you can double or triple-click the row to open it.

The “Cylinder Card” window (see fig. 6.6/10) opens to the “General Information” tab. Click the “Advanced Elec. 

info.” tab to open it and then click the  symbol to transfer the program data to the selected cylinder using the 

programming key.

A message window appears and prompts you to insert the main programming key into the correct port on your 

programming device. Click the [OK] button to confirm and insert the main programming key for the imported or 

selected lock system into the correct port of your programming device (see section 5.3).

Fig. 6.6/28: Message window

A security query appears and you have to click the [Yes] button to reprogram the cylinder. Click the [No] button 

to close this window without reprogramming the selected cylinder.

Fig. 6.6/29: Security query

In the message window that appears, click the [OK] button to confirm the action.
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Fig. 6.6/30: Message window

Click the [OK] button or the [Cancel] button to close the “Cylinder Card” window. Click the  symbol in the 

taskbar to open the “Lock Chart” window. In this window, the cylinders whose event lists are to be read are 

indicated by the green traffic light  (see fig. 6.8/1). 

To transfer the request to the programming key, click  in the toolbar. The yellow traffic light  changes from 

green to yellow and you cannot make any changes during this time. 

When one or more requests are being sent to the programming key, the “Sending task list” window appears. This 

window closes automatically as soon as the transfer is complete. After this, a message window appears. Click the 

[Yes] button to open the “Report Actions” window (see fig. 5.6/2) where you can configure the printout of a “To 

Do” list as described in section 5.6. This “To Do” list contains the names of the cylinders to be reprogrammed. Click 

the [No] button to close this window without printing the “To Do” list.

Fig. 6.6/31: Message window

Insert the programming key into the cylinder to be reprogrammed. Insert the programming key into the cylinder 

and hold it there until the  symbol appears on the display. Insert the programming key into the correct port 

on your programming device and click the  symbol in the “Lock Chart” window to transfer the reprogramming 

details for the cylinder. The “Type in the PIN” window opens where you can enter the PIN code of your 

programming key for the imported or selected lock system. Click the [OK] button to confirm your entry (see section 

5.4). 

The “Receiving task list” window appears while the data is being transferred to the programming key. This window 

closes automatically as soon as the transfer is complete and the cylinder has been reprogrammed.
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6.6.8 Adding Doors and Cylinders

You can create new doors or add cylinders to existing doors.

6.6.8.1 Add Doors

Click the  symbol in the toolbar or choose the “Create” function in the “Edit” menu on the menu bar and then 

click the “Create a new door” function to create a new door. An empty row is added to the end of this list for this 

door. 

To create a new door for a cylinder that has not yet been assigned, first click the row containing the cylinder in the 

list. Click the  symbol in the toolbar or choose the “Create” function in the “Edit” menu on the menu bar and 

then click the “New door for this cylinder” function. A message window opens where you can choose whether 

to create the new door using the name from the selected cylinder.

Fig. 6.6/32: Message window

Click the [No] button to list the doors without labels above the cylinders. Click the [Yes] button to apply the cylinder 

name to the new door.

Select the new door in the list and click the  symbol in the toolbar or choose the “Information Card” function 

in the “List” menu on the menu bar. Alternatively, you can also double or triple-click the row containing the lock 

line. The “Door Card” (see fig. 6.6/6) window opens to the “General Information” tab where you can change the 

settings as described in section 6.6.3.

Instead of editing the data in the “Door Card” window, you can also enter the information directly in the list by 

clicking the field in a column and editing the information there. When you click an editable column field, the 

background colour changes to yellow and is marked with a black border. 

Click the  symbol in the toolbar or choose the “Copy” function in the “Edit” menu on the menu bar to copy a 

selected entry. Click an input field and click the  symbol in the toolbar or choose the “Paste” function in the 

“Edit” menu on the menu bar to paste a previously copied entry into the currently selected field. 
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To create several doors, choose the “Expand” function in the “Edit” menu on the menu bar and then click the 

“Expand doors” function. In the “Doors” window that appears, select the number of empty lines to be created for 

the doors in the “Quantity to expand” selection box. The current number of doors is displayed above this 

selection box. These doors were either created or imported with the selected or imported lock system.

Note: You can create a maximum of 500,000 doors per lock system.

The “Append at the end” option adds the rows to the bottom of the list. Select the “Insert in the current 

position” option to insert the rows above the currently selected row in the “Door/Cyl. List” window.

Fig. 6.6/33: “Doors” window

Click the [Cancel] button to close this window without creating the empty rows for the doors. Create the new rows 

by clicking the [OK] button.

6.6.8.2 Adding a Cylinder

Click the  symbol in the toolbar or choose the “Create” function in the “Edit” menu on the menu bar and then 

click the “Create a new cylinder” function. An empty row is added to the end of this list for this cylinder. Click the 

“Move up” or “Move down” function in the “Edit” menu on the menu bar to change the position of the selected 

mechanical cylinder in the list.

Note: If doors are included in the list, clicking the “Move up” or “Move down” function will only move 

the position of the rows that contain cylinders belonging to doors. As a workaround, hide the 

doors by clicking the  symbol so that you can move any cylinder in the list using these 

functions.

Select the new mechanical cylinder in the list and click  in the toolbar or choose the “Information Card” 

function in the “List” menu on the menu bar. Alternatively, you can also double or triple-click the row containing 

the lock line. The “Cylinder Card” (see Fig. 6.6/10) window opens to the “General Information” tab where you 

can change the settings as described in section 6.6.4.
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With new mechanical cylinders, the “In Stock” status is displayed in the “Status” display box. You can change 

the status by assigning this cylinder to a door as described in section 6.6.9. Using the “Locked” option, you can 

lock or unlock the cylinder.s

Instead of editing the data in the “Cylinder Card” window, you can also enter the information directly in the list by 

clicking the column field and entering the information there. When you click an editable column field, the 

background colour changes to yellow and is marked with a black border. 

Click the  symbol in the toolbar or choose the “Copy” function in the “Edit” menu on the menu bar to copy a 

selected entry. Click an input field and click the  symbol in the toolbar or choose the “Paste” function in the 

“Edit” menu on the menu bar to paste a previously copied entry into the currently selected field. 

To create several cylinders, choose the “Expand” function in the “Edit” menu on the menu bar and then click the 

“Expand cylinders” function. In the “Cylinders” window that appears, select the number of empty lines to be 

created for the mechanical cylinders in the “Quantity to expand” option. The current number of cylinders are 

displayed above this option box. These cylinders were either created or imported with the selected or imported 

lock system. 

Note: You can create a maximum of 500,000 cylinders per lock system.

The “Append at the end” option adds the empty rows to the bottom of the list. Select the “Insert in the current 

position” option to insert the rows above the currently selected row in the “Door/Cyl. List” window.

Fig. 6.6/34: “Cylinders” window

Click the [Cancel] button to close this window without creating a empty rows for the mechanical cylinder. Create 

the new rows by clicking the [OK] button.
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6.6.9 Changing the Cylinder Status

To change the status for a certain cylinder or assign a cylinder to a door, first select the cylinder in the list. Click 

the  symbol in the toolbar or choose the “Information Card” function in the “List” menu on the menu bar. 

Alternatively, you can double or triple-click the row to open it.

The “Cylinder Card” window (see fig. 6.6/10) opens to the “General Information” tab. Click the  symbol next 

to the “Status” option box here. The “Cylinder Status” window opens where you can change the cylinder status 

or assign the cylinder to a door.

Fig. 6.6/35: “Cylinder Status” window

Note: If a cylinder is damaged, it is not be possible to change the cylinder status by reprogramming it 

(see section 6.6.7).

When you select a cylinder that has not yet been assigned to a door, the “Installed” and “Destroyed” option 

boxes appear. Select the “Installed” option to open the “Door List” window where the doors of the imported or 

selected lock system are displayed with their “ID”, “Name”, “No.”, “Type”, “Cylinder” and “Door plan name”.

Fig. 6.6/36: “Door List” window
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Click the door to which the selected cylinder is to be assigned. Click the  symbol to create a new door for the 

imported or selected lock system. An empty row is added to the end of this list for this door.

Click the [Cancel] button to close this window without assigning the cylinder to the selected door. Click the [OK] 

button to assign the cylinder to the door.

After clicking the [OK] button in the “Cylinder Status” window, a message window appears. Click the [Yes] button 

to apply the settings in the “Cylinder Card” window. Click the [No] button to close this window without changing 

the cylinder status or assigning the cylinder to the selected door. The “Status” display box in the “Cylinder Card” 

window displays the current status of this cylinder.

Fig. 6.6/37: Message window
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6.6.10 Deleting Cylinders and/or Doors

Note: It is not possible to delete electromechanical cylinders.

Select the mechanical cylinder or door whose data you wish to delete. Click the  symbol in the toolbar or 

choose the “Delete” function in the “Edit” menu on the menu bar. A security query appears and you have to click 

the [Yes] buton to continue. Click the [No] button to close this box without deleting the selected cylinder or door.

Fig. 6.6/38: Security query

Note: It is not possible to delete a cylinder or a door if there are persons who have access permission 

for it.

In the message window that appears, click the [OK] button to confirm the action. 

Fig. 6.6/39: Message window
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6.6.11 Additional Functions

Changing the column display

To change the way the columns are displayed, click the  symbol in the toolbar or choose the “Select columns 

to show” function in the “List” menu on the menu bar. In the “Column List” window that opens, you can choose 

which columns to display (as described in section 5.5.1).

Searching for entries

To search for a certain cylinder or door, click an entry to select the column for the search. The selected entry has 

a yellow background and black border. Click the  symbol in the toolbar or choose the “Find” function in the 

“List” menu on the menu bar. The search window opens where you can enter the search parameters and perform 

the search as described in section 5.5.2.

Using “Autofill”

When changing the settings for new rows, you can also automate this procedure. In the entry you are editing, 

select the column that you wish to autofill. When you click an editable column field, the background colour changes 

to yellow and is marked with a black border. Click the  symbol in the toolbar or choose the “Autofill” function 

in the “Edit” menu on the menu bar. In the “Doors” window that opens, you can change the settings for the entry 

as described in section 5.5.4.

Printing out the list

Click the  symbol in the toolbar or choose the “Print” function in the “List” menu on the menu bar. In the 

“Report Actions” window (see fig. 5.6/2) that opens, you can change the printer settings (as described in section 

5.6).

Note: The “Search for cylinder connected to PD” function in the “List” menu on the menu bar is 

currently not available in the English version.
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6.7 Door Plan

In this window, you can create door plans for the imported or selected lock system. This provides you with a clear 

overview of the locking and access permissions for keys and persons using various coloured door symbols. The 

meanings of the door symbols are explained on the inside of the last page of this manual. 

In addition to a clear overview of the permission relationships, the “Door Plan“ window also allows you to switch 

from display mode to access mode. As in the “Lock Chart“ window (see section 6.8.4), this mode allows you to 

change the locking permission for electromechanical keys of type E1 or E2 or for a group of keys of type E1 and 

E2 as they apply to a given cylinder.

Fig. 6.7/1: “Door Plan” window

You can perform the following tasks in the “Door Plan” window:

- Create door plans for the lock system

- View key permissions and the persons associated

- Assign or revoke locking permission to a key of type E1 or E2

- Transfer locking permissions to the programming key

- Print a “To Do” list for the programming key

- Confirm the changes to the locking permission

- Changing cylinder authorisation for a key of type E3

In the taskbar, click the “Door Plan” symbol to open the “Door Plan” window.
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6.7.1 Menu bar

The menu bar in this window contains the following menus. When you click a menu name, the menu drops down 

to display its contents. Some of these functions are also available as symbols in the toolbar.

Right-clicking a door symbol opens a shortcut menu with information on the cylinder that belongs to the selected 

door.

“System” menu

Backup (see section 6.2.3)

“List” menu

Door/Access List (see section 6.7.3)

Keys access (see section 6.7.3)

Persons access (see section 6.7.3)

Refresh lists, refreshes the lists in pop-up windows

Exit, closes the “Door Plan“ window

“Edit” menu

Door Plan (see sections 6.7.2, 6.7.3 and 6.7.6)

New Door plan

Edit Door plan

Delete Door plan

Information Card

Zoom in

Zoom out

Doors (see sections 6.7.2.2 and 6.7.3) 

Remove door from Door 

Plan

Information Card

Toggle door name/number

Unlock door positions or 

Lock door positions

Enlarge door

Reduce door

“Help” menu

Help screen (see section 5.2.1)

Additional help (see section 5.2.1)

About ...(see section 5.2.2)
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6.7.2 Designing a Door Plan

6.7.2.1 Creating a Door Plan

Click the  symbol in the toolbar or choose the “Door Plan” function in the menu bar under the “Edit” menu 

and then click the “New Door plan” function. In the “Door Plan” window that appears, enter the required data for 

the door plan in the available boxes. Click the  symbol to insert an image for the door plan as described in 

section 5.5.3. 

Note: You can import image files of “.jpg” and “.bmp” format in the “Door Plan” window.

Fig. 6.7/2: “Door Plan“ window

Click the [Cancel] button to close this window without creating a door plan for the imported or selected lock 

system. Click the [OK] button to save the door plan.

The “Door Plan“ window displays the inserted image for the door plan together with the given name at the bottom 

of the window as a tab.
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To create a new door plan, click the  symbol in the toolbar or choose “Door Plan“ function in the menu bar 

under the “Edit“ menu and then click the “New Door plan“ function. In the open “Door Plan“ window, enter the 

required data and insert an image for this door plan as described. Click the [OK] button to display this image in 

the “Door Plan“ window and add the given name for the door plan as an additional tab at the bottom of the screen.

You can switch between the various door plan images by clicking the tabs. Click the , ,  or  symbol 

to switch to the first, previous, next or last door plan respectively.

Click the  or  symbol in the toolbar to enlarge or reduce the size of the displayed image. Similarly, you can 

choose the “Door Plan“ function in the menu bar under the “Edit“ menu and then click the “Zoom in“ or “Zoom 

out“ function. This will enlarge or reduce the image according to your requirements.

6.7.2.2 Inserting Door Symbols

Before you can insert door symbols into the door plan, you first have to create the doors for your cylinders using 

the “Install all cylinders in stock“ function in the “Door/Cyl. List“ window as described in section 6.6.2. Click the 

 symbol in the toolbar of the “Door Plan“ window or choose the “Door Access List“ function in the menu bar 

under the “List“ menu. In the “Door/Cyl. List“ pop-up window that appears, the doors are listed together with their 

cylinders as described in section 6.6.2.

Fig. 6.7/3: “Door/Cyl. List“ pop-up window

The list in this pop-up window displays the doors together with the  symbol. Click the  symbol to expand the 

list and display all of the cylinders that belong to the door. Click the  symbol to collapse the list again.

If you have created several door plans, you first have to select the door plan into which the door symbols are to 

be inserted. Click again to insert a door symbol into the door plan. Doors that have already been inserted into the 

door plan are shown in the pop-up window without the  symbol. 

Insert the listed doors as door symbols into the door plan by clicking the  symbol in the pop-up window and 

dragging it into the door plan. A page symbol is now attached to the mouse cursor. 
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The coloured symbols for the doors inserted into the door plan indicate the door cylinder type and are displayed 

as follows:

Note: In general, doors with mechanical cylinders are displayed with blue symbols and doors with 

electromechanical cylinders are displayed with red symbols.

To graphically indicate the locking and access permissions for keys and persons, these door symbols change their 

appearance in the indicator windows (see section 6.7.3) depending on the currently selected row in the list. The 

meanings of the various door symbols are explained on the inside of the last page of this manual.

Click the  or  symbols in the toolbar to enlarge or reduce the inserted door symbols. Similarly, you can 

choose the “Doors“ function in the menu bar under the “Edit“ menu and then click the “Enlarge door“ or 

“Reduce door“ function.

To change the position of a door symbol in the door plan, click the symbol and drag it to the new position by 

keeping the mouse key pressed down. Release the mouse button to insert the symbol at the new position. 

Click the  symbol in the toolbar to lock the position of all inserted door symbols in the door plan. Similarly, you 

can choose the “Doors“ function in the menu bar under the “Edit“ menu and then click the “Unlock door 

positions“ function. 

Click the  symbol in the toolbar or select the “Lock door positions“ function under the “doors“ function in 

the menu bar under the “Edit“ menu to release the position of the door symbols.

To delete door symbols that have been inserted into the door plan, first click the door symbol to be deleted and 

then click the  symbol in the toolbar or choose the “Doors“ function in the menu bar under the “Edit“ menu 

and then click “Remove door from Door Plan“ function. 

Door symbol Corresponding cylinder

(blue) Mechanical cylinder (double, knob, or single cylinder)

(red) Single electromechanical cylinders

(blue/red) Double cylinder with one mechanical and one electromagnetic side

(blue) Electromechanical double cylinder or several cylinders
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In the security query that appears, click the [Yes] button to confirm that you want to remove the selected key from 

the door plan. Click the [No] button if you do not want to delete the door symbol.

Fig. 6.7/4: Security query

Note: You can only select door symbols in the door plan when they have not been locked into position.

The door that belongs to the door symbol that you have removed is displayed using the  symbol in the “Door/

Cyl. List“ pop-up window.

Depending on how you have configured the symbols in the “Door Plan“ tab of the “Config. Options“ window (see 

section 7.5.5), the selected or highlighted door symbols change appearance and are shown using a dashed 

border.
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6.7.3 Viewing Information

Indicator window

Right-click a door symbol in the door plan to view information such as the type of the cylinder in the door. In the 

indicator window that appears, the  or  symbols represent electromechanical or mechanical single cylinders 

respectively and the  or  symbols represent double cylinders with electromechanical and mechanical 

sides or electromechanical double cylinders respectively.

Fig. 6.7/5: Indicator window

Click the  symbol to open the “Cylinder Card“ window for the cylinder of this door. In the various tabs in this 

window, you can view information such as the locking permissions for keys as well as access permissions for 

persons and, if required, read out the event lists of a cylinder (see section 6.6.5). Click the  button to expand the 

menu where you can use the “Remove door from Door Plan“ function to remove the selected door symbol again 

as described.

To display the cylinders for this door in the “Door/Cyl. List“ pop-up window, click the  or  symbol. After 

searching, the  symbol indicates that the cylinder in the “Door/Cyl. List“ pop-up window has been found and that 

the row containing the cylinder is highlighted.

Fig. 6.7/6: Indicator window

In access mode, the permission symbols below the “A“ and “B“ letters indicate the locking permissions that the 

selected key or group possesses for this cylinder (see section 6.8.3). If you choose a key of type E3, the access 

permission symbols indicate whether this key is authorized to access the given cylinder or not (see section 6.8.5). 

Fig. 6.7/7: Indicator window

Click the  symbol to close the indicator window again.
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Pop-up window

To view the permission relationships between keys and persons in the “Door Plan“, you have to open the “Door/

Cyl. List“, “Keys“ and “Persons“ pop-up windows simultaneously. 

Click the ,  and  symbols in the toolbar or choose the “Door Access List“, “Keys access“ and 

“Persons access“ functions in the menu bar under the “List“ menu. 

Fig. 6.7/8: Pop-up windows in door plan

The “Door/Cyl. List“, “Keys“ and “Persons“ pop-up windows list the doors together with their cylinders, the lock 

lines together with the groups and keys contained therein, and the persons who are registered for the imported or 

selected lock system. 

Click the  symbol to expand the list in the “Door/Cyl. List” and “Keys” pop-up windows and display the cylinders 

or keys that belong to a lock line or group. Click the  symbol to collapse the list again. Double-clicking a row in 

these pop-up windows opens another window that displays information on the selected doors, cylinders and/or 

lock lines. 

You can display the permission relationships by clicking a cylinder, key, group or person in the corresponding pop-

up window. When you select a key, group or a person, the door symbols change appearance in the door plan to 

indicate the locking and/or access permissions.

Note: Select the “Show explanation about door marks in Door Plan” option in the “Config. Options” 

window to display a pop-up window additional comments on the cylinder as well as locking and 

access permissions (see section 7.5.5). This pop-up window appears when you move the mouse 

pointer over a door symbol.

Depending on the currently selected item, the lists in the other pop-up windows display the corresponding item in 

their lists. Click the  symbol in the toolbar or choose the “Refresh lists” function in the menu bar under the 

“List” menu to refresh the lists in the pop-up windows and make a new selection.
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6.7.3.1 Displaying Permissions for a Door

In the “Door/Cyl. List“ pop-up window (see fig. 6.7/10), select a door or cylinder in the list to display the locking 

permissions for the key and/or the persons who have access permission for this door or cylinder. Alternatively, you 

can click a door symbol in the door plan. The “Keys“ pop-up window displays the various door symbols in miniature 

in front of the keys and groups. This allows you to se the locking permissions of each key or group at a glance. If 

you choose a key of type E3, the door symbols indicate whether the key is authorized to access the given cylinder 

or not (see section 6.8.5). The meanings of the door symbols are explained on the inside of the last page of this 

manual.

Fig. 6.7/9: “Keys“ pop-up window with door symbols

At the same time, the “Persons“ pop-up window lists the persons who have access permission for the selected 

door or cylinder.

6.7.3.2 Displaying Locking Permissions

In the “Keys“ window, select the key or group in the list whose locking permissions are to be displayed. The door 

symbols in the door plan change depending on the selected key or group and indicate the locking permission for 

the cylinder of the given door. If you choose a key of type E3, these door symbols indicate whether or not the 

cylinder is authorized for the key of type E3 (see section 6.8.5). The meanings of the door symbols are explained 

on the inside of the last page of this manual.

At the same time, the “Door/Cyl. List“ pop-up window displays the various door symbols in miniature in front of the 

doors, so that you can see the locking permissions of the corresponding cylinder in this pop-up window as well.
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Fig. 6.7/10: “Door/Cyl. List“ pop-up window with door symbols

The “Persons“ pop-up window displays the corresponding person who possesses the selected key. When you 

select a group, this pop-up window lists those person who possess keys from this group.

6.7.3.3 Displaying Access Permissions

In the “Persons” pop-up window, select the person in the list whose access permissions are to be displayed. 

Fig. 6.7/11: “Persons” pop-up window

The door symbols in the door plan change depending on the selected person and indicate the access permission 

for the cylinder of the given door. The meanings of the door symbols are explained on the inside of the last page 

of this manual. 

At the same time, the corresponding keys that this person possesses are displayed in the “Keys“ pop-up window. 

The “Door/Cyl. List“ pop-up window lists the corresponding doors and cylinders for which the selected person has 

access permission.
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6.7.4 Changing Locking Permissions for Keys of Type E1 and E2

Note: If you are logged in as a user and not a supervisor and your subordinate programming key has 

restricted programming privileges, you may not be able to change the locking permissions of 

certain keys or groups for the corresponding cylinders. In the “Lock Chart” window, the 

cylinders that your subordinate programming key is not permitted to program are displayed 

using the  symbol (see fig. 6.8/3).

Click the arrow next to the  display box and select “Access Mode” in the drop-down menu 

that appears. The  display box appears in the toolbar and a yellow flashing  symbol is 

displayed in the title bar. You can now change the locking permission of an electromechanical key or group of 

electromechanical keys for electromechanical cylinders. With groups, changing the locking permission affects all 

of the keys therein.

Note: The locking permission for mechanical keys applies only to the mechanical cylinders and cannot 

be changed. In this window, you can only change the authorisation of cylinders for keys of type 

E3 ( ). In the “Lock Chart” window, you can program locking permissions in keys of type E3 for 

authorised cylinders (see section 6.8.8).

6.7.4.1 Assigning Locking Permissions

To assign locking permission for a cylinder to an electromechanical key of type E1 or E2 or to a group with keys 

of type E1 or E2, open the “Keys“ pop-up window as described. In this pop-up window, first click the  symbol to 

expand the list to the keys. Next, click the row in the list containing the key that is to receive locking permission for 

the current cylinder.

Fig. 6.7/12: “Keys” pop-up window

Right-click the door symbol in the list to display the locking permission for the corresponding cylinder in the open 

indicator window. In this indicator window, any missing locking permissions of a key or group are shown below 

the “A“ and “B“ letters using the permission symbols  (single electromechanical cylinder),  (double 

electromechanical cylinder), and  or  (double cylinder with one electromagnetic side).
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Fig. 6.7/13: “Door Plan” window

Double-click a permission symbol to assign locking permission for the cylinder to the key of type E1 or E2, or to a 

group. Depending on the given cylinder, the assigned locking permission is displayed using one of the following 

permission symbols: , ,  or . To assign locking permission to one side or to both sides of a double 

cylinder, double-click the corresponding side(s) of the permission symbol: ,  or . 

Fig. 6.7/14: Indicator window

When the traffic light  is green, this indicates that the locking permission was changed for the given cylinder. At 

the same time, the assigned locking permission is displayed in the corresponding door symbol using a “+” sign. 

The  symbol is active in the toolbar for data transfer (see fig. 6.7/13).
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6.7.4.2 Revoking Locking Permissions

To revoke locking permission for a cylinder from an electromechanical key of type E1 or E2 or from a group 

containing keys of type E1 or E2, select the key from the list in the “Keys“ pop-up window as described in section 

6.7.4.1.

Right-click the corresponding door symbol to change the cylinder's locking permission in the open window (see 

fig. 6.7/13). In this indicator window, any existing locking permissions of a key or group are shown using the 

permission symbols  (single electromechanical cylinder),  (double electromechanical cylinder) and  or 

 (double cylinder with one electromagnetic side).

Double-click a permission symbol to revoke locking permission for the cylinder from the key of type E1 or E2, or 

from a group. Depending on the given cylinder, the revoked locking permission is displayed using one of the 

following permission symbols: , ,  or . To revoke locking permission from one side or from both sides 

of a double cylinder, double-click the corresponding side(s) of the permission symbol: ,  or .

Fig. 6.7/15: Indicator window

When the traffic light  is green, this indicates that the locking permission was changed for the given cylinder. At 

the same time, the revoked locking permission is displayed in the corresponding door symbol using a “-” sign. 

The  symbol is active in the toolbar for data transfer (see fig. 6.7/13).
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6.7.5 Transferring Locking Permissions

Note: After importing your lock system into the CLIQ™ Manager program or selecting it in the CLIQ™ 

Manager Plus program, make sure to insert the programming key into the correct port on your 

programming device (see section 5.3.)

When the traffic light  is green, this indicates that the locking permission has been changed for this cylinder. 

This change has to be transferred to the programming key so that you can program the changes into the 

corresponding cylinders. During the transfer, the traffic light  becomes yellow and you cannot make any 

changes to the locking permissions. It is not possible to make additional changes to the locking permissions until 

you confirm having programmed the changes. When the traffic light  is red, this indicates that task was 

transferred to another programming key for this cylinder but has not yet been confirmed (see section 8.4.1.1). You 

transfer the modified locking permissions to the cylinders as described for the “Lock Chart“ window. Here we only 

briefly describe the procedure:

Transferring locking permissions to the electromechanical cylinders (see section 6.8.4.3)

To transfer the locking permission changes to the programming key, click the  symbol in the toolbar. When one 

or more tasks are being transferred to the programming key, the “Sending task list“ window appears. This window 

closes automatically as soon as the transfer is complete. You can also print out a “To Do“ sheet with a list of the 

cylinders to be reprogrammed with the new locking permissions. In the toolbar, the  symbol is deactivated 

again and the  symbol is activated. 

Programming cylinders (see section 6.8.4.3)

Insert the programming key into each cylinder where the locking permission is to be changed. Hold the 

programming key in the cylinder until the  symbol appears on the display.

Confirming programmed electromechanical cylinders (see section 6.8.4.4)

Insert the programming key into the correct port on your programming device and click the  symbol in the 

toolbar to confirm that the changes to the locking permissions have been programmed. The “Receiving task list“ 

window appears while the task(s) are being transferred from the programming key. This window closes 

automatically as soon as the transfer is complete. The symbols change appearance in the corresponding windows 

(see fig. 6.7/14 and fig. 6.7/15) and indicate that the locking permission changes have been programmed into the 

cylinders. Once the tasks have been received, the  symbol is deactivated in the toolbar again.
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6.7.6 Deleting Door Plans

Select the door plan to be deleted by clicking the corresponding tab at the bottom of the window. Click the 

symbol in the toolbar or choose the “Door Plan“ function in the menu bar under the “Edit“ menu and then click 

the “Delete Door Plan“ function.

A security query appears and you have to click the [Yes] buton to continue. Click the [No] button to close the 

security query without deleting the selected door plan.

Fig. 6.7/16: Security query

Doors that have already been inserted as door symbols into the door plan are displayed using the  symbol in 

the “Door/Cyl. List“ pop-up window. As described in section 6.7.2.2, you can insert these doors as door symbols 

into another door plan.

6.7.7 Additional Functions

Note: Make sure to insert the programming key into the correct port on your programming device for 

the lock system that you have imported into CLIQ™ Manager or selected in CLIQ™ Manager Plus 

(see section 5.3). 

Click the  symbol in the toolbar and choose the “Search for key inserted in PD” function to highlight the 

electromechanical key currently inserted in the programming device in the “Keys“ pop-up window.

Note: The “Search for cylinder connected to PD” function (  symbol) is currently not available in the 

English version.
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6.8 Lock Chart

Note: Make sure to insert the programming key into the correct port on your programming device for 

the lock system that you have imported into CLIQ™ Manager or selected in CLIQ™ Manager Plus 

(see section 5.3).

This window clearly lists all of the electromechanical and mechanical keys that have been created or imported for 

the imported or selected lock system. The locking permission of a key for a given cylinder is indicated using various 

permission symbols in a function matrix located in the lower section of this window. This provides you with an 

overview of the lock permissions for this lock system that you can change quickly and easily whenever necessary.

Fig. 6.8/1: “Lock Chart” window

You can perform the following tasks in the “Lock Chart” window:

- View locking permissions for a key

- Assign or revoke locking permission to a key of type E1 or E2

- Transfer lock permission to the programming key

- Print a “To Do” list for programming cylinders

- Confirm the changes to the lock permission

- Change the locking permissions for a key of type E3

In the taskbar, click the “Lock Chart” symbol to display the “Lock Chart” 

window.
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6.8.1 Menu bar

The menu bar in this window contains the following menus. When you click a menu name, the menu drops down 

to display its contents. Some of these functions are also available as symbols in the toolbar.

When you select a row by clicking it, right-clicking it opens a shortcut menu with various functions that you can 

select.

“System” menu

Backup (see section 6.2.3)

“List” menu

Select columns to show (see section 5.5.1)

Door/Cyl. List

Key List

Flip Lock Chart (see section 6.8.2)

Zoom (see section 6.8.2)

150 %

100 %

75 %

50 %

33 %

Other zoom

Show existing keys or Show all keys (see section 6.8.2)

Door/Cyl. List (see section 6.8.2)

Expand all lines

Contract all lines

Information Card

Key List (see section 6.8.2)

Expand all lines

Expand selected line

Contract all lines

Information Card

“Edit” menu

Auto fill accesses (see section 6.8.4.1)

Auto delete accesses (see section 6.8.4.2)

“Help” menu

Help screen (see section 5.2.1)

Additional help (see section 5.2.1)

About ... (see section 5.2.2)
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6.8.2 Viewing Information

The “Lock Chart” window provides you with an overview of the keys and cylinders of the imported or selected lock 

system, listed above and to the left of the function matrix. The top left section of this window displays the selected 

key together with the selected cylinder or door and the numbers that have been assigned to them.

Click the  symbol in the toolbar or choose the “Flip Lock Chart” function in the “List” menu on the menu bar 

to flip positions in the list.

Key types

When the keys are listed, a lock line is indicated by the  symbol and the keys therein are indicated by the  or 

 symbols, depending on the type of key (electromechanical or mechanical). All of the electromechanical keys 

within a lock line are combined into a group that is indicated by the  symbol. Keys of type E3 are also indicated 

by the  symbol.

Cylinder types

When the cylinders are listed, each type of cylinder is displayed using a unique symbol. The  or  symbols 

represent electromechanical or mechanical cylinders and the  or  symbols represent double cylinders 

with electromechanical and mechanical sides or electromechanical double cylinders.

A row that contains a destroyed key is marked in red. If you choose the “Install all cylinders in stock” function 

in the “Door/Cyl. List” (see section 6.6.2), the corresponding doors are also listed here.

Click the  symbol to expand the given list and display all of the keys for that belong to the lock line or group as 

well as the cylinders that belong to each door. Click the  symbol to collapse the given list again. In the “List” 

menu on the menu bar, you can choose the “Door/Cyl. List” or “Key List” function and then click the “Expand 

all lines” or “Contract all lines” function to expand or collapse the given list. Choose the “Expand selected 

line” function under the “Key List” function to expand the selected group or lock line.

Displaying lock lines with keys or just the keys

Click the  symbol in der toolbar or choose the “Show existing keys” function in the “List” menu on the menu 

bar to display the keys in the given list together with the lock line(s) and groups that they belong to. Click the 

symbol in the toolbar or choose the “Show all keys” function in the “List” menu on the menu bar to restrict this 

list display to those keys that belong to the imported or selected lock system.
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Zooming

Click the  symbol in the toolbar or choose the “Zoom” function in the “List” menu on the menu bar to drop 

down a menu where you can choose the zoom factor for the lock chart. Click the “Other Zoom” function to enter 

a custom zoom value. In the “Zoom” window that opens, you can enter as custom zoom value. 

Click the  symbol to expand the selection box and select one of the available zoom factors. Click the [Cancel] 

button to close this window without applying the zoom factor to the lock chart. Click the [OK] button to apply the 

zoom factor.

Fig. 6.8/2: “Zoom” window

Displaying information

Note: In the “Door/Cyl. List” window (see fig. 6.6/1), you can hide the doors and display only the 

cylinders in the function matrix (as described in section 6.6.2). 

To view the data for a certain lock line, group or for a specific key, cylinder or door, click the row in the list that 

contains the item. Click the  symbol in the toolbar or choose the “Cylinder Card” or “Key Card” function in 

the drop-down menu. Similarly, you can choose the “Door/Cyl. List” or “Key List” function in the “List” menu 

on the menu bar and then click the “Information Card” function. Alternatively, double-click the corresponding 

row. 

The next window that opens depends on what you have selected: “Key Line Card” opens for lock lines (see section 

6.5.3), “Group Card” opens for a group (see section 6.5.4), “Electronic Key Card” (see section 6.5.5) opens for an 

electromechanical key and “Key Copy Card” opens for a mechanical key (see section 6.5.9.2). If you select a 

cylinder, the “Cylinder Card” window (see section 6.6.4) opens while the “Door Card” window (see section 6.6.3) 

opens for doors. 

Click the [Cancel] button to close the window again.
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6.8.3 Displaying Keys of Type E1 and E2

The function matrix displays the locking permissions for mechanical ( ) and electromechanical keys of type E1 

and E2 ( ) or key groups (E1 and E2) ( ) using the following locking permission symbols for each of the 

cylinders. For information on the locking permission symbols for electromechanical keys of type E3, see section 

6.8.5.

The locking permission of an electromagetic key of type E1 or E2 is automatically revoked for the given 

electromechanical cylinder when the key is registered as ‘missing’ or ‘locked’. The corresponding permission 

symbols are displayed in red in the function matrix.

6.8.4 Changing Locking Permission for Keys of Type E1 and E2

The imported system data from an electromechanical lock system contains the locking permissions for the 

mechanical and electromechanical keys. You can change the electromechanical locking permission for 

electromechanical keys of type E1 or E2, for electromechanical keys of type E3 (see section 6.8.8) as well as for 

a group of keys of type E1 or E2. With groups, changing the locking permission affects all of the keys therein. 

Note: The locking permission for mechanical keys applies only to the mechanical cylinders and cannot 

be changed.

Mechanical keys: Electromechanical keys: Group:

Mechanical cylinder

Opens Opens Opens

Single electromechanical cylinders

Does not open 

Opens (electromagnetic access) Opens (electromagnetic access)

Does not open (no 
electromechanical access)

Does not open (no 
electromechanical access)

Double cylinder with one mechanical and one electromagnetic side

Does not open

Opens (electromagnetic access) Opens (electromagnetic access)

Does not open (no 
electromechanical access)

Opens only one side (no 
electromechanical access)

Electromagnetic double cylinder

Does not open

Opens (electromagnetic access) Opens (electromagnetic access)

Opens only one side (no 
electromechanical access for both 
sides) 

Opens only one side (no 
electromechanical access for both 
sides)

Does not open (no 
electromechanical access)

Does not open (no 
electromechanical access)
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If you are logged in as a user and not a supervisor, your programming key will be subordinate to the master 

programming key and the missing programming privileges will be indicated by a  symbol next to the affected 

cylinders. Using your subordinate programming key, you will not be able to change the locking permissions for the 

keys or groups that access these cylinders. If required, contact your supervisor to change your programming 

privileges for your subordinate programming key.

Fig. 6.8/3: “Lock Chart” window with display of lacking programming priveleges

6.8.4.1 Assigning Locking Permissions

Any locking permission that an electromechanical key of type E1 or E2 or group of keys of type E1 or E2 does not 

have for a cylinder is displayed in the function matrix using permission symbols:  (single electromechanical 

cylinder),  (double electromechanical cylinder) and  /  (double cylinder with an electromechanical side).

Note: In a group containing keys of type E1 or E2, you have to select the corresponding group.

To assign locking permission for a cylinder to an electromechanical key of type E1 or E2 or to a group containing 

keys of type E1 or E2, first click the  symbol to expand the list down to the required keys and/or cylinders. Next, 

double-click the corresponding permission symbol in the function matrix. Depending on the given cylinder, the 

assigned locking permission is displayed using one of the following permission symbols: , ,  or . To 

assign locking permission to an electromechanical side or to both electromechanical sides of a double cylinder, 

double-click the corresponding side(s) of the permission symbol: ,  or .
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Fig. 6.8/4: “Lock Chart” window with modified locking permission

To assign locking permission to multiple keys of type E1 or E2 for a single cylinder or to one key of type E1 or E2 

for multiple cylinders, click the corresponding permission symbol in the function matrix.

Note: It is not possible to assign locking permission to several groups with keys of type E1 or E2 

simultaneously.

Click the green  symbol in the toolbar or choose the “Auto fill accesses” function in the “Edit” menu on the 

menu bar. The “Autofill” window opens where you can change the listing in the function matrix by clicking the 

or  symbol. Depending on your selection here, the locking permissions may be assigned to multiple keys of 

type E1 and E2 for a single cylinder or to one key of type E1 or E2 for multiple cylinders.

Click the green  symbol to switch to the “Delete” window (see fig. 6.8/7), where you can revoke locking 

permission from multiple keys of type E1 and E2 for a single cylinder or from one key of type E1 or E2 for multiple 

cylinders. Click the [Cancel] button to close this window without assigning the locking permission.
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Fig. 6.8/5: “Autofill” window

Click the  or  symbol to open the “Auto fill accesses” window where you can assign locking permission to 

a row in the current list. The “From” display box displays the row that corresponds to the currently selected symbol 

in the function matrix. 

The “First” display box indicates that the changes to the locking permissions will begin at this row. In the “To” 

input box, enter the last row containing a key of type E1 or E2, or a cylinder, which is to be affected by the changes 

to the locking permissions. The “Last” display box indicates which row contains the last key of type E1 or E2 or 

the last cylinder. 

Fig. 6.8/6: “Auto fill accesses” window

Click the [Cancel] button to close this window without assigning the locking permission. Click the [OK] button to 

change the locking permissions for the rows in the current listing.

When the traffic light  is green in the “Lock Chart” window, this indicates that the locking permission was 

changed for the given cylinder. Click the  symbol in the toolbar to transfer the locking permission changes to 

your programming key (see section 6.8.4.3).
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6.8.4.2 Revoking Locking Permissions

Note: It is not possible to revoke locking permission for mechanical cylinders from electromechanical 

keys of type E1 and E2 or groups with keys of type E1 or E2.

Any locking permission that an electromechanical key of type E1 or E2 or group of keys of type E1 or E2 does 

have for a cylinder is displayed in the function matrix using permission symbols:  (single electromechanical 

cylinder),  (double electromechanical cylinder) and  or  (double cylinder with an electromechanical side).

Note: In a group containing keys of type E1 or E2, you have to select the corresponding group.

To revoke locking permission from an electromechanical key of type E1 or E2 or from a group containing keys of 

type E1 or E2 for a single cylinder, first click the  symbol to expand the list down to the required keys or cylinders. 

Next, double-click the corresponding permission symbol in the function matrix. Depending on the given cylinder, 

the revoked locking permission is displayed using one of the following permission symbols: , ,  or . To 

revoke locking permission for an electromechanical side or for both electromechanical sides of a double cylinder, 

double-click the corresponding side(s) of the permission symbol: ,  or .

To revoke locking permission from multiple keys of type E1 or E2 for a single cylinder or from one key of type E1 

or E2 for multiple cylinders, click the corresponding permission symbol in the function matrix. 

Note: It is not possible to simultaneously revoke the locking permission from multiple groups 

containing keys of type E1 or E2.

Click the red  symbol in the toolbar or choose the “Auto delete accesses” function in the “Edit” menu on the 

menu bar. The “Delete” window opens where you can change the listing in the function matrix by clicking the 

or  symbol. Depending on your selection here, you can revoke locking permission from multiple keys of type 

E1 and E2 for a single cylinder or from a single key of type E1 or E2 for multiple cylinders.

Fig. 6.8/7: “Delete” window

Click the red  symbol to switch to the “Autofill” window (see fig. 6.8/5), where you can reassign locking 

permission to multiple keys of type E1 and E2 for a single cylinder or to one key of type E1 or E2 for multiple 

cylinders. Click the [Cancel] button to close this window without revoking the locking permissions.
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Click the  or  symbol to open the “Auto delete accesses” window where you can revoke locking permission 

from a row in the current list. The “From” display box displays the row that corresponds to the currently selected 

symbol in the function matrix. 

The “First” display box indicates indicates that the changes to the locking permissions will begin at this row. In 

the “To” input box, enter the last row containing a key of type E1 or E2, or a cylinder, which is to be affected by 

the changes to the locking permissions. The “Last” box indicates which row contains the last key of type E1 or 

E2 or the last cylinder. 

Fig. 6.8/8: “Auto delete accesses” window

Click the [Cancel] button to close this window without revoking the locking permission. Click the [OK] button to 

change the locking permissions for the rows in the current listing.

When the traffic light  is green in the “Lock Chart” window (see fig. 6.8/4), this indicates that the locking 

permission was changed for the given cylinder. Click the  symbol in the toolbar to transfer the locking 

permission changes to your programming key (see section 6.8.4.3).
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6.8.4.3 Transferring Locking Permission

Note: Make sure to insert the programming key into the correct port on your programming device for 

the lock system that you have imported into CLIQ™ Manager or selected in CLIQ™ Manager Plus 

(see section 5.3).

When the traffic light  is green, this indicates that the locking permission has been changed for a cylinder. This 

change has to be transferred to the programming key so that you can program the changes into the corresponding 

cylinders. During this time, the traffic light  changes to a yellow and you cannot make any changes to the locking 

permissions. It is not possible to make additional changes to the locking permissions until you confirm having 

transferred the changes to the cylinders. When the traffic light  is red, this indicates that a task was transferred 

to another programming key but has not yet been confirmed (see section 8.4.1.1).

Fig. 6.8/9: “Lock Chart” window for data transfer

To transfer the locking permission changes to the programming key, click the  symbol in the toolbar. While 

transferring locking permission changes to the programming key, the “Sending task list” window appears. This 

window closes automatically as soon as the transfer is complete. 
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After this, a message window appears. Click the [Yes] button to open the “Report Actions” window (see fig. 

5.6/2) where you can configure the printout of a “To Do” list as described in section 5.6. This “To Do” list contains 

the names of the cylinders that have to be programmed with the changes to the locking permissions using the 

programming key. Click the [No] button to close this window without printing the “To Do” list.

Fig. 6.8/10: Message window

After transferring the new locking permission(s) to your programming key, the  symbol is active in the toolbar. 

Click thissymbol to open the “Report Actions” window and print out a “To Do” list. The  symbol is active on the 

toolbar but the  symbol is deactivated.

Programming cylinders

Insert the programming key into each cylinder where the locking permission is to be changed. Hold the 

programming key in the cylinder until the  symbol appears on the display. 

Each cylinder is programmed by the progamming key according to the locking permissions defined in the lock 

chart.

Fig. 6.8/11: Programming a cylinder
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6.8.4.4 Confirming Locking Permission

Note: Make sure to insert the programming key into the correct port on your programming device for 

the lock system that you have imported into CLIQ™ Manager or selected in CLIQ™ Manager Plus 

(see section 5.3).

After programming a cylinder using the programming key, click the  symbol to confirm the permission change 

in the program.

The “Type in the PIN” window opens where you can enter the PIN code of your programming key for the imported 

or selected lock system. Click the [OK] button to confirm your entry (see section 5.4).

While transferring locking permission changes from the programming key, the “Receiving task list” window 

appears. This window closes automatically as soon as the transfer is complete. The permission symbols change 

appearance in the function matrix of the locking chart and indicate that the locking permission changes have been 

programmed.

If the locking permission changes were not made by the programming key or other problems occur, the “Results 

receiving task list” window opens with an error log. This window provides you with an overview of the tasks that 

have not yet been completed. Click the [Cancel] button to close this window again.

Fig. 6.8/12: “Results receiving task list” window
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6.8.5 Displaying Locking Permissions for Keys of Type E3

The function matrix in this window displays the locking permissions of electromechanical keys of type E3 ( ) for 

the cylinders using different permission symbols. Keys of type E3 are also indicated by the  symbol. The 

difference with keys of type E3 is that, even when they have locking permission for a given cylinder, the keys 

themselves have to be authorised to access the cylinder in question (see section 6.8.6). The locking permissions 

are displayed using the following symbols:

The locking permission of an electromagnetic key of type E3 is automatically revoked for the given 

electromechanical cylinder when the key is registered as ‘missing’ or ‘locked’. The corresponding permission 

symbols are displayed in red in the function matrix.

Mechanical cylinder Opens

Single electromechanical cylinders

Opens (electromechanical locking permission exists and 
key of type E3 is authorized for cylinder)

Does not open (no electromechanical locking permission 
and key of type E3 is not authorized for cylinder)

(yellow)
Does not open (key of type E3 is authorized for cylinder 
but does not have electromechanical locking permission)

(pink)
Does not open (no electromechanical locking permission 
and key of type E3 is not authorized for cylinder)

Double cylinder with one mechanical and 
one electromagnetic side

Opens (electromechanical locking permission exists and 
key of type E3 is authorized for cylinder)

Opens only one side (no electromechanical locking 
permission and key of type E3 is not authorized for 
cylinder)

(yellow)
Opens only one side (key of type E3 is authorized for 
cylinder but does not have electromechanical locking 
permission)

(pink)
Opens only one side (no electromechanical locking 
permission and key of type E3 is not authorized for 
cylinder)

Electromagnetic double cylinder

Opens (electromechanical locking permission exists for 
both sides and key of type E3 is authorized for both sides)

(yellow)
Opens only one side (no electromechanical locking 
permission for both sides and key of type E3 is not 
authorized for cylinder)

Does not open (no electromechanical locking permission 
and key of type E3 is not authorized for cylinder)

(yellow)
Does not open (key of type E3 is authorized for cylinder 
but does not have electromechanical locking permission)

(pink)
Does not open (no electromechanical locking permission 
and key of type E3 is not authorized for cylinder)
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6.8.6 Changing Cylinder Authorisation for a Key of Type E3

In order for a key of type E3 to be able to access a given cylinder, you first have to authorise the cylinder for keys 

of this type. After authorising the cylinders, you also have to assign locking permission to keys of type E3 for these 

cylinders (see section 6.8.8.1).

In the function matrix, the authorised cylinders for keys of type E3 are displayed using a yellow permission symbol 

(such as ) while unauthorised cylinders are displayed using a white permission symbol (such as ).

Fig. 6.8/13: “Lock Chart” window with display of authorised cylinders for keys of type E3

Assigning authorisation

Any authorisation that an electromechanical cylinder does not have for a key of type E3 is displayed in the 

function matrix using white permission symbols:  (single electromechanical cylinder),  (double 

electromechanical cylinder) and  /  (double cylinder with an electromechanical side).

To authorise a cylinder for an electromechanical key of type E3, click the  symbol to expand the list down to the 

required cylinders and/or keys. Next, double-click the corresponding permission symbol in the function matrix. 

Depending on the given cylinder, the authorisation is displayed using one of the white permission symbols: , 

,  or . To authorise an electromechanical side or both electromechanical sides of a double cylinder, 

double-click the corresponding side(s) of the white permission symbol: ,  or .
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To authorise multiple cylinders for a key of type E3 or one cylinder for several keys of type E3, click the 

corresponding permission symbol in the function matrix. Click the green  symbol in the toolbar or choose the 

“Auto fill accesses” function in the “Auto fill accesses” menu on the menu bar. The “Autofill” window opens 

(see fig. 6.8/5). Analogously to assigning locking permissions to keys of type E1 and E2 (see section 6.8.4.1), you 

can authorise multiple cylinders for a single key of type E3 or a single cylinder for multiple keys of type E3.

When the traffic light  is green in the “Lock Chart” window, this indicates that the authorisation was changed for 

the given cylinder. Click the  symbol in the toolbar to transfer the authorisation changes to your programming 

key as described in section 6.8.7.

Revoking authorisation

Any authorisations that an electromechanical cylinder does have for keys of type E3 is displayed in the function 

matrix using yellow permission symbols:  (single electromechanical cylinder),  (double electromechanical 

cylinder) and  /  (double cylinder with an electromechanical side).

To revoke a cylinder's authorisation for an electromechanical key of type E3, click the  symbol to expand the list 

down to the required cylinders and/or keys. Next, double-click the corresponding permission symbol in the function 

matrix. Depending on the given cylinder, the authorisation is displayed using one of the yellow permission 

symbols: , ,  or . To revoke locking permission from the electromechanical side or both 

electromechanical sides of a double cylinder, double-click the corresponding side(s) of the yellow permission 

symbol: ,  or .

To authorize multiple cylinders for a key of type E3 or a single cylinder for multiple keys of type E3, click the 

corresponding permission symbol in the function matrix. Click the red  symbol in the toolbar or choose the 

“Auto delete accesses” function in the “Edit” menu on the menu bar. The “Delete” window opens (see fig. 6.8/

7). Analogously to revoking locking permissions from keys of type E1 and E2 (see section 6.8.4.2), you can delete 

the authorisation from multiple cylinders for a single key of type E3 or from a single cylinder for multiple keys of 

type E3.

When the traffic light  is green in the “Lock Chart” window (see fig. 6.8/4), this indicates that the authorisation 

of the given cylinder was changed for keys of type E3. Click the  symbol in the toolbar to transfer the 

authorisation changes to your programming key as described in section 6.8.7.
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6.8.7 Transferring and Confirming Authorisations

Note: Make sure to insert the programming key into the correct port on your programming device for 

the lock system that you have imported into CLIQ™ Manager or selected in CLIQ™ Manager Plus 

(see section 5.3).

Transferring authorisations

When the traffic light  is green, this indicates that the authorisation has been changed in a cylinder for a key of 

type E3 (see fig. 6.8/9). Click the  symbol to transfer this change to the programming key so that you can 

program the changes into the corresponding cylinders (see section 6.8.4.3). During this time, the traffic light  is 

yellow and you cannot make any changes to the authorisations. It is not possible to make additional changes to 

the authorisations until you confirm having programmed the changes. When the traffic light  is red, this indicates 

that a task was transferred to another programming key but has not yet been confirmed.

Confirming authorisations

After programming the cylinder using the programming key, click the  symbol in the toolbar to confirm that the 

authorisation for keys of type E3 has been changed.

The “Type in the PIN” window opens where you can enter the PIN code of your programming key for the imported 

or selected lock system. Click the [OK] button to confirm your entry (see section 5.4).

While transferring authorisation changes for keys of type E3 from the programming key, the “Receiving task list” 

window appears. This window closes automatically as soon as the transfer is complete. The permission symbols 

change appearance in the function matrix of the locking chart and indicate that the changes to the authorisations 

have been programmed.

If the authorisation was not changed by the programming key or other problems occur, the “Results receiving task 

list” window opens with an error log (see fig. 6.8/12). This window provides you with an overview of the tasks that 

have not yet been completed. Click the [Cancel] button to close this window again.
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6.8.8 Changing the Locking Permission for Keys of Type E3

Note: In the “Config. Options” window, select the “Activate functions for temporary keys” option (keys 

of type E3) to also include programming symbol for keys of type E3 in the toolbar (see section 

7.5.2).

You can quickly and easily change the locking permissions for E3 keys without having to program the 

electromechanical cylinders. As a prerequisite, the corresponding electromechanical cylinders must be authorized 

for keys of type E3 as described in section 6.8.6.

If you assign locking permission to a key of type E3 for an unauthorised cylinder, a pink permission symbol (such 

as ) is displayed for the cylinder after you program the key of type E3 (see section 6.8.8.1). In this case, the 

key of type E3 will not be able to open or lock the cylinder even though it has locking permission.

Fig. 6.8/14: “Lock Chart” window for key of type E3
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6.8.8.1 Assigning and Programming Locking Permissions

Note: Make sure to insert the programming key into the correct port on your programming device for 

the lock system that you have imported into CLIQ™ Manager or selected in CLIQ™ Manager Plus 

(see section 5.3).

Any locking permissions that a key of type E3 ( ) does not have for an authorised cylinder is displayed in the 

function matrix using permission symbols:  (single electromechanical cylinder),  (double electromechanical 

cylinder) and  /  (double cylinder with an electromechanical side).

Click the active  symbol in the toolbar to assign locking permission to the inserted key of type E3 for an 

authorised cylinder. This symbol flashes and the key of type E3 is highlighted in blue in the corresponding list.

Next, double-click the corresponding permission symbol in the function matrix. Depending on the given cylinder, 

the assigned locking permission for the key of type E3 is displayed using one of the following modified permission 

symbols: , ,  or . To assign locking permission for an electromechanical side or for both sides of a 

double cylinder, double-click the corresponding side(s) of the permission symbol: ,  or .

Note: If you select the key of type E3 by clicking the row instead of the  symbol, double-clicking 

the permission symbol will revoke the cylinder authorisation for the key of type E3 instead of 

assigning locking permission to the key of type E3 for this cylinder.

After changing the locking permission for a key of type E3, the  symbol becomes active in the toolbar. Click 

this symbol to program the key of type E3 according to the new locking permissions (see fig. 6.8/15). 

The “Type in the PIN” window opens where you can enter the PIN code of your programming key for the imported 

or selected lock system. Click the [OK] button to confirm your entry (see section 5.4).
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Fig. 6.8/15: “Lock Chart“ window for programming a key of type E3

A message window appears and prompts you to insert the selected key of type E3 into the correct port on your 

programming device. Click the [OK] buton to confirm and insert the key of type E3 into the correct port of your 

programming device (see section 5.3).

Fig. 6.8/16: Message window

The programmed locking permissions for the key of type E3 are displayed in the “Programming temporary key” 

window. This window closes automatically as soon as the programming is complete. The  symbol is 

deactivated in the toolbar again.

Note: If you assign locking permission to a key of type E3 for an unauthorised cylinder (such as ), 

a pink permission symbol (such as ) is displayed in the function matrix after you program the 

key. 
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This pink permission symbol indicates that the key of type E3 will not be able to open or lock the cylinder even 

though it has locking permission. As described in section 6.8.6, authorise the cylinder for the key of type E3 so 

that it can access this cylinder.

6.8.8.2 Revoking and Programming Locking Authorisation

Note: Make sure to insert the programming key into the correct port on your programming device for 

the lock system that you have imported into CLIQ™ Manager or selected in CLIQ™ Manager Plus 

(see section 5.3).

Any locking permissions that a key of type E3 ( ) does have for an authorised cylinder is displayed in the 

function matrix using permission symbols:  (single electromechanical cylinder),  (double electromechanical 

cylinder) and  /  (double cylinder with an electromechanical side). 

Click the active  symbol in the toolbar to revoke locking permission to the inserted key of type E3 for an 

authorised cylinder. This symbol flashes and the key of type E3 is highlighted in blue in the list.

Next, double-click the corresponding permission symbol in the function matrix. Depending on the authorised 

cylinder, the revoked locking permission is displayed using one of the following permission symbols: , , 

or . To assign locking permission to an electromechanical side or to both sides of a double cylinder, double-

click the corresponding side(s) of the permission symbol: ,  or .

Note: If you select the key of type E3 by clicking the row instead of the  symbol, double-clicking 

the permission symbol will authorise the cylinder for the key of type E3 instead of revoking 

locking permission from the key of type E3 for this cylinder.

After changing the locking permission, the  symbol becomes active in the toolbar. Click this symbol to program 

the key of type E3 according to the new locking permissions (see Fig. 6.8/15). 

The “Type in the PIN” window opens where you can enter the PIN code of your programming key for the imported 

or selected lock system. Click the [OK] button to confirm your entry (see section 5.4).

A message window appears and prompts you to insert the selected key of type E3 into the correct port on your 

programming device. Click the [OK] buton to confirm and insert the key of type E3 into the correct port of your 

programming device (see section 5.3).

Fig. 6.8/17: Message window
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The programmed locking permissions for the key of type E3 are displayed in the “Programming temporary key” 

window. This window closes automatically as soon as the programming is complete. The  symbol is 

deactivated in the toolbar again.

Note: If you revoke locking permission from a key of type E3 for an unauthorised cylinder (such as ), 

a white permission symbol (such as ) is displayed in the function matrix after you program 

the key.

6.8.9 Additional Functions

Changing the column display

To change the way the columns are displayed, click the  symbol in the toolbar or choose the “Select columns 

to show” function in the “List” menu on the menu bar and then click the “Door/Cyl. List” or ”Key List” function. 

In the “Column List” window that opens, you can choose which columns to display in the locking chart (as 

described in section 5.5.1).

Displaying hidden keys

Note: Make sure to insert the programming key into the correct port on your programming device for 

the lock system that you have imported into CLIQ™ Manager or selected in CLIQ™ Manager Plus 

(see section 5.3).

Click the  symbol in the toolbar or choose the “Search for key inserted in PD” function in the “List” menu 

on the menu bar to highlight the electromechanical key that is currently inserted in the programming device.

Note: The “Search for cylinder connected to PD” function in the “List” menu on the menu bar is 

currently not available in the English version.
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6.9 System Information

This window displays data on the imported or selected lock system on the “Information” and “Notes” tabs. This 

information was created or imported when the lock system was imported (see section 6.2.1) or created in the in 

the “Create New System” window (see section 9.2.4). 

If the lock system you have imported or created is electromechanical, this is indicated by the  symbol. If you 

create a mechanical lock system (see section 9.2.4), the  symbol appears when you select the system.

Fig. 6.9/1: “System Information” window with “Information” tab

You can change some of the information on these tabs by simply selecting the entry and editing it or entering new 

information. Click the  symbol to insert an image of this lock system as described in section 5.5.3.

Note: You can import image files of “.jpg”, “.bmp”, “.wmf” and “.ico” format in the “System 

Information” window.

To delete the system map that you have imported into the “System Information” window, simply click the 

symbol.

When you select a mechanical lock system, the  symbol is displayed below the “Creation Date” display box 

on the right. Click this symbol to enter a new modification date in the “Date” window, as described in section 

6.3.2.2.

In the taskbar, click the “System Card” symbol to open the “System Card” 

window.
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Click the “Notes” tab to enter additional information about this lock system in the “System Information” window.

Fig. 6.9/2: “System Information” window with “Notes” tab

Click the [Cancel] button to close this window without applying any changes. Click the [OK] button to apply the 

settings.
Version:  P84 5 133 0106_ENP845133 00017 0EN 0A    04/18



Reports 6.10-1Manager
6.10 Reports

In this window, you can choose from various reports that the CLIQ™Manager or CLIQ™ Manager Plus program 

has created according to your requirements. You can create and print out these reports for the “Person reports”, 

“Key reports”, “Personnel access list” and “Cylinders access list” sections. Click the [Cancel] button to 

close this window without selecting a report.

Fig. 6.10/1: “Reports” window

Before the report is printed, the “Report Actions” window (see fig. 5.6/2) opens where you can change the printer 

settings (as described in section 5.6) and print out the report.

The top of the reports displays data on the imported or selected lock system under “System” and “Project”, and 

can also contain an image for the lock system. The “User” or “User Name” indicates the name of the user who 

has logged on to CLIQ™ Manager or CLIQ™ Manager Plus  program.

In the taskbar, click the “Reports” symbol to open the “Reports” window.
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6.10.1 Person Reports

Click the [Person reports] button to create a customisable personnel report containing various personnel data. 

The “Select Person Report” window opens where, depending on the options you have selected, you can design 

the report to meet your requirements. Click the [Cancel] button to close this window without creating a report.

Fig. 6.10/2: “Select Person Report” window

Click the  symbol for “All Persons” and the  symbol for “Persons with Keys” to open the “Range of 

persons” window where you can select the range of personnel (“From” and “To” selection box) to be printed from 

the “Personnel” window (see fig. 6.4/1).

Fig. 6.10/3: “Range of persons” window

Click the [Cancel] button to close this window without printing the report. Click the [OK] button to print the selected 

range. 
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Fig. 6.10/4: Personnel data printout, e.g., only persons with keys

The personnel data report contains a list of the selected persons and can also include an image. Depending on 

the selected options, each person is listed together with their keys or history, and the “Mark”, “Name”, “Alt. 

Mark” as well as the “Out Date” and “In Date”. The latter two fields indicate when the key was issued and 

returned, or if not yet returned, the planned return date.

6.10.2 Visitor Lists

In the “Select Person Report” window, click the  symbol for “Visitors”, to print out a report containing visitor 

data for the imported or selected lock system.

Fig. 6.10/5: Visitors list

The visitors list displays the visitor names together with “Name” and “Date Arriving”, “Time Arriving”, “Date 

Leaving” and “Time Leaving”. The latter two fields indicate the exact access period that was granted to the given 

user.
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6.10.3 Key Reports

Click the [Key reports] button to create out a customisable report containing the various key data. The “Select 

key report” window opens where you can choose from various reports. Click the [Cancel] button to close this 

window without selecting a report.

Fig. 6.10/6: “Select key report” window

Click the  symbol for “Key List” for options on which keys from your imported or created lock system to include 

in the report.

Fig. 6.10/7: Report, e.g., for all keys in lock system
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This report lists the keys together with their “Name”, “Mark”, “Alt. Mark”, “Missing” and “Key Type”. 

Depending on the selected options, each key can be listed together with its history and keyholders under  

“Employee Number” and “Keyholder”. The “Out Date”, “Out Time” fields together with the “In Date” and “In 

Time” indicate the date that the key was issued and returned, or if not yet returned, the planned return date.

6.10.4 Missing Keys

Click the  symbol for “Missing Key” to print out a report with the missing keys.

Fig. 6.10/8: Report with missing keys

6.10.5 Key Status

Click the  symbol for “Key status” to print out a list containing the number of keys currently issued and/or a 

list containing the number of keys that are currently available in your imported or selected lock system. 

Fig. 6.10/9: Key status report

This report lists the number of keys with the same properties under “Total” together with the “Pos”, “Name” and 

“Mark” data. The “Handed out” and “Remaining” fields indicate how many keys have been handed out and 

how many are remaining. Below the summation line, the totals are displayed.
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6.10.6 Key Reminders

Click the  symbol to open the “Print Reminders” window and create a report that lists the overdue keys.

Fig. 6.10/10: Key Reminders

This report contains a list of overdue keys together with the “Key Name” and “Mark” as well as the “In Date” 

and “In Time” . The latter two fields display the expired return date. The  or  symbols indicate the key type 

(electromechanical or mechanical). The “Person Name” field in the reminder list lists the personnel who are to 

receive reminders for their overdue keys (as described in 6.3.3).
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6.10.7 Personnel Access List

Click the [Personnel access list] button to create a report that lists the personnel who have access to the 

imported or selected lock system.

Fig. 6.10/11: Personnel access list

Below the personnel data, this report lists the keys and cylinders that this person can access using their keys. The 

 or  symbols indicate the key or cylinder type (electromechanical or mechanical).
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6.10.8 Cylinders Access List

Click the [Cylinders access list] button to create a report that lists the cylinders that can be accessed using the 

currently issued keys.

Fig. 6.10/12: Cylinders access list

This report lists the personnel with access to these cylinders together with the keys they can use. The  or 

symbols indicate the cylinder or key type (electromechanical or mechanical).
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7. Setup

Click the [Setup] button in the taskbar to display the symbols for this program area in the taskbar.

7.1 Taskbar

The “Setup” taskbar contains the following symbols. When you click one of these symbols, a window appears or 

opens where you can access the functions.

Note: With CLIQ™ Manager Plus program, the taskbar does not contain the  symbol.

Note: The  symbol only appears in the taskbar when you log on as a supervisor in the “Login” 

window (see section 3.2.1). 

Opens the “System Import” window (see section 6.2.1).

Displays the “Users” window (see section 7.2).

Opens the “Select Keybank Languages” window (see section 7.3).

Opens the “Company Data” window (see section 7.4).

Opens the “Config. Options” window (see section 7.5).

Opens the “Login” window (see section 7.6).
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7.2 Users

Note: You can only configure the users for the program when you log on as a supervisor.

The “Users“ window provides you with an overview of the users who have been set up by the supervisor. The user 

data is stored in corresponding tabs so that you have access to all of the information at a glance. Despite the 

potentially large number of users, it is easy to manage all of the data pertaining to your users.

Fig. 7.2/1: “Users“ window

You can perform the following tasks in the “Users“ window:

- Create users or user profiles

- Set up or change passwords for users

- Assign user privileges and subordinate programming keys to users

- Assign a user profile to a user

- Delete users or user profiles

In the taskbar, click the “Users” symbol to open the “Users” window.
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7.2.1 Menu bar

The menu bar in this window contains the following menus. When you click a menu name, the menu drops down 

to display its contents. Some of these functions are also available as symbols in the toolbar.

When you select a row by clicking it, right-clicking it opens a shortcut menu with various functions that you can 

select.

7.2.2 Viewing Information

In the “Users” window, the supervisor is displayed using the  symbol. The supervisor has privileges for using 

the various functions and can set up additional users for the program. These users are indicated by the  symbol 

and the user profiles are indicated by the  symbol. In effect, user profiles are templates for access permissions 

that users can receive. 

Click the  symbol to expand the list and display all of the users in a user profile. Click the  symbol to collapse 

the list again.

“System” menu

Backup (see section 6.2.3)

“List” menu

Select columns to show (see section 5.5.1)

Information Card (see section 7.2.2)

Exit, closes the “Users“ window

“Edit” menu

Autofill (see section 5.5.4)

Active/Inactive (see section 7.2.2.2)

Clone user (see section 7.2.3.1)

Create (see section 7.2.3.1)

Create user profile

Create user

Create user for this 

profile

Delete (see section 7.2.5)

“Help” menu

Help screen (see section 5.2.1)

Additional help (see section 5.2.1)

About ...(see section 5.2.2)
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To view the data for a supervisor or for a certain user or user profile, click the corresponding row in the list. Click 

the  symbol in the toolbar or choose the “Information Card” function in the “List” menu on the menu bar. 

Alternatively, you can double or triple-click the row to open it.

Depending on your selection, the “User Card” window (see section 7.2.2.1 and section 7.2.2.2) opens for a 

supervisor or user and the “Profile Card” (see section  7.2.2.3) opens for a user profile. In following, we describe 

these tab windows using just one window. The information described there also applies to the corresponding tabs 

in the other window.

Click the [Cancel] button to close the window without applying the changes. Click the [OK] button to apply the 

settings.

7.2.2.1 Displaying Supervisor Data

When you select a supervisor, the “User Card” window opens to the “General Information” tab.

Fig. 7.2/2: “User Card” window with “General Information” tab

This tab displays the data that has been registered for the supervisor in the lock system. The  symbol next to 

the “Type” display box indicates that the data is for a supervisor. You can change or edit the entries in the 

“Name”, “Password” and “Notes” input boxes by simply selecting the contents and overwriting them or making 

an entry.
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7.2.2.2 Displaying User Data

When you select a user, the “User Card” window opens to the “General Information” tab.

Fig. 7.2/3: “User Card” window with “General Information” tab

The  symbol next to the “Type” display box indicates that the data is for a subordinate user. You can change 

or edit the entries in the input boxes by simply selecting the contents and overwriting them or making an entry. 

Additional data is also displayed for the selected user in this tab. If this user was registered when the program, 

click the  symbol next to “Logged In” to release the user again. The “Active” option box indicates the current 

user status that you can change by clicking. 

To change a user's status, select the row containing the user in the “Users” window and click the  symbol in 

the toolbar or choose the “Active/ Inactive” function in the “Edit” menu  on the menu bar.

Click the  symbol next to the “Profile” display box to assign this user to a user profile as described in section 

7.2.4. If this user was already assigned to a user profile, the  and  symbols are displayed next to the 

“Profile” display box. 

Click the  symbol to remove a user from a user profile and click the  symbol to open the “Profile Card” 

window (see fig. 7.2/4), where you can view data on the user profile. Click the [Cancel] button in the window to 

display data on the selected user in the “User Card” window.
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7.2.2.3 Displaying User Profile Data

When you select a user profile, the “Profile Card” window opens to the “General Information” tab.

Fig. 7.2/4: “Profile Card” window with “General Information” tab

This tab displays the data that has been registered for the user profile in the lock system. The  symbol next to 

the “Type” display box indicates that the data is for a user profile. You can change or edit the entries in the input 

boxes by simply selecting the contents and overwriting them or making an entry.

In these tabs, click the  symbol to insert a photo for the user or an image for the user profile. In the “Open” 

window (see fig. 5.5/3) that opens, you can select the image (as described in section 5.5.3). 

Note: You can import image files of “.bmp” format in the “User Card” or “Profile Card” windows. 

After you add a photo for the user or an image for the use profile to the “User Card” or “Profile Card” window, you 

can delete it by simply clicking the now active  symbol.
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7.2.2.4 Displaying User Privileges

When you select a user or user profile in the “User Card” or “Profile Card” window, click the “Access” tab to view 

their user privileges for the various functions.

Fig. 7.2/5: “Profile Card” window with “Access” tab

The “User privileges list” on this tab displays the program areas together with the functions that are available 

there. The  or  symbol indicates whether the user or user profile has been granted with permission to access 

the given functions. 

Click the  symbol to expand the list and display all of the program areas and the functions that are available 

there. Click this symbol again to collapse the list.
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7.2.2.5 Displaying Programming Keys

When you select a supervisor or user in the “User Card” window, click the “C-Key list” tab to list all of this person's 

programming keys for the imported or selected key system. 

Fig. 7.2/6: “User Card” window with “C-Key list” tab

In this list, the programming keys are displayed with “Pos”, “System”, “Name”, “Mark” and “C-Key type”. 

Using these programming keys, you can program the current locking permissions into the cylinders of the 

corresponding lock system, for example.

7.2.3 Adding Users or User Profiles

7.2.3.1 Creating Users or User Profiles

Click the  symbol in the toolbar or choose the “Create” function in  the “Edit” menu on the menu bar and then 

click “Create user” or “Create user profile” function to create a new user or user profile. 

To create a user with a specific user profile, first select the user profile by clicking the corresponding row in the list. 

Click the  symbol in the toolbar or choose the “Create” function in the “Edit” menu on the menu bar and then 

click the “Create user for this profile” function.

To create a user with the same properties as an already existing user, select the corresponding user in the list. 

Click the  symbol in the toolbar or choose the “Clone user” function in the “Edit” menu  on the menu bar. An 

empty row is added for this user or user profile to the end of the list or below the corresponding user profile.

Select the new user or user profile in the list and click the  symbol in the toolbar or choose the “Information 

Card” function in the “List” menu on the menu bar. Alternatively, you can double or triple-click the row to open it. 

Depending on the selected item, the “User Card” or “Profile Card” window opens where you have to enter the 

required data.
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Instead of editing the data in the “User Card” or “Profile Card” window, you can also enter the information directly 

in the list by clicking an input field in a column and entering the information there. When you click an editable 

column field, the background colour changes to yellow and is marked with a black border.

7.2.3.2 Setting Up or Changing a Password

The “General Information” tab of the “User Card” window (see fig. 7.2/2 and fig. 7.2/3), you can enter or change 

the password for the supervisor or selected user in the “Password” input box.

When starting the program, this user must enter their given password in the “Login” window before the program 

will open (see section 3.2). 

Note: If no password has been set up for a given supervisor or user, this person will be able to start 

the program without entering a password.

7.2.3.3 Assigning User Privileges

In the “User Card” window (see fig. 7.2/3) or “Profile Card” (see fig. 7.2/4), click the “User privileges list” tab to 

grant user privileges for the program functions to the selected user or user profile.

The “User privileges list” on this tab displays the program areas together with the functions that are available 

there. Click the  smbol to expand the list and display all of the program areas and the functions that are available 

there. Click this symbol again to collapse the list.

Click the corresponding  symbols to grant privilege to the user or user profile for this function. The selected 

functions are marked by the  symbol and you can deselect these by clicking the option box again. To grant 

privilege for all functions in the program or for all functions in a program area, select the “User privileges list” 

option globally or just in the required area.
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7.2.4 Assigning Users to a User Profile

In the “Users” window, select the user in the list to whom you wish you assign a user profile. Click the  symbol 

in the toolbar or choose the “Information Card” function in the “List” menu on the menu bar. Alternatively, you 

can double or triple-click the row to open it.

The “User Card” window (see fig. 7.2/3) opens to the “General Information” tab. Click the  symbol next to the 

“Profile” display box here. The “Select profile” window opens containing any previously user profiles.

Fig. 7.2/7: “Select user profile” window

Click the [Cancel] button to close this window without applying the user profile in the “User Card” window. Select 

the row containing the user profile and confirm by clicking the [OK] button or double-click the line. In the “User 

Card” window, the selected user profile is displayed in the “Profile” display boxes together with its ID and name.

7.2.5 Deleting Users and User Profiles

Note: It is not possible to delete the data from a supervisor.

In the “Users” window, select the user or user profile from the list whose data is to be deleted. Click the  symbol 

in the toolbar or choose the “Delete” function in the “Edit” menu on the menu bar. In the security query that 

appears, click the [Yes] button to continue. Click the [No] button to close the security query without deleting the 

data for the selected user or user profile.
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Fig. 7.2/8: Security query

When you delete a user profile to which users have been assigned, a security query appears. Click the [Yes] 

button to delete the user profile and the assigned users. If you click the [No] button, the user profile will be deleted 

but not the assigned users.

Fig. 7.2/9: Security query

7.2.6 Additional Functions

Changing the column display

To change the way the columns are displayed, click the  symbol in the toolbar or choose the “Select columns 

to show” function in the “List” menu  on the menu bar. In the “Column List” window that opens, you can select 

the columns (as described in section 5.5.1).

Using “Autofill”

When changing the settings for new rows, you can also automate this procedure. Click an input field in the column 

that you wish to autofill with information across the rows. When you click an editable column field, the background 

colour changes to yellow and is marked with a black border. Click the  symbol in the toolbar or choose the 

“Autofill” function in tthe “Edit” menu  on the menu bar. In the “User Name” window that opens, enter the settings 

for the desired entries as described in section 5.5.4.
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7.3 Languages

In this window, you can set the display language for the program. 

Fig. 7.3/1: “Select Keybank Languages“ window

Click a language to select it and confirm your selection by clicking the [OK] button. The program appears in the 

selected language. Click the [Cancel] button to close this window without changing the display language for the 

program.

In the taskbar, click the “Languages“ symbol to open the “Select Keybank 

Languages“ window.
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7.4 Company Data

This window lists the company data that was entered during the installation (see section 3.1.2). This data is 

displayed in the report headers that the program generates according to your requirements (see section 6.10).

Fig. 7.4/1: “Company Data“ window

After logging on as a supervisor in the “Login“ window (see section 3.1.3), you can enter, edit or add to this data. 

Select the entry to be changed and overwrite it or enter a new entry in the input boxes provided. Click the arrows 

next to the “Opening time“ and “Closing time“ selection boxes to set the opening times for your company.

Click the  symbol to insert you company's logo. In the “Open“ window that opens, select the required image 

(as described in section 5.5.3). 

Hinweis: You can insert files of “.jpg“, “.bmp“, “.wmf“ and “.ico“ format as a logo in the “Company 

Data“ window.

To delete your company's logo from the “Company Data“ window, simply click the  symbol. This ymbol is only 

active after you insert a logo. Click the [Cancel] button to close the “Company Data“ window without applying any 

changes. Click the [OK] button to apply the settings.

In the taskbar, click the “Company Data“ symbol to open the “Company Data“ 

window. 
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7.5 Config. Options

In this window, you can change various settings in the tabs to configure the program according to your 

requirements.

Click the [Cancel] button to close the “Config. Options“ window without applying any changes. Click the [OK] 

button to apply the settings.

7.5.1 Selecting a Database

Under “Working Database” of the “Database” tab, you can configure whether other users are permitted to 

access your program's database or whether you are permitted to access an external program's database. The 

display box below displays the target path of your program as it was defined during the installation (see section 

2.1.3). Your program's database is stored in the “Data“ folder that is located in this target folder.

Fig. 7.5/1: “Config. Options“ window with “Database“ tab

Note: If multiple users are to access the database in CLIQ™ Manager or CLIQ™ Manager Plus program, 

a network drive has to be selected as the target path during the installation. If a network drive 

was not selected as the target path, it will not be possible for other users to access this database.

In the taskbar, click the “Config. Options” symbol to open the “Config. Options” 

window.
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Selecting an Internal Database

Select the “Allow this  database to be server“ option to share your program's database with other users. Click 

the [Installation Info] button to enter a name and any remarks concerning the installation in the “Installation 

Information“ window.

Fig. 7.5/2: “Installation Info“ window

Selecting an External Database

Select the “Remote Database” option to access a database from a different program. In the message window 

that appears, click the [Yes] button to confirm that you want to switch to the external database. Click the [No] 

button to close this window without switching to the external database.

Fig. 7.5/3: Message window

After switching, the “Database” tab changes appearance and you have to change the target path for the database 

in the other CLIQ™ Manager or CLIQ™ Manager Plus program. You can select the target path by clicking the 

symbol or enter it by clicking the  symbol in the “Remote database connection“ window.

Note: Your system administrator can provide you with the target path of the database in the other 

CLIQ™ Manager or CLIQ™ Manager Plus program.
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Fig. 7.5/4: “Config. Options“ window with “Database“ tab

Click the  symbol next to the “Remote Database Location“ selection box to select the target folder for the 

external database in the “Browse For Folder“ window. Select the “Data“ folder of the external database and click 

the [OK] button to apply the target path of the external database to the corresponding display box on the 

“Database“ tab. Click the [Cancel] button to close this window without applying the target path.

Fig. 7.5/5: “Browse For Folder“
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Click the  symbol next to the “ Remote Database Location“ display box to open the “Remote database 

connection“ window. In this window, enter the IP address of the network drive that was selected for the other 

CLIQ™ Manager or CLIQ™ Manager Plus program during the installation.

Note: Your system administrator can provide you with the IP address of the network drive where the 

other CLIQ™ Manager or CLIQ™ Manager Plus program was installed.

Fig. 7.5/6: “Remote Database Connection“ window

Click the [OK] button to apply the entered IP address in the corresponding display box of the “Database” tab. 

Click the [Cancel] button to close this window without applying the IP address.
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7.5.2 Adjusting the Display Options

Click the “View Options” tab in the “Config. Options” window to adjust the display settings for the current window.

Fig. 7.5/7: “Config. Options“ window with “View Options“ tab

View photo and signature

You can activate or deactivate the current photo and signature for the selected person by clicking the “View photo 

and signature“ option in the “Daily Work“ window.

Import personnel data from ASCII files

Using the option boxes below “Import personnel data from ASCII file”, you can define whether to automatically 

overwrite any existing data for a personnel number when importing personnel data as a text file (ASCII) or to 

require that this action is confirmed.

Restore to the predefined columns for the lists

Click the [Restore] button below “Lists” to reset the column size and the number of columns in the current 

window to the default values.

Activate functions for temporary keys

Select the “Activate functions for temporary keys” (keys of type E3) option to display the symbols for the key 

of type E3 in the toolbar of the “Lock Chart” window. Using these symbols, you can directly program the locking 

permissions for keys of type E3 using the programming key.
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Type of locking permissions to display

According to the requirements for your lock system, IKON can supply you with mechanical and electromechanical 

keys with various mechanical locking permissions. In this way, these keys can only open those mechanical 

cylinders for which they have mechanical locking permission. To open electromechanical cylinders, you have to 

assign electromechanical locking permissions to these electromechanical keys in addition to the mechanical 

locking permissions. In contrast to electromechanical keys, mechanical keys can only open mechanical cylinders. 

By selecting “Mechanical accesses“ option (selected by default), only those mechanical and electromechanical 

cylinders will be displayed for which the selected key has mechanical permission, regardless of any 

electromechanical permissions that have been assigned.

To display the electromechanical cylinders that the selected electromechanical key is permitted to access on an 

electromechanical basis in addition to the mechanical locking permission, select the “Electronical accesses“ 

option.

Select “All accesses“ option to display those mechanical and electromechanical cylinders for which the selected 

key has either mechanical or electromechanical permission.
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7.5.3 Formatting Time and Date

Click the “Date/Time“ tab in the “Config. Options“ window to adjust the time and date settings in the program.

Fig. 7.5/8: “Config. Options“ window with “Date/Time“ tab

Depending on the option you select under “Hours Format“, the hours of the day are displayed using either the 

12-hour or 24-hour clock.

The “Date Format“ selection box allows you to set the date format. “DD“ specifies the date, “MM“ the month and 

“YYYY“ the year. In the “First week day” selection box, choose the day that is to be used as the first day of the 

week.
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7.5.4 Converting the 16-bit Manager

To convert the 16-bit version (16-bit Manager), the following requirements are necessary:

- One 16-bit Manager on the drive of your Windows computer

- Corresponding SSD file with lock system data and

- main programming key for lock system of 16-bit Manager

If the 16-bit Manager is no longer located on the hard drive of your Windows computer, you have to perform the 

following steps:

- Save the 16-bit Manager on the hard drive of your Windows computer

- Unset the write-protection for the 16-bit Manager and, if necessary

- Import the lock system data into the 16-bit Manager

Close the “Config. Options“ window by clicking the [Cancel] button and click the  symbol in the header to 

minimise the program to the taskbar of your Windows computer. Save the 16-bit Manager on the hard drive of your 

Windows computer as described below.

Saving the 16-bit manager to the hard drive

Proceed as follows to save the 16-bit Manager on the hard drive of your Windows computer:

- Insert the medium with the 16-bit Manager into the appropriate drive on your Windows computer.

- Create a new folder (directory) on your Windows computer with the name “IKON” and store the “16bit-

Manager” in this folder.

- Change the file names for the “16bit-Manager” folder to “16bit”, for example

Note: You cannot enter more than 8 characters for these folder names.

Fig. 7.5/9: Folder named “16bit“ on hard drive
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After saving the 16-bit Manager on the hard drive, you have to deactivate the write protection for the 16-bit 

Manager as described below. 

Deactivating write protection for 16-bit Manager

Proceed as follows to deactivate write protection for the 16-bit Manager:

- Right-click the folder (e.g., “16bit”) and choose “Properties” from the shortcut menu

Fig. 7.5/10: Shortcut menu

- The “16bit Properties” window opens to the “General” tab.

- In this tab, clear the “Read-only” option under “Attributes”

- Click the [Apply] button to deactivate write protection.

Fig. 7.5/11: “16bit Properties“ window
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- In the “Confirm Attribute Changes“ window that opens, select the last option by clicking it

Fig. 7.5/12: “Confirm Attribute Changes“ window

- Click the [OK] button to confirm your selection and close the window again

- Click the [OK] button in the “16bit Properties“ window to deactivate write protection and close the window

again.

- Click [Cancel] button in both windows to close them without deactivating the write protection.

After you deactivate write protection, click the  button in the status bar so that the program 

window of the 32-bit Manager appears again. Open the “Config. Options“ window again by clicking the  symbol 

and convert the 16-bit Manager as described below.
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Converting the 16-bit Manager and importing the lock system data

Click the “Import old files“ tab in the “Config. Options“ window to convert the 16-bit Manager and import its lock 

system data.

Fig. 7.5/13: “Config. Options“ window with “Import old files“ tab

Click the [Start search] button to search for the 16-bit Manager on your Windows computer. Click the [Stop 

search] button to abort the search and any 16-bit Managers that have been found will be displayed in the lower 

display box of the window.

Select the 16-bit Manager to be converted in the list and click the [Import old files] button. In the message window 

that appears, click the [Yes] button to confirm the conversion. Click the [No] button to close this window without 

converting the 16-bit Manager.

Fig. 7.5/14: Message window
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The 16-bit Manager conversion process is displayed in the “Convert CSW files from 16 bit to 32 bit“ window. Once 

the conversion process is complete, this window closes automatically and the “List of CWS 16 bit systems“ window 

opens. This window provides you with a clear overview of all lock systems that have been created using the 

16-bit Manager.

Fig. 7.5/15: “List of CWS 16 bit systems“ window

Click the [Cancel] button to close this window without converting lock system data of the 16-bit Manager. Select 

the lock system in the list whose data is to be converted and click the [OK] button. The conversion process for the 

lock system data is displayed in the “Convert CSW files from 16 bit to 32 bit“ window. This window closes 

automatically after the conversion process. 

A message window appears and informs you that you still have to select the SSD file for this lock system. Click 

the [OK] button in the message window and open the “Open“ window.

Fig. 7.5/16: Message window

In the “Open“ window that appears, choose the folder from the “Look in“ selection box and select the required 

SSD file in the display box below. The file name of the selected SSD file is entered into the “File name“ input box. 

Click the [Open] button or double-click the SSD file to import the lock system data for this file.
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Fig. 7.5/17: “Open“ window

The import progress for the lock system data is indicated in the “System Import“ window. Once the import is 

complete, the “System Import“ and “Config. Options“ windows close automatically and the data is applied in the 

program. The “System List“ window lists the lock system data for the imported SSD file and displays it according 

to the columns you have selected for display.

If there is no SSD file on your Windows computer, click the [Cancel] button first in the “Open“ window and then in 

the “List of CWS 16 bit systems“ to close these windows again. Insert the medium containing the SSD file for the 

16-bit Manager being converted into the appropriate drive on your Windows computer. Convert the 16-bit Manager

again and import the lock system data as described.

Note: You can import the lock system data for an SSD file that you have created using the 16-bit 

Manager and for which you possess the main programming key. If the SSD file is missing, please 

contact the IKON customer service.

If the message window appears while converting the 16-bit Manager, you have to to deactivate write protection 

for the 16-bit Manager.

Fig. 7.5/18: Message window
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7.5.5 Configuring the Door Plan Symbols

The “Door Plan” window displays the access and locking permissions using various door symbols that change 

appearance depending on the currently selected person or key (see section 6.7.3). Click the “Door Plan” tab in 

the “Config. Options“ window to change the way these door symbols indicate the access and locking permissions.

Fig. 7.5/19: “Config. Options“ window with “Door Plan“ tab

Using the “Choose selection mark“ selection box, choose the display mode and adjust the animation speed 

using the  “Animation speed“ slider. The “Example“ display box displays a preview of how the settings will 

appear.

Select the “Show explanation about door marks in Door Plan“ option to display pop-up messages containing 

explanations on the door symbols in the door plan. These pop-up messages are displayed when you move the 

mouse pointer across a door symbol.
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7.5.6 Creating Standard Text for Messages

Click the “Reports“ tab in the “Config. Options“ window to create standard message texts on the various tabs in 

this tabbed dialog.

Fig. 7.5/20: “Config. Options” window with “Reports” tab

You can create a standard text message for confirming issued and returned keys, for reminders to users with 

overdue keys as well as for notifications of changes. The input fields in these tabs are highlighted in green and 

display the most recently changed entries. If required, overwrite these entries with a new standard text that serves 

as a comment in message listings.

Click the [Restore default values] button to reset the various input fields of the currently selected message to 

their default values.
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7.5.7 Refreshing the System Data

If you have already updated the data in your eletromechanical lock system as described in 6.2.2 for CLIQ™  

Manager program or in section 9.2.3 for CLIQ™ Manager Plus program, you also have to refresh the system 

data. Click the “Reindexing“ tab in the “Config. Options“ window to refresh the system data.

Note: You also have to refresh the system data after making numerous changes to the locking 

permissions in the program.

Select the “Reindexing key-, cyl- and person relations“ option and click the [Start reindexing] button.

Fig. 7.5/21: “Config. Options“ window with “Reindexing“ tab

A security query appears and prompts you to confirm the action. Click the [Yes] button to refresh the system data 

for the lock system imported into the CLIQ™ Manager program or selected in the CLIQ™ Manager Plus program. 

Click the [No] button to close the security query without refreshing the system data.

Fig. 7.5/22: Security query

Another security query appears. This message informs you that the lock system has to be closed before 

refreshing. Click the [Yes] botton in this security query to close the lock system so that the system data can be 

refreshed. Click the [No] button to close the security query without refreshing the system data.
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Fig. 7.5/23: Security query

Once your system data has been refreshed, a message window appears. Confirm this message by clicking the 

button [OK].

Fig. 7.5/24: Message window
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7.6 Changing Users

In this “Login“ window, you can log in as the next user to operate the program. The supervisor is automatically 

logged in under their given name (e.g., “John Doe“), unless they choose a different user name as described in 

section 7.6.1.

Fig. 7.6/1: “Login“ window

As described in section 7.6.1, choose your user name in the “Select user“ window to log in as the next user. Enter 

your password in the “Password“ input box of the “Login“ window and click the [OK] button. Click the [Cancel] 

button to close the window without logging in as the next user. The previously logged in user is active again.

If you enter an incorrect password, a message window appears. Confirm this message by clicking the [OK] button.

Fig. 7.6/2: Message window

Note: The program ends automatically if you enter the password incorrectly three times successively.

In the taskbar, click the “Change user”symbol to open the “Login” window.
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7.6.1 Choosing Users 

Click the  symbol in the “Login“ window to open the “Select User“ window. This window lists the users that have 

been configured by the supervisor (see section 7.2). If no user is selected here, the supervisor is activated 

automatically in the “Login“ window. 

Fig. 7.6/3: “Select user“ window

Click the corresponding row to select your user name and confirm by clicking the [OK] button or double-click the 

row containing your name. Click the [Cancel] button to close the “Select user“ window without applying your user 

name in the “Login“ window. 

In the “Login“ window, your user name is displayed in the “Name“ input box and you have to enter your password 

into the “Password“ input box. Click the [OK] button to restart the program under your user name.

Fig. 7.6/4: “Login“ window
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7.6.2 Releasing Users

If were already logged on before the program crashed, the following message window will appear when you click 

the [OK] button in the “Login“ window.

Fig. 7.6/5: Message window

Click the [OK] button to confirm the message window and click the activated  smbol in the “Login“ window (see 

fig. 7.6/4). 

In the “Release user“ window that appears, enter your password, if required, into the “Password“ input box.

Fig. 7.6/6: “Release user“ window

If you click the [Cancel] button to close this window, you will not be released as the next user of the program. Click 

the [OK] button to release your user name in the program.

Note: For supervisors, only the supervisor can release their own user name after a program crash. 

The program restarts and the corresponding program window appears. CLIQ™ Manager program opens the 

imported electromagnetic lock system automatically. Since CLIQ™ Manager Plus program does not, you first have 

to open a lock system (as described in 9.2.5) before you can use any of the functions in this program. 

If you have not selected a lock system, the following message window appears after you click a function.
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Fig. 7.6/7: Message window

Click the [OK] button to confirm the message window and select a lock system in the CLIQ™ Manager Plus 

program.
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8. Elec. Setup

Click the [Elec. Setup] button in the taskbar to display the symbols for this program area in the taskbar.

8.1 Taskbar

The “Elec. Setup“ taskbar contains the following symbols. When you click one of these symbols, a new window 

opens where you can access the functions of this program area.

Note: You can only open the “Programming key“ window after logging on as a supervisor in the 

“Login“ window (see section 3.1.3). If you are logged in as a user, clicking the  symbol will 

open a message window. Confirm this message by clicking the [OK] button.

Fig. 8.1/1: Message window

Displays the “C-Key list“ window (see section 8.2).

Opens the “Change PIN code“ window (see section 8.3).

Opens the “Select PD port“ window (see section  8.4).

Opens the “Programming device options“ window (see section 8.5).
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8.2 Programming Key (C-Key)

Note: Make sure to insert the main programming key into the correct port on your programming device 

for the lock system that you have imported into CLIQ™ Manager or selected in CLIQ™ Manager 

Plus (see section 5.3).

If you log in to the program as a supervisor (see section 3.1.3), this window will provide you with an overview of 

the programming keys that were imported with the data from the electromechanical lock system (see section 

6.2.1). The main programming key must be in the possession of the supervisor who is authorised to add new users 

to the program (see section 7.2.3). These users can receive subordinate programming keys with various 

programming privileges for programming locking permissions into the cylinders.

Fig. 8.2/1: “C-Key list“ window

You can perform the following tasks in the “C-Key list“ window:

- View data for the main and subordinate programming keys

- View programming privileges for the programming keys

- Assign/revoke programming privileges to/from a subordinate programming key

- Assign subordinate programming keys to a user

- Register a subordinate programming key as ‘missing’

In the taskbar, click the “C-Key list“ symbol to display the “C-Key list“ window.
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8.2.1 Viewing Information

The “C-Key list“ window displays the main programming key in the “C-Key type“ column as “C-Keys 

CurrentMaster“. Using this programming key, the locking permissions can be programmed for all cylinders. The 

subordinate programming keys are displayed as “C-Keys Normal“ and can be assigned to users by the 

supervisor. This allows these users to program locking permissions for which they have programming privileges 

into the corresponding cylinders.

To view the data from a programming key, first select the row in the list that contains the key. Click the  symbol 

in the toolbar or double-click the corresponding row to open the “C-Key Card“ window. 

8.2.1.1 Displaying Data for Main Programming Key

When you select a main programming key, the “C-Key Card“ window opens to the “General Information“ tab.

Fig. 8.2/2: “C-Key Card“ window for main programming key

This tab displays the data that has been registered for the main programming key in the lock system.

The “C-Key type“ display box indicates that the data is for a main programming key. Click the  symbol to 

display the PUK code in “PUK Code“ display box without encryption.

In contrast to the subordinate programming keys, the main programming key cannot be assigned to any given 

user. The main programming key cannot be registered as ‘missing’.
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Note: If the main programming key is lost, inform your system partner immediately and request a 

replacement for this key.

8.2.1.2 Displaying Data for Subordinate Programming Key

When you select a subordinate programming key, the “C-Key Card“ window opens to the “General Information“ 

tab.

Fig. 8.2/3: “C-Key Card“ window for a subordinate programming key

This tab displays the data that has been registered for the subordinate programming key in the lock system. The 

“C-Key type“ display box indicates that the data is for a subordinate programming key. Click the  symbol to 

display the PUK code in “PUK Code“  display box without encryption.

In the “User Assigned“ display box, you can also view which user has been assigned with this subordinate 

programming key. To assign this key to another user, click the  symbol. In the “Select User“ window (see fig. 

8.2/12) that opens, you can assign the programming key to another user (as described in section 8.2.3).
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8.2.1.3 Displaying Electromechanical Information

To view electromechanical information for a programming key, click the “Electronic Information“ tab in the “C-

Key Card“ window.

Fig. 8.2/4: “C-Key Card“ window with “Electronic information“ tab

Click the  symbol to view electromechanical information from the manufacturer (see section 8.2.1.4) and click 

the  symbol to display article information from the manufacturer (see section 8.2.1.5) for the selected 

programming key.

Note: To display the electromechanical information for a subordinate programming key, you first have 

to change the assignment of this programming key. As described in section 8.2.3, assign this 

subordinate programming key to the supervisor again.
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8.2.1.4 Displaying Manufacturer's Information

Note: Make sure to insert the main or subordinate programming key into the correct port on your 

programming device for the lock system that you have imported into CLIQ™ Manager or selected 

in CLIQ™ Manager Plus (see section 5.3).

To display the manufacturer's electromechanical information for the selected programming key, click the 

symbol in the “Electronic information“ tab. A message window appears and prompts you to insert the selected 

programming key into the correct programming port on your programming device. Click the [OK] button to confirm 

and insert the key into the correct port on your programming device (see section 5.3).

Fig. 8.2/5: Message window

The “Electronic. Information“ window opens to the “Lists“ tab. In the top section of the window, you can view 

general information on the programming key as well as the name of the imported or selected lock system. The first 

tab in the lower section of this window provides you with a general overview of the manufacturer's 

electromechanical information for this programming key.

Fig. 8.2/6: “Electronic Information“ window with “Lists tab
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The “Task List“ tab is only displayed when the programming key still has outstanding tasks. If, for instance, a 

change to the locking permissions has still not been confirmed in the “Lock Chart“ window (see section 6.8.4.4), 

this tab provides you with a clear overview of all such outstanding tasks.

Click the “Task List“ tab to display the outstanding tasks.

Fig. 8.2/7: “Electronic Information“ window with “Task List“ tab

Click the [Close] button to close the window again.
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8.2.1.5 Displaying Manufacturer's Article Informatio

To display the manufacturer's article information for the selected programming key, click the  symbol in the 

“Electronic. Information“ tab. The “Product information“ window opens where you can view article information 

for the selected key.

Fig. 8.2/8: “Product information” window

Note: We do not advise changing any of this information.

Click the [Change PIN Code] button to change the PIN code for the selected programming key. In the “Change 

PIN“ window (see fig. 8.3/1) that opens, you can change the PIN code as described in section 8.3. Click the 

[Cancel] button to close the window again.
Version:  P84 5 133 0106_ENP845133 00017 0EN 0A    04/18



8.2-8 Programming Key (C-Key) Manager
8.2.2 Changing Programming Privileges for a Programming Key

Click the  symbol in the toolbar to change the programming privileges of the subordinate programming key for 

programming locking permissions into cylinders. The “C-Key list“ window changes appearance and the “C-Key 

Programming“ window appears. Click the  symbol in the toolbar to return to the other display mode.

Fig. 8.2/9: “C-Keys Programming“ window with display of programming privileges

Here, all of the programming keys and cylinders are listed for the imported or selected lock system. These lists 

are shown next to and above the matrix located in the lower section of this display area. The top section of this 

window displays the selected programming key or cylinder and the numbers that have been assigned to them. 

Click the  symbol in the toolbar to switch positions of the lists.

If doors have been assigned to the cylinders (see section 6.6.2), the doors are displayed together with the 

cylinders. Click the  symbols to expand the lists and display all of the cylinders for these doors. Click the 

symbols to collapse the lists again. 

The cylinder types are indicated by corresponding symbols: The  or  symbols represent electromechanical or 

mechanical cylinders and the  or  symbols represent double cylinders with electromechanical and 

mechanical sides or electromechanical double cylinders.
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To view the data for a certain cylinder, door or for a specific programming key, double-click the row containing the 

item that you wish to display. Depending on the selected item, the “Cylinder Card“ window (see section 6.6.4) 

opens for a cylinder, “Door Card“ window (see section 6.6.3) opens for a door, and “C-Key Card“ window (see 

section 8.2.1) opens for a programming key.

Click the  symbol in the toolbar to drop down a menu where you can choose a zoom factor for the window 

display. Click the “Other Zoom” function in the drop-down menu to enter a custom zoom value. In the “Zoom“ 

window that opens, you can enter a custom zoom value into the select box. Click the  symbol to select a 

different zoom factor in the drop-down selection box.

Fig. 8.2/10: “Zoom” window

Click the [Cancel] button to close this window without applying the entered or selected zoom factor for the display. 

Click the [OK] button to apply the zoom factor. 

8.2.2.1 Assigning Programming Privileges

The programming privileges of a programming key are displayed in the matrix using various symbols for the given 

cylinder. This provides you with a means for quickly and easily viewing all of the programming privileges of the 

programming key at a glance and also allows you to change the privileges for the subordinate programming keys 

(see fig. 8.2/9).

Note: The programming privileges of the main programming key are displayed in the matrix using 

bright blue symbols and cannot be changed.

The programming privileges for a subordinate programming key are revoked automatically when the programming 

key is registered as ‘missing’. The corresponding symbols are displayed in red for this programming key.

Any authorisation that a subordinate programming key does not have for the given cylinder is displayed in the 

matrix using the following symbols:  (single electromechanical cylinder),  (double electromechanical 

cylinder) and  /  (double cylinder with an electromechanical side).
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To assign programming privileges for certain cylinders to a subordinate programming key, first click the  symbol 

to expand the list of doors up to the cylinders. Next, double-click the corresponding symbol in the matrix. 

Depending on the given cylinder, the assigned programming privileges are displayed using one of the following 

symbols: , ,  or . To assign programming privileges for both sides of a double electromechanical 

cylinder, double-click the corresponding side(s) of the symbol: ,  or .

8.2.2.2 Revoking Programming Privileges

Any existing programming privileges for a subordinate programming key are displayed in the matrix using the 

following symbols:  (single electromechanical cylinder),  (double electromechanical cylinder) and  / 

(double cylinder with an electromechanical side).

To revoke programming privileges for certain cylinders from a subordinate programming key, first click the  

symbbl to expand the list of doors up to the cylinders. Next, double-click the corresponding symbol in the matrix. 

Depending on the given cylinder, the revoked programming privileges are displayed using one of the following 

symbols: , ,  or . To revoke programming privileges for both sides of a double electromechanical 

cylinder, double-click the corresponding side(s) of the symbol: ,  or .

In the “Lock Chart“ window, any missing programming privileges for the subordinate programming key are 

displayed using the  symbol.

Fig. 8.2/11: “Lock Chart“ window
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8.2.3 Assigning a Programming Key to a User

In the “C-Key list“ window, select the subordinate key in the list to whom you wish to assign a user. Click the 

symbol in the toolbar or double-click the row in the list.

The “C-Key Card“ window opens to the “General Information“ tab (see fig. 8.2/3). Click the  symbol next to 

the “User Assigned“ display box here. The “Select user“ window opens and lists the users that have been 

previously created in the program.

Fig. 8.2/12: “Select User“ window

Click the [Cancel] button to close this window without assigning the selected subordinate key to a user. Select the 

user in the list to whom you wish to assign this programming key. Confirm your selection by clicking the [OK] 

button or double-click the corresponding row in the list. The “C-Key list“ window displays the selected user in the 

“User Assigned“ display box.

Click the [Cancel] button to close the “C-Key Card“ window without assigning the subordinate programming key. 

Click the [OK] button to assign the key.
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8.2.4 Registering a Programming Key as ‘Missing’

In the “C-Key list“ window, select the subordinate programming key in the list that is to be registered as ‘missing’. 

Click the  symbbol in the toolbar or double-click the row in the list.

The “C-Key Card“ window opens to the “General Information“ tab (see fig. 8.2/3). Click the  symbol next to 

the “State“ display box here. In the security query that appears, click the [Yes] button to register the subordinate 

programming key as ‘missing’. Click the [No] button to close the security query and return to the “C-Key list“ 

window.

Fig. 8.2/13: Security query

A subordinate programming key registered as ‘missing’ loses all privileges for executing functions on the cylinders. 

If this subordinate programming key is ever lost, inform your system partner immediately and request a 

replacement for it.

In contrast to electromechanical and mechanical keys, subordinate programming keys registered as ‘missing’ 

cannot be registered as ‘found’ at a later point in time. 

8.2.5 Additional Functions

Changing the column display

Click the  symbol in the toolbar to change the way the columns are displayed. In the “Column List“ window that 

opens, you can choose which columns to display (as described in section 5.5.1).

Synchronizing the time

If the time in a programming key does not correspond to the time in your Windows computer, you can synchronise 

these times as described in section 8.4.2.
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8.3 Changing the PIN

When you select an electromechanical locking system or choose functions in safety-relevant areas, the 

“Change PIN“ window opens you have to enter your PIN code for the programming key into the input box provided 

(see section 5.4). 

Click the  symbol in the taskbar to change the PIN code for your programming key.

Note: Make sure to insert the programming key into the correct port on your programming device for 

the lock system that you have imported into CLIQ™ Manager or selected in CLIQ™ Manager Plus 

(see section 5.3).

Fig. 8.3/1: “Change PIN“ window

In the “Old PIN Code“ input box of the “Change PIN“ window, enter the currently valid PIN code for your 

programming key. In the “New PIN Code“ input box enter the new PIN code that you want to assign to your 

programming key. Confirm this PIN code by entering it again in the “Confirm new PIN code“ input box. Due to 

security reasons, the PIN code is displayed as “xxxxxx“.

Note: The PIN code for the programming key must contain six characters.

Confirm the modified PIN code by clicking the [OK] button. Click the [Cancel] button to close this window without 

changing the PIN code for the programming key.

In the taskbar, click the “Change PIN code” symbol to open the “Change PIN“ 

window.
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8.4 Electronic Information

In this window, you can choose a port on the programming device so that you can display manufacturer's data for 

a programming key or electromechanical key together with their event lists.

Fig. 8.4/1: “Select PD port“ window

Note: Make sure to insert the programming key and, if applicable, the corresponding 

electromechanical key into the correct port on your programming device for the lock system that 

you have imported into CLIQ™ Manager or selected in CLIQ™ Manager Plus (see section 5.3). 

The “Cylinder Port” function is currently not available in the English version.

Click the corresponding option to read out the electromechanical information from the inserted key. Click the [OK] 

button to open the “Electronic Information“ window for the key to be read out. 

Click the [Cancel] button to close the “Select PD port“ window without displaying the information for the keys.

In the taskbar, click the “Elec. Info” symbol to open the “Select PD port” 

window. 
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8.4.1 Displaying Electromechanical Information

Programming key

If you select “Programming port”, the “Electronic Information” window opens for the inserted programming key. 

In the top section of the window, you can view the data that has been registered for the programming key in the 

lock system. The first four tabs contain general electromechanical manufacturer's data for this programming key. 

The  symbol indicates that the data is from a programming key.

Note: The “Task List” tab is only displayed when the programming key still has outstanding tasks (see 

section 8.4.1.1).

Fig. 8.4/2: “Electronic Information“ window with “Lists“ tab

Electromechanical key

If you select “Key port“, the “Electronic Information“ window opens for the inserted electromechanical key. In the 

top section of the window, you can view the data that has been registered for the key in the selected lock system. 

The first four tabs contain general electromechanical manufacturer's data for this key. The  symbol indicates 

that the data is from an electromechanical key.

Note: With keys of type E3, the “Auth. Cyls in TK list“ tab is also visible (see section 8.4.1.3).
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Fig. 8.4/3: “Electronic Information“ window with “Lists“ tab

8.4.1.1 Displaying Task List for a Programming Key

If a change to the locking permissions has still not been confirmed in the “Lock Chart“ window, the “Task List“ 

tab provides you with a clear overview of the tasks remaining for the inserted programming key.

Fig. 8.4/4: “Electronic Information” window with “Task List” tab
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8.4.1.2 Displaying Event Lists for Electromechanical Keys

Click “Normal audit trail” or “Foreign audit trail” tab in the “Electronic Information” window to display the event 

list for an electromechanical key. These event lists display all authorised or unauthorised locking actions in the 

cylinders and log the programming details of the keys. The “Normal audit trail” tab displays all locking actions 

that the inserted key has performed within the current lock system. The “Foreign audit trail” tab displays all 

authorised or unauthorised locking actions that the inserted key has performed within an external lock system.

Fig. 8.4/5: “Normal audit trail“ and “Foreign audit trail“ tabs

To search for a certain entry in these lists, click an entry to select the column for the search. Next, click the 

symbol to perform a search as described in section 5.5.2. Click the  symbol to select the columns to display as 

described in section 5.5.1.

Click the  symbol to save the event list on your hard drive or another data medium. The “Save File As“ window 

appears. In this window, choose a folder for storing the event list in the “Save“ select box and change the file 

name if required in the “File name“ input box. Click the [Save] button to save the event list as a text file (format: 

“.txt“). Click the [Cancel] button to close this window without saving the event list.
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Fig. 8.4/6: “Save File As ...” window

8.4.1.3 Displaying Authorised Cylinders for Keys of Type E3

The “Auth. Cyls in TK list“ tab lists the authorised cylinders for which the inserted key of type E3 has locking 

permission.

Fig. 8.4/7: “Electronic Information” window with “Auth. Cyls in TK list” tab
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8.4.2 Synchronising the Time

If the time in a programming key or key of type E2 or E3 does not correspond to the time in your Windows 

computer, click “Diagnostics” tab to synchronise the time of the given key. Click the “Diagnostics” tab in the 

“Electronic Information“ window to open this tab.

Fig. 8.4/8: “Electronic Information” window with “Diagnostic” tab

Click the  symbol to open the “Checking Key quartz” window and click the [Start] botton in this window to 

transfer the time synchronisation data to the corresponding key. Click the [Cancel] button to close this window 

again.

Fig. 8.4/9: “Checking key quartz” window
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After you transfer the timetable data by clicking the [Start] button, a message window appears. Click the [OK] 

button here to confirm the message window.

Fig. 8.4/10: Message window

Click the [Close] button to close the “Electronic Information“ window again.
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8.5 PD Options

In this window, you can change the settings for a connected COM programming device and/or display the settings 

for a COM or USB programming device.

Note: Make sure to insert the programming key into the correct port on your programming device for 

the lock system that you have imported into CLIQ™ Manager or selected in CLIQ™ Manager Plus 

(see section 5.3). When you connect a USB programming device, you do not have to change any 

settings.

8.5.1 Setting the Date and Time

In the “Date time settings” tab, the tab and date are displayed for the connected programming device as well as 

for your Windows computer. The display boxes next to “Programming device” display the current time and the 

current date in the programming device and the “PC Time” displays the current time and date in your Windows 

computer.

Fig. 8.5/1: “Programming device options” window with “Date time settings” tab

To set the time in the programming device to the time in your Window computer, set the time using the selection 

boxes and click the  symbol for the date, or select the “Synchronize PD date/time with the PC date/time” 

select option. 

In the taskbar, click the “PD Options“ symbol on the taskbar to open the 

“Programming Device Options“ window. 
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Click the  symbol to apply the modified time and date settings to the programming device. In the message 

window that appears, click the [OK] button to confirm the action. 

Fig. 8.5/2: Message window

8.5.2 Making General Settings

Click the “Options” tab to make additional settings for a COM or USB programming device.

Fig. 8.5/3: “Programming device options” window with “Options” tab

Choose the language for the programming device in the “Language” selection box and choose a numeric code 

for the device in the “Password” selection box. Specify a turn-off time limit in the “Off-TimeOut” selection box 

for the COM programming device. 

The “Backlight time” selection box allows you to set a time limit for the background lighting of the programming 

device.

Note: Do not change the value given in the “N-Address” box because this is a manufacturer's setting.
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Click the  symbol to transfer the modified settings to the programming device. In the message window that 

appears, click the [OK] button to confirm the action. 

Fig. 8.5/4: Message window

8.5.3 Setting the Interface and Transfer Rate

Click the “Communications“ tab to make interface settings and change the transfer rate for the COM 

programming device.

Fig. 8.5/5: “Programming device options“ window with “Communications“ tab

In the “Comm. Port“ select box, select the interface on your Windows computer to which the programming device 

is to be connected (see section 2.2). In the “Comm Speed“ select box, set the transfer rate to 115200. 

Note: Make sure that the correct interface is selected for the programming device (see section 3.1.4). 

For the USB programming device, install the USB driver first as described in 2.2.2.
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Click the  window to transfer the modified settings to the programming device. In the message window that 

appears, click the [OK] button to confirm the action. 

Fig. 8.5/6: Message window

8.5.4 Displaying Hardware

Click the “Hardware“ tab to display information about the hardware of the connected programming device.

Fig. 8.5/7: “Programming device options“ window with “Hardware“ tab

Click the [Exit] button to close the window again.
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9. CLIQ™ Manager Plus Program

9.1 Additional Functions

In following, we describe some of the differences in functionality between CLIQ™ Manager Plus and CLIQ™ 

Manager . 

Menu bar

In general, the menu bar in CLIQ™ Manager Plus contains the “System List”, “List”, “Edit” and “Help” menus 

with window-specific functions. In contrast to CLIQ™ Manager, this program contains a “System List” menu with 

the System List” function.

Functions

The following functions are different in CLIQ™ Manager and CLIQ™ Manager Plus:

- Import a lock system (see section 9.2.2).

- Store lock system data (see section 9.2.6)

- Release a lock system (see section 9.2.7)

- Display overdue keys (see section 9.2.5.2)

CLIQ™ Manager Plus also allows you perform the following additional functions:

- Open a lock system (see section 9.2.5)

- Create a mechanical lock system (see section 9.2.4)

- Delete a lock system (see section 9.2.8)

- Assign personnel to a lock system (see section 9.3.1)

- Display a person's keys for other locking systems (see section 9.3.2)

Click a menu item to drop down the menu and select a menu item by 

clicking it.
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Program window

Fig. 9.1/1: program window for CLIQ™ Manager Plus
Version:  P84 5 133 0106_ENP845133 00017 0EN 0A    04/18



Lock System 9.2-1Manager
9.2  Lock System 

The “System List“ window of this program provides you with a clear overview of the/all lock system(s) that you 

have imported or created. The system data for the electromechanical lock system is made available by your 

system partner and you can import it from this window. 

In this window, you can add mechanical components to the electromechanical lock system or create additional 

mechanical lock systems. In the “System List“ window, the “Type” column displays the  symbol for 

electromechanical lock systems and the  symbol for mechanical systems.

Fig. 9.2/1: “System List” window

You can perform the following tasks in the “Key List” window:

- Import electromechanical lock systems

- Create electromechanical lock systems

- Back up data for electromechanical lock system(s)

- Restore data for an electromechanical lock system

- Release a lock system

- Deleting a lock system

In the taskbar, click the “System” symbol to display the “System List” window.
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9.2.1 Menu Bar

The menu bar in this window contains the following menus. When you click a menu name, the menu drops down 

to display its contents. Some of these functions are also available as symbols in the toolbar.

9.2.2 Importing Data for a Lock System

Note: Make sure to insert your programming key for the lock system to be imported into the correct 

port on your programming device (see section 5.3).

Insert the medium with the data from your electromechanical lock system into the appropriate drive on your 

Windows computer. In the “System List“ window, click the  symbol in the toolbar or choose the “Import 

System” function in the “Edit” menu on the menu bar.

Note: While the CLIQ™ Manager program can only import and manage data from a single 

electromechanical lock system, the CLIQ™ Manager Plus program allows you to import data from 

several electromechanical lock systems. 

In the “System Import“ window that opens, choose the option that corresponds to the data format in your lock 

system. Select the “Superlock 16 bit file” option box to import data from an older version of the lock system. The 

“Electronic lock system (*.ELS)” option box is for importing newer versions of the lock system that use keys of 

type E3.

“Card” menu

Backup (see section 9.2.6)

OK, opens the selected lock system

Cancel, closes the “System List“ window

“Edit” menu

New System (see section 9.2.4)

Import System (see section 9.2.2)

Delete System (see section 9.2.8)

Release system (see section 9.2.7)

Select columns to show (see section 5.5.1)

Refresh lists

“Help” menu

Help screen (see section 5.2.1)
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Fig. 9.2/2: “System Import” window

Click the [Cancel] button to close this window without importing the data of the electromechanical lock system. 

Click the [OK] button to confirm your selection and import the system data. 

In the “Connecting DB...“ window that appears, choose the folder from the “Look in” selection box and select the 

required file (format: “.WIN”) from the available files. Click the [Cancel] button to close this window without 

opening the selected file.

Fig. 9.2/3: “Connecting DB...” window

The selected file appears in the “File name” input box and you can open it by clicking the [Open] button or simply 

double-clicking the file.

The loading progress of the system data is briefly shown in a window. After importing the data from the 

electromechanical lock system, the “Type in the PIN“ window opens. In the inpot box provided, enter the PIN code 

of your programming key for the imported lock system and confirm your entry by clicking the [OK] button (see 

section 5.4). 

The imported electromechanical lock system is added to the “System List“ window and the system data is 

displayed according to the selected columns (see section 5.5.1). When you start the program, you first have to 

select a lock system in the “System List“ window, as described in section 9.2.5.1. 
Version:  P84 5 133 0106_ENP845133 00017 0EN 0A    04/18



9.2-4 Lock System Manager
9.2.3 Updating Data for a Lock System

Note: Make sure to insert your programming key for the lock system to be updated into the correct port 

on your programming device (see section 5.3).

To update the data in your electromechanical lock system, insert the medium with your new system data into the 

appropriate drive on your Windows computer. 

Click the  symbol in the toolbar of the “System List“ window or choose the “Import System” function in the 

“Edit” menu on the menu bar. The “System Import“ window appears where, as described in section 9.2.2, you 

select the data format option of the lock system for the update.

Fig. 9.2/4: “System Import“ window

Click the [Cancel] button to close this window without updating the data in the lock system. Click the [OK] button 

to confirm the settings and update the system data. The “Connecting DB...“ window opens where, as described in 

section 9.2.2, you can choose the file containing the new system data and click the [Open] button to apply it.

Fig. 9.2/5: “Connecting DB...“ window

A security query appears and prompts you to confirm the action. Click the [No] button to close the security query 

without updating the data in the electromechanical lock system. Click the [Yes] button in this box to update your 

lock system data.
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Fig. 9.2/6: Security query

As the system data is being updated, a window displays the progress and the “Type in the PIN“ window appears. 

In the  imput box provided, enter the PIN code of your programming key for the lock system and confirm your entry 

by clicking the [OK] button (see section 5.4). 

Once your system data has been updated, a message window appears. Confirm this message by clicking the [OK] 

button.

Fig. 9.2/7: Message window

Note: After updating your lock system database, you have to refresh the system data (see section 

7.5.7).).

In the taskbar of the [Setup] program area, click the  button for “Config. Options“ to open the “Config. 

Options“ window. Click the “Reindexing“ tab and refresh the data for the selected lock system as described in 

section 7.5.7.
Version:  P84 5 133 0106_ENP845133 00017 0EN 0A    04/18



9.2-6 Lock System Manager
9.2.4 Create Mechanical Lock System

Users of this program can also create one or more mechanical lock systems so that they can manage the 

mechanical keys in these lock systems. Click the  symbol in the toolbar or choose the “New System“ function 

in the “Edit“ menu on the menu bar. The “Create New System“ window opens to the “Information“ tab.

9.2.4.1 Entering System Data

The  symbol indicates that the data is from a mechanical lock system. The creation date of this lock system is 

set to the current date and is displayed in the “Creation Date“ display box. If the lock system was been modified 

at any time, the “Modify Date“ display box displays the date that the changes were made.

Fig. 9.2/8: “Create New System“ window with “Information“ tab

Enter the appropriate data into the into input boxes and click the  symbol to insert an image or graphic for this 

lock system. In the “Open“ window that opens, select the required image as described in section 5.5.3.

Note: You can insert files of “.jpg“, “.bmp“, “.wmf“ and “.ico“ format as a logo in the “Create New 

System“ window.

After you insert an image for the lock system into the “Create New System“ window, the  symbol becomes 

active and you can click this symbol to remove the image again.
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9.2.4.2 Inserting Additional Information

Click the“Notes“ tab to enter additional information about this lock system. Enter the appropriate data into the 

input boxes.

Fig. 9.2/9: “Create New System” window with “Notes” tab

Click the [Cancel] button to close this window without creating the mechanical lock system. Click the [OK] button 

to save the lock system.

The imported electromechanical lock system is added to the “System List“ window and the system data is 

displayed according to the selected columns (see section 5.5.1). 

You can edit or add to some of this lock system information in the “Information” and “Notes” tabs at a later point 

in time. To do this, click the  symbol and make the required changes in the “System Information“ window as 

described in section 6.9.
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9.2.5 Opening a Lock System

Note: Make sure to insert the programming key into the correct port on your programming device for 

the lock system that you have selected in CLIQ™ Manager Plus (see section 5.3).

Users of this program must select the required lock system in the “System List“ window and confirm their selection 

by clicking the [OK] button. Alternatively, you can double or triple-click an item in the list to open it.

Note: When you select a mechanical lock system, the functions in the “Elec. Setup“ program area are 

no longer available. 

Whenever you click an symbol in the “Elec. Setup“ program area, a message window appears and you have to 

click the [OK] button to confirm.

Fig. 9.2/10: Message window

If you have not selected a lock system, a message window appears where you have to click the [OK] button to 

confirm.

Fig. 9.2/11:  Message window

After selecting an electromechanical lock system, the “Type in the PIN“ window opens. In the input box provided, 

enter the PIN code of your programming key for this lock system and confirm your entry by clicking the [OK] button 

(see section 5.4). 

Click the [Cancel] button to close the “System List“ window without opening the selected lock system.
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9.2.5.1 Selecting a Lock System

To select a different lock system, click the  symbol in the taskbar. The “System List“ window opens where the 

currently selected lock system is marked as “(Read only)“ together with the  symbol.

Fig. 9.2/12: “System List” window

Note: Make sure to insert your programming key for the other selected lock system into the correct port 

on your programming device (see section 5.3).

Click a lock system in the list to select it and confirm your selection by clicking the [OK] button. If you change the 

locking permissions in the previously selected lock system but have not yet transferred this change to the 

programming key (see section 6.8.4.3), clicking the [OK] button will cause a message window to appear. This 

message window will also appear if you exit the program without transferring the lock permission changes.

Fig. 9.2/13: Message window

Click the [OK] button to confirm this message and transfer the lock permission changes to the programming key 

as described in section 6.8.4.3. Next, select the other lock system as described.
Version:  P84 5 133 0106_ENP845133 00017 0EN 0A    04/18



9.2-10 Lock System Manager
9.2.5.2 Displaying Overdue Keys

You can assign a return date to all keys that are given out to personnel (see section 6.3.2.2). In other words, the 

key has to be given back by the return date. If this return date passes before the key is given back, a message 

window appears when you select the corresponding lock system.

Fig. 9.2/14: Message window

Click the [No] button to close this window without displaying the overdue key. Click the [Yes] button in the 

message window to open the “Reminder list“ window.

Fig. 9.2/15: “Reminder list“ window

This window lists the overdue keys from the lock system together with the “Pos“, “Name“, “Mark“, “Keyholder“ 

as well as “Out Date“, “Out Time“, “In Date“ and “In Time“ . The  or  symbol indicates the key type 

(electromechanical or mechanical). The “Out Date“ and “Out Time“ columns indicate the exact times that this 

person was issued with this key. The exact time that the key was returned is displayed in the “In Date“ and “In 

Time“ columns.

Send a reminder to the person given in “Keyholder“, as described in section 6.3.3. As soon as you receive an 

overdue key from a person, insert this into the programming device and click the  symbol. The overdue key is 

highlighted in the list so that you can immediately see the information pertaining to this key.
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Click the  symbol to open the “Report Actions“ window (see fig. 5.6/2) where you can change the print settings 

(as described in section 5.6) or print out this list. You can also create a printout with a list of overdue keys at a later 

point in time (see section 6.10.6).

Click the [OK] button to close this window without printing out the list of overdue keys.

9.2.6 Restoring Data for an Electromechanical Lock System

Click the  symbol in the toolbar of the “System List“ window or choose the “Backup“ function in  the “Card“  

menu on the menu bar to open the “Select operation to perform“ window. 

Fig. 9.2/16: “Select operation to perform“ window

Click the [Backup] button to open a window (see fig. 9.2/17) where you can choose to back up the data for the 

selected lock system or for all of the lock systems.

Click the [Restore] button in the “Select operation to perform“ window to restore the data for a lock system (see 

section 9.2.6.2). 

Click the [Cancel] button to close the “Select operation to perform“ window. 
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9.2.6.1 Changing the Backup Settings

To change data backup settings for the lock system(s), click the [Backup] button in the “Select operation to 

perform“ window (see fig. 9.2/16). In the open window, click the [Selected systems] or [All the systems] button 

to back up the data for all lock systems or just for the selected lock system. Click the [Cancel] button to close the 

window again.

Fig. 9.2/17: “Select operation to perform” window

Click the [Selected systems] or [All the systems] button to open the “Create Backup” window. In this window, 

you can adjust the “Security level” slider to set the security level and the “Compression” slider to enter the 

degree of compression for the data backup. The “Level description” display box displays your settings for the 

security level. The remaining options allow you to make additional settings. Note that you can select several 

options at once.

Fig. 9.2/18: “Create Backup” window

Click the [Cancel] button to close this window without applying the data backup settings. Click the [OK] button to 

apply the settings.
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In the “Save File As ...“ window that appears, choose the folder where you want to store the backup file and click 

the “Save“ selection box. If required, you can also change the file name in the “File name“ input box. Click the 

[Save] button to create a backup file for the lock system(s).

Fig. 9.2/19: “Save File As ...“ window

If you selected the “Use password protection system“ option, the “Write password or phrase“ window will open. 

In this window, enter a password for the backup file of the lock system(s) and click the [OK] button to apply the 

password.

Fig. 9.2/20: “Write password or phrase“ window

If you click the [Cancel] button to close this window, you are prompted to confirm this action. Click the [OK]  button 

in the security query to confirm that you do not want to use a password for the backup file. Click the [Cancel] button 

to return to the “Write password or phrase“ window.

Fig. 9.2/21: Security query
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If you selected the “Specify system comments” option, the “Comment editor“ window appears. In the input box, 

you can enter a comment that will appear when the backup file for the lock system(s) is opened.

Fig. 9.2/22: “Comment editor window

Click the [Cancel] button to close this window without using the comment. Click the [OK] button to apply the 

comment. 

A window appears to inform you that the backup file is being created for the selected lock system(s). When the 

backup is complete, a message window appears where you have to click the [OK] button to confirm.

Fig. 9.2/23: Message window
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9.2.6.2 Restoring System Data for a Lock System

Note: If you already updated a lock system database as described in section 9.2.3, it is not possible to 

use a backup file that was created before the update.

The backup data for a lock system is stored in a backup file according to the settings made during the backup (see 

section 9.2.6.1). Therefore, if your computer crashes or some other problem occurs, you can also restore your 

system data from this backup file. In the “Select operation to perform“ window (see fig. 9.2/16), click the [Restore] 

button so that you can access this backup file again. 

In the “Connecting DB...“ window that appears, choose the folder from the “Look in“ selection box and select the 

required system backup file (format: “.A2B“) from the available files. The selected backup file appears in the “File 

name“ input box and you can open it by clicking the [Open] button or simply double-clicking the file. Click the 

[Cancel] button to close this window without using the backup file.

Fig. 9.2/24: “Connecting DB…“ window

Note: If you have assigned a password to the backup file, the “Write password or phrase“ window 

opens (see fig. 9.2/20). Enter the previously defined password in this box.

After applying the backup file, the “List of backed up systems“ window opens. If you have backed up data for 

several lock systems, this window lists all of the lock systems that are contained in the selected backup file.

Click a row to select the lock system in the list whose data you wish to restore.
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Fig. 9.2/25: “List of backed up systems“ window

Click the [Cancel] button to close the window again. Click the [OK] button to restore the lock system. 

A security query appears and prompts you to confirm this action. Click the [Yes] button to restore the lock system 

database. Click the [No] button to close the security query without restoring the lock system data.

Fig. 9.2/26: Security query

Any existing lock system data is overwritten with the data from the backup file. In the message window that 

appears, click the [OK] button to confirm the action.

Fig. 9.2/27: Message window
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9.2.7 Releasing a Lock System

In the “System List“ window, a write-protected lock system is indicated using the  symbol for “Read only“. To 

release this lock system again, first select the lock system in the list.

Fig. 9.2/28: “System List“ window

Click the   symbol in the toolbar or choose the activated “Release system“ function in the “Edit“ menu on the 

menu bar. A security query appears and prompts you to confirm this action. Click the [Yes] button to release the 

lock system. Click the [No] button to close the prompt box without releasing the lock system.

Fig. 9.2/29: Security query

In the “Release“ window that appears, enter the word “release“ using lower-case letters into the input box 

provided.
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Fig. 9.2/30: “Release” window

Click the [Cancel] button to close this window without releasing the selected lock system. Click the [OK] button 

to release the lock system. 

After selecting an electromechanical lock system, the “Type in the PIN” window opens. In the box provided, enter 

the PIN code of your programming key for this lock system and confirm your entry by clicking the [OK] button (see 

section 5.4).

9.2.8 Deleting a Lock System

Note: Make sure to insert the programming key into the correct port on your programming device for 

the lock system that you have selected in CLIQ™ Manager Plus (see section 5.3).

Click a row to select the lock system in the list whose data you wish to delete. Click the  symbol in the toolbar 

or choose the “Delete system” function in the “Edit” menu on the menu bar. In the “Delete System” window that 

appears, enter the word “DELETE” using upper-case letters into the box provided. 

Fig. 9.2/31: “Delete System” window

Click the [Cancel] button to close this window without releasing the selected lock system. After selecting a lock 

system, click the [OK] button and the “Type in the PIN” window opens. In the input box provided, enter the PIN 
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code of the programming key for this lock system and confirm your entry by clicking the [OK] button (see section 

5.4).

Note: When you delete a mechanical lock system, there is no security prompt involved where you have 

to enter a PIN code.

9.2.9 Additional Functions

Changing the column display

To change the way the columns are displayed, click the  symbol in the toolbar or choose the “Select columns 

to show” function in the “Edit”  menu on the menu bar. In the “Column List” window that opens, you can choose 

which columns to display (as described in section 5.5.1).
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9.3  Personnel

Fig. 9.3/1: “Personnel” window

9.3.1 Assigning Personnel to a Lock System

In the “Personnel” window, click the  symbol in the toolbar. The “Person access chart” window opens and 

displays the personnel assignments for the lock system using various symbols in the function matrix in the lower 

section of the window. 

The  and  symbols indicate whether a person is assigned to a lock system or not. 

To change the assignments between personnel and the lock systems, double-click the corresponding symbol in 

the function matrix. The personnel data is automatically applied in the lock system to which they have been 

assigned so that you can issue these persons which keys for the lock system. 

In the taskbar, click the “Personnel“ symbol to display the “Personnel“ window.
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Fig. 9.3/2: “Person access chart” window

Making assignments

When a person has not been assigned to a lock system, this is displayed in the function matrix using the 

symbol. To assign a person to a lock system, double-click the corresponding symbol in the function matrix. When 

a person has been assigned to a lock system, this is displayed in the function matrix using the  symbol.

You can assign several persons to a lock system simultaneously. Click the  symbol in the function matrix and 

click the green  symbol in the toolbar. The “Autofill” window opens where you can change the listing in the 

function matrix by clicking  or . According to the selection you make here, you can assign multiple persons 

to a single lock system or a single person to multiple lock systems. Click the green  symbol to switch to the 

“Delete” window (see fig. 9.3/5), where you can revoke assignments from multiple persons to a single lock system 

or from a single person to multiple lock systems. Click the [Cancel] button to close this window without making 

the assignment.

Fig. 9.3/3: “Autofill“ window
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Click the  or  symbol to open the “Auto fill accesses“ window where you can make an assignment for the 

row of the current list. The “From“ display box displays the row that corresponds to the currently selected symbol 

in the function matrix. The “First“ display box indicates the first row to be affected by the changes to the 

assignment. In the “To“ selection box, enter the last row containing person or lock system, which is to be affected 

by the changes to the assignments. The “Last“ display box displays the row containing the last person or lock 

system. 

Fig. 9.3/4: “Auto fill accesses“ window

Click the [Cancel] button to close this window without making the assignment. Click the [OK] button to change 

the assignment for the rows in the current listing.

Revoking an assignment

When a person has not been assigned to a lock system, this is displayed in the function matrix using the 

symbol. To revoke the assignment of a person to a lock system, double-click the corresponding symbol in the 

function matrix. When the person is no longer assigned to the lock system, this is displayed in the function matrix 

using the  symbol.

You can revoke the assignment of multiple persons to a lock system simultaneously. Click the  symbol in the 

function matrix and click the red  symbol in the toolbar. The “Delete“ window opens where you can change the 

listing in the function matrix by clicking the  or  symbol. According to the selection you make here, you 

can revoke the assignment of multiple persons to a single lock system or a single person to multiple lock systems. 

Click the red  symbol to switch to the “Autofill“ window (see fig. 9.3/3), where you can reassign multiple 

persons to a single lock system or a single person to multiple lock systems. Click the [Cancel] button to close this 

window without revoking the assignment.

Fig. 9.3/5: “Delete“ window

Click the  or  symbol to open the “Auto delete accesses“ window where you can revoke the assignment 

given in the row of the current list. The “From“ display box displays the row that corresponds to the currently 
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selected symbol in the function matrix. The “First“ display box indicates the first row to be affected by the changes 

to the assignment. In the “To“ input box, enter the last row containing the person or lock system, which is to be 

affected by the changes to the assignments. The “Last“ display box displays the row containing the last person 

or lock system.

Fig. 9.3/6: “Auto delete accesses“ window

Click the [Cancel] button to close this window without revoke the assignment. Click the [OK] button to change the 

assignment for the rows in the current listing.

Note: You can only revoke an assignment between a person and a given lock system when the person 

no longer possesses any keys for this lock system. A message window  appears and prompts 

you whether you wish to perform this action. Click the [OK] button to confirm.

Fig. 9.3/7: Message window
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9.3.2 Displaying a Person's Keys for an External Lock System

Select the person in the list of the “Personnel“ window (see fig. 6.4/1) and click the  symbol in the toolbar or 

choose the “Information Card”  function in the “Card” menu on the menu bar. Alternatively, you can also double 

or triple-click the row containing the person. In the “Person Card“ window that appears, click the “Keys in other 

systems” tab. This tab provides you with an overview of the keys that this person possesses for external lock 

systems. 

In this list, the keys that were given to this person (“keyholder”) are displayed with “Pos”, “System”, “Name”, 

“Mark” and “Alt. Mark”. The  or  symbols indicate the key type (electromechanical or mechanical). The 

“Missing” status indicates whether the given key has been registered as missing.

Fig. 9.3/8: “Person Card“ window with “Key in other systems“ tab

Click the [Cancel] button or the [OK] button to close the “Person Card“ window and return to the “Personnel“ 

window.
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